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Foreword 
How many of us have suffered through a presentation or desktop 
publication created with more enthusiasm than skill? Wouldn't it be 
great if there were a· guide to help people avoid the pitfalls of poor 
balance and poor choice of type and layout? But even better, what 
if there were a guide somewhere that helped beginners not merely 
to avoid the sinkholes and morasses, but went on to inform them 
on injecting style, energy, and good, old-fashioned pizzazz into 
their presentation or desktop publishing? 

This is it. Author Dan McNeill has provided the secrets neces­
sary to create attractive, interesting, and energetic Macintosh 
Graphics in his latest COMPUTE! book, Mastering Graphics on the 
Macintosh. 

Starting with an introduction to the Macintosh as a graphics 
platform, McNeill introduces you to graphics software and the 
standard graphics formats. Then he turns to the use of the specific 
software packages MacPaint, MacDraw, and HyperCard. Learn about 
the tools available and how to use them to the limits of their pow­
er. Learn about perspective, shadow, and texture, capturing reality, 
and using color. 

Learn how to import art into the Macintosh by manual copy­
ing, or using clip art and digitizers. 

When you master the software and hardware that help you 
create art on the Macintosh, put your skills to work creating vivid, 
powerful presentations complete with script, charts, visuals, dia­
grams, and illustrations-all presented via overhead transparencies, 
slides, computer screen images, and handouts. 

· If you're interested in using your Macintosh graphics in the 
desktop publishing world, you're in luck. Desktop publishing is 
covered in full, including explanations of the best use of typogra­
phy, trademarks, logos, and page design. Learn how to take control 
of the reader's eye with layout and white space. 

Should your text be laid out in columns? What can you do to 
improve readability? What's the best alignment for your work­
ragged right or fully justified? What's the proper use of borders, 
lists, subheads, readouts? 
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What about printers? When it comes time to put your work on 
paper, what kind of computer printer will make the best original? 
What kind of printing should you use when you want to distribute 
your work to the masses? 

If you know the answers to these questions and follow the 
simple rules provided in this book, your readers will be able to tell; 
and the credibility of your creation will be enhanced. 

Let Dan MacNeill help you create your graphics; then print, 
present, and distribute them with class. It's all here for you in 
one book. 
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Preface 
The Macintosh was the first graphics computer for the desktop, but 
in recent years its power has bloomed-and more like fireworks 
than a flower. Yet it's one thing to have the power to create won­
derful graphics and another to understand how to use it. In fact, 
the Macintosh is rather deceptive. It makes creating graphics so 
easy we think we can do it all, and all by ourselves. In fact, you 
can do a remarkable amount very easily, but you do need some 
guidelines, especially at first. 

This book focuses more on design than specific software. New 
versions of the Macintosh are emerging fairly rapidly. Likewise, the 
software surges ahead in power, and novel programs are still ap­
pearing. Thus, hints and caveats about specific software have a 
way of becoming quaint very rapidly. Moreover, Mac graphics pro­
grams have grown from a handful to an abundance, and universal­
ly accepted standards are becoming harder to find in any field. 
Most successful programs have some features its rivals lack. 

Hence, this book addresses the end more than the means of 
getting there, result more than technique. Nonetheless, the modi 
operandi in certain kinds of software are similar and relatively sta­
ble, so we can guide you through a program like MacPaint without 
worrying that the description will have the lifespan of a mayfly. 

Finally, this book more or less covers the gamut. Though it 
omits some fields, it also covers more topics than most readers may 
need to know about. So please feel free to skip around. This is a 
guidebook, not an assignment. 

Acknowledgments 
No doubt some readers view an acknowledgments section as a 
kind of preliminary cough, where the author grudgingly concedes 
his debt to others before hastening on to crow about himself. How­
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have sustained me from first outline to final patch-up. They 
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Paul Freiberger, high-tech reporter for the San Francisco Exam­
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A Graphics Primer 
Graphics are as old as the human race. Scholars think they began 
with bodily ornament-smearing the face, scarifying the arms, 
tattooing the chest. Virtually all primitive tribes show a proud array 
of these adornments, even ones who lack all other pictures. Unfor­
tunately, illustrations on the skin do not survive the death of their 
owners, so we cannot tell when they originated. 

True art emerged only within the last 100,000 years, and cave 
paintings of aurochs, horses, and other beasts survive in Europe 
and Africa from as early as 35,000 B.C. Not all this work is impres­
sive or even competent, but some is memorable. A picture of a bi­
son charging full bore across a limestone wall, head down and 
hooves aloft, puts you right there, a witness to angry mass in 
motion. 

Since then, graphics have always exploited new technology. 
For instance, factory-produced oil paints in tubes made possible the 
plein air works of the Impressionists-sunny picnics on grass, pop­
lars at Aries-since they obviated the need to prepare paints in the 
studio. Graphic designers quickly embraced lithography and pho­
tography, and modem artists and sculptors have exulted in steel 1-
beams, glass, burlap, and like materials. 

The computer is the latest advance in graphics, and by far the 
most dramatic. 

Every graphics medium has some advantages and some draw­
backs. For instance, charcoal is quick and erasable, but lacks color 
and requires fixative. Watercolor easily renders depth and a certain 
pale dreaminess, but demands rapid fresco-pace execution. Com­
puters too have up sides and down. Let's look first at their 
advantages: 

Precision. The machine works in dots, and they can be exception­
ally small. Laser printers render images at 300 dots per inch 
(90,000 dots per square inch), and phototypesetters like the 
Linotronic yield of up to 2540 dots per inch. Of course, mediums 
like oil achieve a dotless saturation, but the computer lets you 
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Chapter I 

control each dot directly. Hence, you gain extraordinary power 
over detail. 
Palette. On the Mac II, you can choose among about 16.8 million 

different colors for each dot, a staggering sum. Moreover­
onscreen, at least-you work in pure light, without the bother of 
pigments. 

Erasures. The computer bestows a magical forgiveness. If you· 
make a mistake in charcoal, say, you must make an effort to 
eradicate it, and rubbing may even remove paper. But the com­
puter erases cleanly, instantly, and forever. Only when you are 
finished do you print out and generate a hard copy. 

Special effects. The computer supplies an array of instant tools. 
For instance, you can pull out a circle or rectangle on the screen 
automatically. You can fill space with patterns, create mirror im­
ages, trace edges, eliminate "noise," move figures about, and 
duplicate them onscreen. You can carry out a host of other func­
tions-indeed, so many that we'll spend most of this book de­
scribing them and still won't reach an end. 

Range. The computer lends itself tO every kind of art: not just 
drawings, but charts, diagrams, fonts, and page layouts. It's a to­
tal graphics machine. 

Absorption. The computer is a graphics sponge. It can easily read 
in printed graphics and display them onscreen where you can al­
ter them. It also accepts video signals, so you can take photo­
graphs through a video camera or copy frames from a videotape. 

Variations. The computer can replicate electronic files in a snap, 
usually with a command or two. Hence you can rapidly vary 
your work. For instance, if you are drawing a series of 
comprehensives (comps) for a client's inspection, you can do one, 
duplicate it, alter the new file, duplicate it again, alter that, and 
so on. This process saves a fantastic amount of time and labor. 

Copies. As in lithography, the computer can print out as many 
copies of your work as you want. Hence, though originals won't 
fetch auction-block prices, you can distribute them far more 
easily. 

Finally, the computer adds a whole new phase to graphics: a 
waystation on the road to output. Its screen presents a vision of the 
final image which you manipulate at will, adding, erasing, and re­
touching until you'i:e satisfied. Only then do you make the hard 
copy. It's almost like developing and refining the picture in your 
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A Graphics Primer 

mind, except you view it in faultless detail and the machine exe­
cutes the final vision automatically. 

Of course, the computer too has drawbacks, though few are 
inherent: 

Price. It costs far more than most art materials, and is less porta­
ble-though portable machines are certainly available. 

Color reproduction. More important than the price of the machine, 
direct color printout remains either inferior or expensive, and 
hues on the screen may not match those on hard copy. 

Size. The machine may also limit hardcopy size, usually to the 
width of the printer. Film sidesteps some of these obstacles, but 
final copies still lack the range of expressiveness of traditional art 
media. 

Yet the computer has tremendous powers. As a graphics tool, 
it's not merely legitimate, it's impressive and powerful. 

The Macintosh 
Most computer books are about software, not computers, and this 
one is no exception. You don't have to know how a computer 
works to use it, but it's important to know a few hardware traits to 
grasp what the software can do. So lets tarry a moment on the 
Macintosh, the pedestal supporting all else. I'll try to make it as 
painless as possible, but if you find technical talk insufferable or 
know the material already, please jump ahead. 

Personal computers debuted commercially in 1975, but they 
were feeble by today's standards. Though they grew rapidly in 
power, for years they displayed an inaccurate image of printout. In 
some cases, distortion was perhaps desirable; for instance, word 
processors could show a whole page of text by compressing lines 
together. But such displays hamstrung graphics. 

In January 1984, Apple Computer announced the Macintosh. 
The Mac was the first personal computer with a graphics orienta­
tion, and hence the first desktop machine for serious artists. 

What does graphics orientation mean? In fact, it's a catch-all 
term for several qualities. Most basically, it means the Macintosh 
has a set of software routines called QuickDraw that place text and 
other images on the screen more or less exactly as they will look at 
printout, a trait called WYSIWYG (pronounced WIZZY-wig, for What 
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Chapter I 

You See Is What You Get). Instead of. guessing output, you can see it 
at a glance. 

This approach has proved so popular it has spread to virtually 
all personal computers that can handle it. At the same time, the 
Macintosh has evolved into two lines, the original and the Mac II, 
which have quite different ramifications for graphics. 

Orlglnal Line 
The basic line includes the Mac, Mac Plus, Mac XL, Mac SE, and 
Mac SE/30. These are sometimes called the portable line, because 
they come in fairly small size with the screen inside the box as part 
of the in-store purchase. It's a happy arrangement, in some ways: It 
greatly reduces buyer confusion. The machine has attractive con­
tours, and its black-and-white screen boasts high resolution. 

However, this package exacts a toll: lack of choice. You are es­
sentially compelled to use the Mac monitor unless you want to re­
wire the computer. Also, the display is small and solely black-and­
white. 

The first three computers mentioned-the Mac, Mac Plus, and 
Mac SE-are based on the Motorola 68000 microprocessor. This 
central device comprising the brains of the Mac is a 16/32 bit chip. 
(A bit is one on/off signal in a computer.) It can alter information 
in chunks of 32 bits but handles data 16 bits at a time in other ways, 
such as feeding it through channels. These machines are faster and 
more powerful than pure 16-bit computers like the IBM PC. 

The fourth computer in this series, the Mac SE/30, is based on 
the more powerful 32-bit 68030. Both the SE and the SE/30 have a 
single slot into which you can insert cards, special circuitry boards 
that give the machine added powers. 

Mac II Line 
The newer line includes the Macintosh II and the Ilx, substantially 
different machines from the portable line. Sometimes called plat­
form machines, in them the computer forms a shallow dais support­
ing the monitor, which is detachable from it. This arrangement 
allows far more flexibility with the monitor: You buy it separately 
from the computer and can choose among monochrome (black­
and-white), grayscale, or color monitors, in numerous levels of res­
olution. These computers also have slots into which you insert 
video cards, which let the Mac communicate with a panoply of 
screens. 
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These newer Macs are based on full 32-bit microprocessors­
the 68020 and the 68030, respectively-which are much faster and 
more capable than the 68000. In addition, they have math 
coprocessors, special chips that carry out calculations and speed 
things up even further. 

By the time you read this book, there may well be additional 
Mac versions. 

Stages of Creation 
There are six basic elements in the process of creating computer 
graphics. In rough chronological order, they are: 

•Paintbrush: How Is Information Entered? 
• Format: How Is It Coded? 
•Memory: How Is It Stored? 
• Screen: How Is It Shown? 
•Program: What Can You Do with It? 
•Output: How Do You Make Final Copies? 

Most of this book deals with the last two elements, but unless 
you understand the first four to at least some extent, you'll be at 
sea with Macintosh graphics. The rest of this chapter deals with 
them. 

Entering Graphics 
You can enter graphics into the Mac either piece by piece or full­
blown. In other words, you can either create them or copy them. 

Creation 
Programs like MacPaint invite you to exercise your imaginative 
powers, abetted by a small army of aids. Moreover, a host of less 
creative programs, like chart software, also take data directly from 
you and shape it into an image. 

Mice. The Mac allows several tools for creating graphics, the 
best known of which is the mouse. Every Macintosh is sold with 
one, and the Mac user who doesn't understand it is probably just 
pulling the styrofoam away from the machine. The mouse is a rec­
tangular item slightly smaller than a deck of cards. 

You roll it about your desk, and a pointer or other symbol rep­
licates its movement on the screen. To issue commands, change 
status, or select an item, you press and release the button on the 
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mouse. To draw, you press the button and move the mouse, and 
the pointer/paintbrush trails a line behind on the screen. It's all 
much simpler than it sounds. 

The mouse excels at graphics that don't demand keen neuro­
muscular precision, such as page layout and chart programs. It does 
well with freehand graphics too, but since you grasp a block rather 
than a pen..:like stylus, you have less control. A stylus brings the 
fingertips together at the place of contact with the page and yields 
greater finesse. 

Trackballs. The trackball is even worse. It is a ball in a socket, 
mounted on or near the keyboard. You place your finger on the 
ball and rotate it, and the pointer crosses the screen. Proponents 
claim it surpasses the mouse, since it lets you work without moving 
your hands away from the keyboard. Whatever its overall merit, 
it's awkward for freehand graphics since you can't grasp it at all. 

Digitizer pads. The freehand champion, this is a flat tablet 
with a grid on which you move a stylus. This familiar approach not 
only yields great control, it also permits manual copying. You place 
an image atop the pad, trace its contours with the stylus, and the 
picture wends its way into memory. For small images it's a quick 
and easy process, sidestepping scanners and the other machinery 
you'll see in a moment. 

Creating graphics entails both time and, often, a touch of tal­
ent. But there is a faster way: You can copy them. 

Copying 
The Mac is a kind of flypaper for the graphics of this world. To 
pick up these images, you merely need to turn light waves or video 
signals into Macintosh digital code. There are several ways to do 
this. 

Clip art. The most direct kind of copied graphic is clip art, 
predrawn computer art you buy and feed into the machine as is. 
Clip art requires no translation, no new hardware, and little extra 
time. On the other hand, each set of images costs money, and clip 
art more or less limits you to the fare available on the market. 

Scanners. The Mac also accepts images straight from the out­
side world. For instance, you can use a scanner to read light from a 
two-dimensional source, such as a photo, and translate it into digi­
tal form. The graphic then appears on the Mac screen, where you 
can alter it as you please. 

One common scanner is ThunderScan, which f~ts right into the 
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ImageWriter printer. This cartridge device is probably the best to 
start with, since it is much less expensive than other types. Flatbed 
scanners resembling office copiers usually cost over a thousand 
dollars and can copy not only single sheets of paper, like 
ThunderScan, but pages from books; they also copy much faster 
and with less effort. 

Video digitizers. The Mac also takes video information, letting 
you snap photos of the world. Set up a video camera and connect 
it to a translator called a video digitizer, which transforms video sig­
nals into digital ones. Then you link the video digitizer to the Mac­
intosh and simply start taking pictures. The digitizer also lets you 
read in video data from a VCR. 

Formats: Introduction 
Once graphics information enters the machine, you must store it 
some way. The computer uses special transistors which can be 
either on or off. A single on/off state is the most basic piece of 
information in the machine, and we call it a bit. A bit can hold one 
piece of yes/no information, such as whether a light bulb is on or 
whether a Macintosh pixel is black or white. Likewise, a string of 
bits can store more complex information, such as the letter K. 

But how does it work? How do you know the meaning of an 
on/off series of bits? 

You use code, matching the on-off sequence in memory 
against a set of patterns with specific, predefined meanings. For in­
stance, a string of dots and dashes may be random nonsense, but if 
encrypted according to the system of Samuel Morse, it has meaning 
and we can decode it. Three dots, three dashes, and three dots, for 
instance, is SOS. The same symbols in another dot-dash code might 
have different meaning or none at all. All codes are arbitrary and 
depend only on prior agreement. 

Software uses codes too, and for graphics we call them formats. 
Thus if a program is geared to receive information in one format 
and actually receives it in another, it won't understand the 
message. 

Most programs such as SuperPaint and hardware like 
ThunderScan have their own format. So, to move graphics back 
and forth among them, you need a standard format you can trans­
late to and from. 

It would be nice if there were just one universal standard, a 
lingua franca to which you could automatically resort, but in. fact 
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there are many. Why? A standard becomes entrenched and, before 
long, the technology outstrips it. Better machines appear, program­
mers devise tricks the format can't express, and soon a new format 
emerges. Yet the old one lingers on serving previous software, for 
which it may be perfectly adequate. The old standard may even be 
updated, causing further confusion. 

To understand the major formats, you need to know certain 
hardware concepts that follow, so they'll be bumped to the end of 
this chapter. If you know the technology already, you can turn 
ahead; otherwise, read on. 

Memorv 
Memory holds data when the computer isn't working on it, that is, 
almost all the time. It's crucial to computers, and, as Silicon Valley 
sages note, "Every computer needs twice as much memory as is 
currently available." 

For graphics, memory has three important aspects: the total 
amount in the machine, the amount allotted for the screen image, 
and the manner of storing pictures (by dot or by shape). 

Total Memory 
Graphics requires more total memory than most applications, be­
cause images are more complex. Hence, the amount you have be­
comes quite important. 

For most purposes, computer memory comes in two basic 
kinds: RAM and storage. 

RAM (random access memory) refers to the memory chips within 
the machine that hold data temporarily. When you turn the Mac on 
and load a program, part of it goes into RAM. The documents you 
work on go into RAM too, as do changes you make to them. 

RAM is measured in bytes. One byte equals eight bits and can 
usually hold a single alphabetic character, number, or other discrete 
piece of data. It's a molecular amount of memory today, so the 
standard unit of measure has soared. You normally see RAM de­
scribed in kilobytes (K, or 1024 bytes), megabytes (MB, a little over 
a million bytes), or even gigabytes (about a billion bytes). 

The RAM in your Mac holds information for immediate com­
puter access. In this way, RAM may limit the software you can run 
or the size of documents you can create, and partly define your 
machine. The first Macs held 128K and ran MacWrite and MacPaint 
but little more, since 128K is now considered a narrow slice. Next 
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came the Fat Mac, at 512K. No one calls it the Fat Mac today, since 
512K is the lower limit of most Macs. The standard Mac memory 
now is one megabyte; for graphics, 2MB or even 4MB are better 
yet. 

RAM is transient. Tum the Macintosh off, and you lose all the 
information in RAM, instantly and forever. Hence you need a more 
permanent way to save material. This kind of memory is called 
storage (or mass storage). 

Storage is generally a matter of disks, either normal floppy 
diskettes you insert or internal hard disk drives. For graphics, a 
hard disk is almost indispensable; these devices hold a minimum of 
lOMB, and 20MB is the most common size. You can easily aug­
ment a hard disk in increments of 20MB, and for serious graphics 
work, you may want a hard disk with 100MB or more, though 
many artists would find 40MB sufficient. 

The total amount of memory defines your periphery, your 
sceptred realm. But all the memory in the world won't help you 
much if you don't cultivate the part devoted to the screen image. 

Screen Memorv 
One of the more confusing concepts involved in ~creen memory is 
bits-per-pixel. A pixel (short for picture element) is a single dot on 
the screen, the most basic graphics unit. The term dot would do as 
well and is often used, but pixel has a spritely charm missing from 
much other computer jargon (like the chilling object-orientation). 

On the original line of Macs, a pixel is either black or white. 
Since black/white is analogous to off/on, each pixel needs only 
one bit in memory to describe it. If the bit for a pixel is off, the 
onscreen pixel is black; if the bit's on, it's white. A black-and-white 
screen, therefore, is one bit-per-pixel. 

Of course, pixels need not be just black or white; they can be 
any shade of gray and over 16 million different colors. You simply 
·need the right monitor and more than one bit of memory per pixel. 

The more versatile the pixel, the more bits it needs. It makes 
sense: If a pixel can come in 64 different shades of gray, say, it re­
quires 64 different combinations of on and off to describe it. If only 
32 are allotted, the computer will understand only 32 states and 
send only 32 different signals to the screen. As a result, no matter 
how good the monitor, each pixel would show one of only 32 shades. 

Sometimes it's a little hard to grasp the relation between the 
bits-per-pixel figure and the image on the screen. The number of 
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possible shades doubles with each new bit-per-pixel, setting up a 
geometric progression. 

Let's look closely at how this works. With two bits for each 
pixel, you have 2 X 2 possible codes: 

on-on 
on-off 
off-on 
off-off 

yielding four shades of gray. That's clear. To run through all possi­
ble combinations at three bits per pixel, you place an on at the end 
of each of the four two-bit strings, then an off. You get: 

on-on-on 
on-off-on 
off-on-on 
off-off-on 
on-on-off 
on-off-off 
off-on-off 
off-off-off 

Because you add an on and then an off to each of the four 
combinations, you double the total to eight. Exactly the same thing 
happens with a fourth bit. You can attach each of the eight three­
bit strings to an on bit, then an off bit. The total doubles again, to 
16, and so on. 

Therefore, the total number of shades per pixel equals two 
multiplied by itself for as many "bits per pixel" as we have. In 
other words, it is 2 to the power of the bits-per-pixel: 

4 bits per pixel = 

5 bits per pixel = 

6 bits per pixel = 

8 bits per pixel = 

12 bits per pixel = 

16 bits per pixel = 

24 bits per pixel = 

12 

16 shades (24, or 2 X 2 X 2 X 2) 
32 (2s, or 2 X 2 X 2 X 2 X 2) 
64 (26) 

256 (28) 

4,096 (212) 
65,536 (216) 
16,777,216 (224) 
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It works the same way with color. If you store eight bits of 
color information per pixel, as Apple's Macintosh II Video Card 
does, you get a palette of 2s, or 256, colors. Internally, the Mac II 
can hold a maximum of 24 bits-per-pixel, so each pixel on the 
screen can be one of 224-roughly 16.8 million-colors. The actual 
range of the palette depends on the bits-per-pixel of the video card. 

Bits-per-pixel is the standard measure of screen image quality, 
often abbreviated to bit. When someone refers to "an 8-bit image" 
or '~a 12-bit image," you must either do rapid calculation-not 
easy-or know the rough equivalent. 

Since most Mac II screens display about 780,000 total pixels, 
you can show a maximum of 780,000 different colors at any one 
time. That's a reasonable palette, since to scan color photos accu­
rately or shade three-dimensional objects, most professional work­
stations display more than 1,000,000 colors at once. 

Programs for your Mac have two manners of memorizing 
graphics: by dot, or individual pixel; or by overall shape. The first 
method is called bitmapping; the second, object-orientation. 

Bitmapping. Bitmapping is a simple concept, but sometimes it's 
ramifications seem unclear. Essentially, it is plain rote memory of 
pixels on the screen. The computer makes a map in memory to 
correspond to the pixels, and each pixel has its own site. When 
you print a bitmapped image on an ImageWriter, the Mac simply 
sends this information to the device, bit by bit. 

Bitmapping makes precise work easy. Since you control each 
pixel independently of all others, you can make it whatever you 
want and gain crisp detail. We generally call bitmapped graphics 
software paint programs, after MacPaint, which started it all. 

Object-orientation. The Macintosh QuickDraw routine uses bit­
mapping to display the screen, but your software need not em­
ploy this tactic if it can "understand" the relation between the 
pixels. 

Imagine a circle on the screen. Memory can record it in one of 
two ways: A bitmapped program simply notes the location of each 
pixel, With no information about the overall shape. An object­
oriented program, on the other hand~ expresses the overall shape 
as a formula and places it at a particular site. 

13 



Chapter I 

At first glance, this approach may seem clumsy. By working 
with objects, you forsake the splendid detail of bitmapping. You 
lose such charming features as FatBits, which lets you manipulate 
individual pixels. Usually it also takes longer to get accustomed to 
object-oriented software. You can sit down with a bitmapped pro­
gram and create pictures at once, as if you're sitting at an easel. 
Object-oriented software is more like playing with blocks, and de­
mands more patience. 

However, the payoff might be worth it. Object-orientation lets 
you work with clearly demarcated objects-hence its name. Since 
the machine stores each object separately, you can pile them atop 
each other in layers and later easily detach them, an invaluable 
power for drafting. With bitmapping, there is only one "layer," so 
once you fuse two shapes, they stay fused; it's like pouring apple 
juice into pear juice. 

But object-orientation goes further. Since it defines shapes, not 
pixels, it can readapt the shapes to new circumstances. For in­
stance, if you expand a bitmapped circle, the program magnifies 
the image literally, and tiny steps swell into great blocks. The soft­
ware has no choice, since it knows only pixels. An object-oriented 
program, however, regenerates the circle in larger size and rounds 
out the curves; it, too, has no choice, but here you benefit. 

Text also profits from this compulsive tidiness. Expand a bit­
mapped A and you get an Aztec pyramid. Expand an object-orient­
ed A and you get a smoothly-sloping A. The software cleans up the 
contours, so you can resize almost any type you want. 

This capacity has proved fantastically useful with laser print­
ers, because it enables greater resolution. If you can resize your 
work, you can take advantage of more precise printing techniques, 
and that's what the laser printers and phototypesetters offer. Most 
laser printers print at 300 dpi (dots per inch); the Macintosh screen 
has only 72 dpi. If you send bitmapped characters to a laser printer 
with no mediation, they stay more or less as they are. If you send 
object-oriented characters via Laser Prep and Postscript, the printer 
can round them off and sharpen them substantially. The effect is 
like expanding the image dramatically, smoothing it out, and re­
ducing it to original size. Object-orientation offers crisp, attractive 
graphics and text, and so has become immensely popular. 

Object-oriented software programs are generally called draw 
programs, after MacDraw. 
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The Screen 
The monitor is the part of the computer you deal with most fre­
quently. It provides the ongoing status of your work, the arena for 
issuing commands, and the center for messages from the computer 
itself. 

Macintosh pixels are square, a fact that affects the appearance 
of graphics on the screen. Since squares have 90-degree angles, 
they tend to give graphics a sharper appearance. Had the pixels 
been circular, as on TVs, the screen would look softer. 

The pixels form a tilework on the screen. Therefore, you don't 
really work pointillistically like Georges Seurat, who placed dots 
wherever he wanted: You are confined to a grid. However, the fi­
nesse of such machines as laser printers and phototypesetters is 
making this fact much less significant. 

The screen also has a number of other basic characteristics, · 
such as size, resolution, and the relative presence or absence of 
color. 

Size 
There are two ways to measure a computer screen: by grid size and 
by absolute size. These methods are very different. 

All graphics software works from a basic concept: the grid. It 
sets up vertical and horizontal axes, somewhat like those in analyt­
ical geometry, and places a pixel at each intersection. Grid size is 
the number of pixels across and down. The grid size of the Mac, 
Mac Plus, and Mac SE is 512 by 342 pixels, or almost exactly 3 to 
2. Grid size of screens for the Mac II varies according to the manu­
facturer. Apple's monochrome and color monitors are 640 by 480, 
or precisely 4 to 3. 

The absolute size of a screen is the figure you get by applying a 
tape measure to it. The screen of the original Mac line is very 
small: 9 inches across diagonally, or 7.11 inches horizontally by 
4.75 vertically. The absolute size of Mac ·n screens also varies but is 
almost always larger. Apple's color RGB monitor is 13 inches diag­
onally, and its monochrome is 12 inches. 

Resolution 
You combine these two ways of determining size to get resolution, 
perhaps the most important figure of all. Resolution measures your 
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perception of the screen's finesse, and it's expressed by the number 
of dots per inch, or dpi (sometimes called dot pitch). You can easily 
derive dpi by dividing the inches in one direction by the number of 
pixels. The screen of the original Mac has 72 dpi, which makes fine 
resolution. 

Resolution matters because of the basic optical illusion behind 
the screen. As pixels dwindle, they tend to fuse together, like the 
flowers in an arboretum bed spelling out "Welcome Shriners." But 
for this trick to work, the pixels must be relatively dense. Some 
computers have offered screens with about the same number of 
pixels as the Mac but spread over a wider area, which looks grainy 
and diminishes your pleasure at the machine. 

Resolution explains the small absolute size of the screen in the 
original line of Macs. If you increased its size, the pixels would be­
come more evident and the screen would appear granulated. 

Full-page screens. The nine-inch screen means you have tun­
nel vision on your work. You see only part of the page at any time, 
and must shuttle up and down between its sections. It's a real irri­
tation for desktop publishing, and an almost insuperable obstacle 
for full-page images. 

The solution is a full-page screen, which displays the entire 
page or, more often, two pages before your eyes. Some "false" 
large screens simply blow up the small Macintosh display, increas­
ing the absolute size of the screen without increasing the grid size. 
These screens may be useful for presentations, but otherwise they 
solve very little. 

The true full-page screen increases the number of pixels as 
well as absolute screen size, and lets you peruse many more of 
them. It comes in two types: portrait and landscape. Portrait screens 
generally show one page and are slightly longer vertically. Land­
scape screens show two pages side by side and are longer horizon­
tally. As the difference in price between the two is small, the latter 
have come to dominate the market. 

Chromatlcltv 
The Mac II lifts the Macintosh out of the realm of black-and-white, 
affording new opportunities for the graphic artist. Its monitors 
come in three kinds: monochrome, grayscale, and color. 

Monochrome. The first Macintosh, and all models before the 
Mac II, worked almost entirely in black and white. This fact did not 
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encumber writers or individuals making charts, diagrams, or page 
layouts. Nor did it hinder people making line art. 

Moreover, monochrome monitors can render gray through a 
trick called dithering. This interesting word refers to strewing black 
dots out in patterns. The eye sees a sparse array of dots as light 
gray, a denser cluster as dark gray. Dithering can't replace true 
gray, for the resolution on the Mac screen is far too coarse, and 
dithered black-and-white lacks the sleek appeal of genuine 
grayscale. 

Why buy a monochrome monitor for a Mac II? It has several 
advantages: It is much cheaper. Moreover, since it needs only one 
bit per pixel, it saves memory and lets the computer redraw the 
screen faster. In addition, much early software was written for 
monochrome screens, and some programs still run better on it, 
though software authors are rewriting most popular programs and 
this disability should not linger. 

Grayscale. A grayscale monitor gives true gray, since it has in­
dividual pixels in shades between black and white. It's rather like 
the way photography works, except photos achieve different levels 
of gray by varying the amount of chemical reaction on the negative 
or print. Since photographs show a near-infinite range of grays, 
they are called continuous-tone images. Grayscale monitors are digi­
tal and show only a certain range of gray tones. 

On the screen, the difference between grayscale and mono­
chrome is instantly obvious. Grayscale looks much sharper, as 
though an array of sub-pixels, all black-and-white, make up each 
pixel. To achieve this crispness by dithering black and white, the 
screen would need exceptional resolution. Grayscale pixels yield 
precise, pleasant images, and with image processing software, you 
can manipulate and improve them with much greater freedom. 

Color. The Macintosh 512K, Mac Plus, and Mac SE can actual­
ly print in color, as the original QuickDraw provides for seven col­
ors: blue, cyan, green, yellow, magenta, red, and black. However, 
the process is laborious: Since the screen is black-and-white, with 
the nonblack colors appearing as white, you must tag colors sepa­
rately. (The SE has a slot, so it can also display eight or even 16 
colors with a ColorVue SE card from Orchid Technology and a 
color monitor.) 

The Mac II is able to support this old scheme. However, it dis­
plays glorious color on its own and is plainly the machine for color 
output, even though it's also more expensive than the others. 
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The predominant color displays are RGB (red-green-blue) mon­
itors. On these, each pixel is actually composed of three tiny phos­
phor dots, one red, one green, and one blue. (These roughly match 
the three kinds of cones in the retina that sense color.) The electron 
gun of the monitor stimulates the phosphor dots in different de­
grees and, because they are so small and tightly packed, the eye 
welds them into a single color. For instance, blue plus green yields 
cyan (turquoise), red plus green gives yellow, and red plus blue 
yields magenta. 

Graphics Software 
The computer lends itself to any kind of art. To perform art, you 
need software, which basically transforms the computer from a uni­
versal machine into a specific tool. Numerous categories of soft­
ware have sprung up to reflect the needs in the marketplace; the 
main ones are discussed here. 

Paint. Paint programs tum the screen into a freehand canvas. 
They use bitmapping, as you've seen, and specialize in complex, ir­
regular pictures, like trees. 

Draw. Draw programs began as software for engineers and ar­
chitects, and replicate the drawing board and its special. tools, like 
the protractor. They are object-oriented, reducing every line and 
figure to a formula. 

Clip art. Clip art is the predrawn art that lets you leapfrog the 
creative process. 

Image processors~ Image processors provide an array of tools . 
for sprucing up whole images. Originally designed for scanned ma­
terial, which often needs extra work, they confer great power and 
flexibility with many kinds of images. 

Chart. Chart programs convert numerical tables into illustra­
tive charts. They can generate pie, bar, line, plus many other kinds 
of charts. They are almost indispensable for reports and have also 
come into vogue for desktop presentations. 

Page layout. If you're publishing a newsletter, book, or even a 
flier, you need to organize its elements on the page. This artform is 
called page layout, and the programs that accomplish it are page 
layout programs. Desktop publishing has brought these items to 
the fore, and they remain among the most rapidly growing seg­
ments of the industry. 

Desk accessories. Desk accessories like graphics viewers can 
be handy for browsing through pictures. There are also full-blown 
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paint and draw programs that come as desk accessories, such as 
DeskPaint and DeskDraw. 

Output 
Final copies are, of course, vital for graphics-they make the differ­
ence between smear and scintillation. The Macintosh gives you nu­
merous options. 

For black-and-white output, laser printers have generally be­
come the machine of choice. They yield 300 dpi and higher, which 
approaches professional quality. For proofs and less important 
printout, dot-matrix machines like the ImageWriter are satisfactory. 
You can also feed clear plastic sheets into these printers and pro­
duce transparencies for use with overhead projectors. If you want 
professional level resolution, up to 2540 dpi, you can send a file to 
a phototypesetter such as a Linotronic. 

For grayscale printout, you might be able to tolerate a 300 dpi 
laser printout, but you'd do best with a phototypesetter. 

Color printing is a bit more problematic. Some emerging color 
printers seem to hold promise, but the best are still very expensive. 
Film recorders yield high-quality slides and even photos direct 
from the Mac screen, but they, too, remain somewhat costly. In 
many cases, you may simply want to take color separations down 
to an offset printer for a four-color process job, which can look 
resplendent. 

Formats: Specifics 
We return at last to formats. Here are the major standards: 

Paint. Paint was the initial standard format, derived from the origi­
nal MacPaint. Paint files can be only 8 X 10 inches large, and its 
images are 72 dots per inch. This format prints well on an 
ImageWriter but produces jagged images on laser printers. Paint 
files are compatible with most programs. The main drawback of 
Paint, of course, is that it addresses only paint software. 

PICT. PICT began with MacDraw, the first object-oriented program 
on the Mac. Apple devised it to deal with MacDraw's different 
nature. PICT files can be larger than 8 X 10 inches and can store 
information both as bitmaps and as objects. However, PICT itself 
soon began to creak. With the advent of the LaserWriter and the 
Postscript page-formatting language, software writers could 
achieve effects like hairlines and graduated fills that PICT could 
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not adequately express. Soon programs like CricketDraw were 
adding little extensions to PICT, and these addenda differed from 
company to company. Software writers also found that PICT 
could not render color or shades of gray, or compress files to 
save memory. 

RIFF. The first format to deal with these problems was RIFF (Ras­
ter Image File Format), created by developer Mark Zimmer, who 
also wrote GreyPaint, the program that evolved into ImageStudio. 

TIFF. The next was TIFF (Tag-based Interchange File Format), de­
veloped by Microsoft and Aldus, the maker of PageMaker. At this 
time, scanners were becoming popular, and TIFF remains the 
standard for scanned images, partly because it allows great com­
pression of large files. It can contain grayscale or color infor­
mation, and resolution from 72 to 2450 dpi. Unfortunately, for a 
standard, it comes in several versions. But TIFF doesn't handle 
Postscript directly. 

EPSF. For some time after the appearance of the LaserWriter, most 
programs used the QuickDraw routines in the Macintosh ROM 
for screen display and the Laser Prep file to translate into Post­
script for the laser printer. Adobe Illustrator switched that 
around. It built graphics with PostScript and conducted an ongo­
ing internal translation for the screen. Soon EPSF (Encapsulated 
Postscript File) emerged, a format with two main parts: 1) Post­
script commands for the printer, and 2) a bitmap image for dis­
play on the screen. That is, EPSF really contains two formats: 
Postscript plus a second type, such as PICT or TIFF. Hence, it's 
encapsulated. EPSF boosts the speed of printing, since it sends 
data straight to the printer without translation. It also allows fin­
er effects, such as precise positioning of text. However, because 
its bitmap subformat can differ from program to program, EPSF 
is not completely compatible across the field. Though most pro­
grams which read it can place images for printing, they can't al­
ways open an EPSF file created by another program or let you 
modify it. 

PICT II. PICT II arose with the Mac II, which had color and thus 
had outgrown the original PICT. PICT II handles color up to 
eight-bits-per-pixel, a level which already seems inadequate, so a 
new version of PICT is undoubtedly on the way. Most Mac draw 
programs are now oriented around PICT II. 

GIF. GIF was invented by CompuServe, the large information utili­
ty. CompuServe deals with users of all kinds of personal com-
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puters, and needed a way to transfer graphics among many 
machines; their solution was GIF. 

The formats will probably continue to grow in number and 
power, but for now, let's go back to the beginning. Let's look at the 
world of paint. 
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Secrets of Paint 
The ancient Asian game of Go is amazingly deceptive. It has about 
two or three rules, which you can learn in a few minutes, yet mas­
tering the strategy may take a lifetime. Anyone can play Go, but 
very few play it well. 

In a sense, paint programs resemble Go. MacPaint, the best 
known, is so easy you can start painting in a matter of seconds. Yet 
beneath its splendid and obvious features lies a trove of little se­
crets, often unsuspected by happy users. 

Paint is the granddaddy of Macintosh graphics, MacPaint 
debuted with the computer itself in 1984, and gives ample evidence 
of its capacities. These are the most flexible of all graphics pro­
grams. Since the software understands each pixel as an atom unto 
itself, rather than as part of a larger entity, you can manipulate the 
pixels with delightful ease, as well as shift portions of images about 
and copy them, alter shapes, and generally act as a wizard of 
screen detail. 

Let's examine paint programs in general through the medium 
of MacPaint, still a good example of the breed. 

The Tools 
MacPaint tools are the items that determine how you interact with 
the screen. They usually change the pointer from an arrow to an­
other figure, like a bucket, and they're the key to the whole program. 

In the early versions of MacPaint, the tools lay constantly 
available in a set of icons on the left side of the screen. MacPaint 
2.0, HyperCard, and many other programs now place them in tear­
off menus. You can use them as normal pull-downs, or you can rip 
them off and deposit them anywhere on the screen for instant ac­
cess. Since you can move them about, tear-offs let you use the 
whole screen. 

To tear off the Tools or Patterns menu, drag the mouse across 
it and continue going below. A shimmering outline follows, and 
the menu springs into being when you release the button. To shift 
the menu elsewhere on the screen, place the pointer on the dotted 
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area at its top, press, and drag. To retire the menu, click the tiny 
square in the upper left. 

If you wish to use MacPaint in fifth gear, you should definitely 
take advantage of the tear-off capacity. Many shortcuts involve 
double-clicking an icon on the Tools menu, an impossible act while 
it hangs from the menu bar. 

MacPaint's tools are important not only for themselves but be­
cause they often introduce these other features of the program: 

• Paintbrush 
• Spraycan 
•Pencil 
•Eraser 
•Straight Line 
•Paint Bucket 
•Shapes (various) 
•Text 
•Grabber 
•Lasso 
•Marquee 

The Paintbrush 
Here is the tool that named the genre. The Paintbrush cursor forms 
a shape on the screen; as you drag it along with the mouse, it 
changes the pixels it crosses to the pattern or color you've selected. 
You have several options for working with this tool. 

Traditional artists use brushes of many sizes, but paint pro­
grams allow different shapes as well. You choose Brush Shape un­
der the Goodies menu and a dialog box appears offering squares, 
spheres, and vertical, slanting, horizontal, or dotted lines. You se­
lect one by clicking it. 

• Double-dick the Paintbrush icon and the brush-shape box ap­
pears; click a selection and it vanishes. 

• Hold the Shift key down and draw, and you restrain the brush­
that is, it only paints vertical or horizontal lines, so it works like a 
T ~square you can't rotate. The Shift key h~s this effect on many 
other tools. 

• Hold the Command key down and draw, and the white in your 
patterns becomes transparent, allowing whatever you paint over 
to show through. In effect, the pattern merges with the one be­
low, rather than replacing it (see Figure 2-1). 
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Figure 2· 1. The Paintbrush: Opaque and Transparent 
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The Spraycan resembles the Paintbrush, except it sieves out most of 
the paint before applying it. With a single pass you get a scattering 
of dots that becomes denser with every subsequent pass, until fi­
nally the pattern stands plain and solid. The Spraycan works in 
bursts, so if you pull it quickly across the screen, you'll see a series 
of dots in a disklike form. Pull more slowly, and you'll get a steady 
trail (see Figure 2-2). 

figure 2·2. The Spraycan: Fast, Slow, and Repeated 

•Hold the Shift button down as you pull the Spraycan, and you re­
strain it to vertical or horizontal lines. 
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• Hold the Command key down and spray, and the white in the 
spray becomes transparent, revealing black pixels beneath. 

The Pencll 
Pencil is the camel's hair brush of MacPaint, working pixel-by-pixel 
to yield the thinnest line possible on the screen. It thus lacks the 
variable shape of the Paintbrush, though it has other virtues. For 
instance, Pencil not only makes white pixels black, it makes black 
ones white. It alters the color of whatever pixel the cursor is touch­
ing when you first press the mouse button, and proceeds to change 
all subsequent pixels to that color until you release it. Pencil is the 
tool of choice in FatBits, for fast pixel work. 

•Hold the Shift key down, and Pencil moves only horizontally or 
vertically. 

Zoom. Pencil is also your gateway into Zoom, for magnification 
of the screen. It provides a number of quick and easy ways to ac­
cess this feature. 

• Double-dick the Pencil icon on the menu, and you jump into 800-
percent Zoom; double-dick again to return to 100 percent. (Click­
ing on the window that appears in Zoom also returns you to 100 
percent.) 

• Hold the Command key down and click the screen. to magnify the 
image one stage at a time. The first click yields 200 percent, the 
second 400 percent, the third 800 percent, all from the point 
where you click (see Figures 2-3, 2-4, 2-5, and 2-6). 

• Hold the Shift and Command keys down and click the screen, 
and you go the other way-the magnification diminishes. Click 
from 100 percent to get a SO-percent view of the page. 
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Figure 2·3. Normal Magnification 
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Figure 2·5. 400 Percent Magnification 
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Figure 2·6. 800 Percent Magnification 
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The Eraser 
The Eraser tool is just a white Paintbrush shaped like a square that 
turns each pixel it touches white. The Eraser allows a fair amount 
of control, even in 100 percent, since it goes to work only when 
you press the mouse button. You can easily erase pixels that touch 
lines you want to retain: Move the Eraser up against the line until 
it and one side of the pointer form a doubled line and dick. If eras­
ing gets delicate, don't hesitate to go into Zoom-it can save time 
and tension. 

The Eraser seems to be a pretty simple tool, but beyond its 
plain facade lies a host of little secrets: 

•Double-click the Eraser icon to erase the whole screen, often a 
very gratifying power. 

• Hold the Shift key down and double-click the Eraser icon to erase 
the whole page. , 

•Hold the Shift key down and pull the Eraser, and it erases only 
vertically or horizontally. Why have this feature? It's very handy. 
for removing those irritating black pixels that often touch a 
straight line. You place the Eraser beside the line, press Shift, and 
pull it along without fear of taking bites out of the line. · 

Snapshot. Like the Pencil, the Eraser opens into another realm, 
this time of the Snapshot. The Snapshot is a fall-back position in 
devising graphics, an image o"f the screen you can always return to 
if you make a mistake or find yourself in a blind alley. It is not the 
same as Save, since you might want to Save fairly often, even with 
material you're not sure about. MacPaint automatically takes a 
Snapshot every time you quit; otherwise you issue this command 
by choosing Take Snapshot from the File menu. 

• Press Command and an animated pyrotechnic appears within the 
Eraser, signaling its new powers. Each stroke of the Eraser now 
resurrects part of the screen as it was the last time you took a 
Snapshot. 

~ Hold the Command key down and double-dick the Eraser icon to 
fully restore the last Snapshot. This is equivalent to choosing Re­
vert to Snapshot from the Edit menu. 

Note that Revert to Saved in the File menu, which takes you 
back to the last image saved, is also a fall-back; but issuing this 
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command also takes a new Snapshot, killing access to an earlier 
one. Intriguingly, if you return to a Snapshot that took place prior 
to the last Save and choose Return to Saved, you restore graphics. 

Other means of erasing. There are a number of ways to erase 
in MacPaint without using the Eraser: 

•Press the tilde key at the upper left of the keyboard (Mac 512K 
and Plus), or just left of the spacebar (Mac SE and II), or choose 
Undo from the Edit menu. Of course, this erases only if your last 
act created something, and then it erases only that. 

•Select the Paintbrush and paint with the white pattern. The 
squareness of the Eraser helps in cleaning out corners, but the 
Paintbrush gives you a range of other shapes. 

•Lasso or Marquee an item and press backspace. This is a very fast 
way to erase large items. 

•Fill a black shape or line with white from the Paint Bucket. 
•·Pull out a borderless white rectangle or other shape. 

The Straight line 
Of course, not every image in paint is complex. Often you deal 
with straight lines, and in such cases, the Straight Line tool is 
invaluable. 

It works very simply: Choose the desired line width from the 
offerings atop the Tools menu, and the crosshairs at the left change 
to display it. Then you select the Straight Line icon, press the 
mouse button, drag across the screen, and release. 

The cursor is two crossed lines, and when you move it over an 
existing line, the matching part of the cursor turns white. You can 
place it fairly precisely, and create perpendiculars or regenerate 
broken lines without blind guesswork. 

• Hold the Shift key down as you pull to restrain the line to a verti­
cal, horizontal, or 45-degree diagonal-an important power. 

•For a patterned line, select the pattern, hold the Command key 
down, and pull out the line. To get a dotted or dashed line, you 
may have to create your own pattern, with the Edit Pattern ... 
command under the Goodies menu-more on this below (see Fig­
ure 2-7). 
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Figure 2 • 7. Making a Pattern for Dashed lines 
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The Paint Bucket fills the area you click with a pattern. It is a 
sweeping command, and there are a few things to note about it. 

., 

First, it fills solid white or solid black areas only, so Paint 
Bucket doesn't replace prior patterns with new ones. Instead, it 
either fills an enclosed part of the old pattern, if one exists, or com­
pletely merges with the old one, creating a new (and usually ugly) 
pattern. 

So how do you replace a pattern? There are three methods, all 
somewhat flawed: 

•You can resort to the Fill command, which fills out to the border 
of the selection no matter what pattern is there. You choose a pat­
tern, select an item with the Lasso, and choose Fill from the Edit 
menu. However, not only does this act eliminate the border, but 
you can't Fill effectively again unless you provide a new border. 

•If the shape is regular, such as a rectangle, you can choose the 
new pattern and pull out a filled borderless rectangle within the 
prior one. It's a delicate act, but it works. You can also simply se­
lect the white pattern, effectively erasing the contents of the rec­
tangle, and then use the Paint Bucket again. 
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•You can erase a pattern with the Eraser tool, but this is what 
we're trying to avoid. 

Second, the Paint Bucket commences its spill from the pixel 
just beneath where the paint pouring from the bucket cursor ends; 
this is important to know if you're filling a tiny area (see Figure 2-
8). If the area you want to fill just seems too small to hit accurately, 
magnify it with Zoom. 

Figure 2·8. The Paint Bucket's Hot Spot 

Third, it's easy to make apparently catastrophic mistakes with 
the Paint Bucket. Misplace the cursor slightly or pour into a shape 
with a one-pixel gap-most often an Oval or a shape with an an­
gled line-and a startling pattern fills the screen. When this hap­
pens, the very next thing to do is to click the Undo command from 
the Edit menu or press the tilde key in the upper left. 

Undo acts on only the last act committed, so if you issue some 
other command, the flood remains. 

•Normally, if you click the bucket on open space, it fills the screen 
only. If you hold the Shift key down and click, however, it fills 
the entire page. 

Shapes 
There are ten tools that allow you to create forms. Five yield un­
filled shapes, and the other five, shapes filled with the preselected 
pattern. The shapes are the 

34 



•Rectangle 
• Rounded Rectangle 
•Oval 
•Polygon 
• Freehand tool 

Secrets of Paint 

All yield forms with a black border as wide as the sample line 
atop the Tools menu. If you pick the thin dotted line, filled shapes 
appear as borderless patterns and unfilled shapes don't appear at all. 

• Hold the Command key down and pull out an unfilled shape, and 
the border appears in pattern rather than black (see Figure 2-9). 
This nifty trick lets you quickly surround a screen,or page with a 
customized border. 

• For a filled borderless shape, hold the Command key down and 
pull out a filled shape. Basically, you are making both border and 
fill the same pattern here. The act replicates picking the dotted 
line in the Tools menu and pulling out a filled shape. 

Figure 2·9. Pattern Border 

Regular shapes. The Rectangle, Rounded Rectangle, and Oval 
are regular shapes, and when you pull them out, they grow from 
the comer where you begin to its opposite comer where you end. 
This approach is called Draw from Edge, and it gives you more con­
trol over where the shape starts and finishes. 

Double-dick any of these icons, however, and a cross appears 
in its heart and the method changes. Now the shape grows away 
from the center and twice as fast. You pull in one direction, and the 
shape expands both in that direction and in the opposite direction. 
This method is called Draw from Center, and it's invaluable if you 
want to surround a point with a shape, like a circle. It also lets you 
square a circle, by commencing both from the same center (see Fig­
ure 2-10). (Draw from Center is available on the Goodies menu as 
well.) 
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Figure 2· 1 o. Concentric Figures Made with Draw from Center 

• To paint a square, rounded square, or circle, hold the Shift key 
down and pull out the Rectangle, Rounded Rectangle, and Oval, 
respectively. It's analogous to restraining a line. 

• Though MacPaint has no Arc tool, like MacDraw, you can get an 
arc by drawing a circle or oval, selecting part of it with the Lasso, 
and pulling it away. 

Irregular shapes. The two remaining shapes-Polygon and 
Freehand-are irregular and hence work a bit differently. With the 
Polygon, you pull out a line, click to end it, pull in a different direc­
tion, click to end that line, and so on until finally you double-click 
and complete the polygon. With the Filled Polygon, you need not 
actually return to the starting point. You can double-click with the 
shape still open, and the software draws a straight line to the point 
of origin and fills the shape. 

• Hold the Shift key down and you get vertical, horizontal, and di­
agonal lines only. 

The Freehand tool lets you create any form you like. You just 
draw and release when finished. It's not particularly useful unfilled, 
since you can draw as easily with the Pencil or Paintbrush. Howev­
er, the filled shape saves you the trouble of resorting to the Paint 
Bucket and, like the Polygon, it automatically closes an open form 
with a straight line. 

Text 
The Text tool lets you write on the screen. It acts as a very crude 
word processor, and you must proceed with some caution. Text be-
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gins wherever you first click the cursor. You can move down anoth­
er line (by pressing Return), select fonts and sizes, and choose left, 
center, or right alignment. However, once you leave the text, it be­
comes pure paint. You can type over it, but the software no longer 
recognizes the text as characters. If you need to do complex format­
ting, you may want to use a real word processor, Copy to the Clip­
board, and Paste. 

•Normally, if you change font, style, or size while in text, all previ­
ous text changes. To mix modes in the same stretch of text, press 
Enter before changing font, style, or size (see Figure 2-11). Note: 
This act seals off the prior text, so you can no longer backspace 
into it. 

Figure 2·11. Mixed Text and Patterned Text 

abed 
•To set the method of writing over graphics, choose Preferences ... 

from the Goodies menu. The options are: 
Normal, which clears a swath of white for the text 
Overlay, which fuses text with graphics so letters disappear 
Inverted, which puts white letters on black and vice versa 

•To adjust line spacing, press Option/Command and the less-than 
key (<)or greater-than (>)key (actually, the comma or period). 
This power lets you shift the lines together or apart in minute in­
crements, and you can even fuse lines so tightly that they overlap 
and obscure each other. 

•For patterned text, the best approach is to select a large font size 
and change the letters one by one with the Paint Bucket (which 
fills solid black as well as white-see Figure 2-11). Patterned let­
ters look better large anyway, but if you do want them small, 
Zoom before pouring. You could also choose a pattern, Lasso the 
whole text, and choose Fill from the Edit menu; unfortunately, 
this command also fills the spaces in such letters as o and b. 
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• To alter font size, press Command plus the less-than key or the 
greater-than key. To change font, press Command-Shift and the 
less than key or the greater-than key. Of course, you can perform 
these feats from the menus also. 

• For instant little pictures, add Zapf Dingbats to your System fonts. 
You are then able to access them with Text. 

The Grabber 
The Grabber, a grasping hand, appears onscreen when you press 
Option with most tools. The Grabber moves the screen before your 
eyes and is especially useful for fast screen adjustments in Zoom. 
You can of course also move the window with the scroll bars on 
the bottom and right. 

•Double-click the Grabber icon and you see the whole page. 
Double-click again and you return to 100-percent magnification. 

The Lasso and the Marquee 
The Lasso and Marquee both select parts of a drawing for further 
action. The difference between them is that the Marquee selects a 
rectangle and everything within, including the white space, while 
the Lasso selects only the contents within a loop you draw. The 
Lasso works more precisely, but the Marquee deploys faster and 
provides the open sesame to the Trace Edges, Flip Vertical, Flip 
Horizontal, and Rotate commands in the Edit menu, and Scale Se­
lection ... in the Goodies menu. 

You need not totally close the Lasso loop. MacPaint does so for 
you and, if you've enclosed at least three sides of the item you 
want, you're set. This feature is especially helpful in those Scylla 
and Charybdis situations where you would otherwise have to pull 
the Lasso through a slender strait of white. If you begin and end at 
the right places, the Lasso runs the narrows by itself. 

•Double-click on Marquee or Lasso icon and you select the entire 
window or its contents, .respectively. Press Shift and double-click, 
and you select the page or its contents. 

• To minimize the extraneous material the Marquee gobbles up, 
press Command as you pull it out. The Marquee shrinks to in­
clude the least area it can. 

38 



Secrets of Paint 

Once you select part of the image, you can perform numerous 
acts on it. For instance, you can move it by waiting till the cursor 
assumes a pointer shape and dragging the shimmering image 
along. If you hold the Shift key down, you pull vertically or hori­
zontally only. You can also Copy onto the Clipboard. 

Resizing and reshaping. Resizing is altering the size of an 
item while retaining its form. Reshaping stretches the form as well. 
Paint programs are not really made for these tasks and don't excel 
in them. After either change you may well find patterns distorted, 
lines doubled, and pixel shapes grossly enlarged (see Figure 2-12). 
But MacPaint can resize and reshape, and that might be enough for 
you. 

Figure 2·12. The Perlls of Reshaping 
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•To resize and reshape an image, pull the Marquee around it, place 
the pointer at the corner of the quivery rectangle, hold the Com­
mand key down, and pull. Everything inside suddenly becomes 
elastic, and you can stretch it as far as you want from the base of 
the opposite comer. To resize vertically, pull from a horizontal 
line. To resize horizontally, pull from a vertical line. 

• To ·resize an image without changing its shape, follow the proce­
dure above but press the Command and the Shift keys. Once 
again, Shift exerts constraint. 
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•You can also resize and reshape images you import from the Clip­
board by simply pulling out a Marquee rectangle before Pasting. 
When you Paste, the image adjusts to fit it. Thus, another way to 
resize and reshape images you already have is to Copy them to 
the Clipboard, pull out a Marquee, and Paste. 

• The Scale Selection ... command in the Goodies menu also re­
sizes items according to the percentages you type in. 

Duplication. The Lasso and Marquee confer special powers to 
duplicate and to duplicate multiples. 

• To duplicate a selection, press the Option key and pull. A new 
copy emerges from the selected area. This is one of the great 
powers of paint, since it allows you to build larger shapes from 
smaller ones or duplicate an image for further, trickier enhance­
ment. If the enhancement doesn't work out, you can delete it and 
go back to the original. 

• To duplicate multiples, press both Option and Command, then 
pull. A string of images appears in the wake of the cursor, like a 
shower of coins. The more slowly you pull, the more they overlap. 

• If you go all the way and press Option, Command, and Shift, the 
multiple images aligns horizontally or vertically. This trick works 
well for generating a stack of items, such as papers or coins for 
pictorial graphs. You can also make them appear at regular inter­
vals by choosing Tum Grid On from the Goodies menu before­
hand, as we'll see below. 

•Normally, duplicate images are opaque. White is white rather 
than no color at all, so if you pull one image atop another, it 
blocks the bottom image out. However, press the Tab key as you 
pull and the white areas of the shape become transparent, letting 
the graphics beneath show through (see Figure 2-13). 
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Figure 2·13. Opaque and Transparent Strings 

Beyond the Tools 
As you've seen, the tools provide windows onto numerous capaci­
ties of MacPaint. However, there are other areas which need to be 
investigated on their own. Some are initial conditions of painting, 
such as the level of magnification, and the presence and size·of the 
Grid. Others involve certain menu commands, like Trace Edges. 

Zoom 
One of the finest aspects of paint programs is Zoom, which 
magnifies the screen so you can see each pixel more distinctly. 
MacPaint 2.0 has three levels of Zoom: 

• 200 percent 
• 400 percent 
• 800 percent 

If you've always had problems controlling the pencil or brush, this 
feature goes far to eliminate them. 

All the tools work in Zoom as they do in 100 percent. Their 
cursors remain the same size, however, so at first you might be 
startled to see the kind of swath a Paintbrush can cut. The 
Spraycan and Text also yield gargantuan forms. 

The Pencil is the most useful tool in Zoom, because it's adept 
at selecting individual pixels, but other tools are handy as well. For 
instance, if you want to Lasso an item separated from another by a 
narrow, winding band of white, you would need keen neuromuscu-
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lar control at 100 percent to avoid roping in parts of the neighbor­
ing image. At higher magnification, the Lasso captures just what 
you want. 

The capacity to paint in Zoom is called FatBits, and it may take 
practice to get used to. The pixels greatly magnified on the screen 
look like a collection of giant blocks, and at first you may find it 
hard to grasp how they'll look in the final document. MacPaint 
deals with this problem by providing a window to the side that 
shows your work in 100 percent. You can move this window about 
by dragging the dotted field at its top, and retire it by clicking the 
tiny square in its upper left. Click elsewhere on the window and 
the whole screen returns to 100 percent. 

• To control where the Zoom focuses, select the Pencil, hold the 
Command key down, and click. It homes in on that spot. 

Patterns 
A palette of patterns is always available from the Patterns menu, 
which you can tear off and place on the screen. Patterns often sim­
ulate gray and can be essential for your work. Yet you may find the 
preexisting patterns insufficient. To create your own pattern, choose 
Edit Pattern ... from the Goodies menu-or double-dick a pattern 
to bring it up fast-and modify the pattern you've selected. You're 
now looking at a FatBits version of the pattern along with a 100-
percent version of it, which gives you a better idea of what you are 
creating (see Figure 2-14). 
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Figure 2·14. Customizing a Monogram Pattern 
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MacPaint also lets you set up a Grid on the screen by choosing 
Turn Grid On from the Goodies menu. The Grid is invisible, but if 
you could see it, it would be a cross-hatching eight pixels wide. You 
don't notice this Grid when you're drawing on the screen with, say, 
the Pencil. But pull out a Rectangle or other regular shape and its 
lines are now made up of eight pixels or their multiples. This fact 
gives you greater control over their size. 

Moreover, if you Lasso a Rectangle and drag, you see it move 
in eight-pixel increments, essentially lurching across the screen. As 
a result of this snap-to feature, you can line shapes up with much 
greater accuracy. 

The Grid also allows you to pull out multiple images at evenly 
spaced intervals. You select a whole item with the Lasso, press Op­
tion-Command, and pull out slowly. Duplicates appear only at the 
Grid interval, and they overlap. Hence, if you draw a coin, select it, 
and pull it upward in this way, you get a stack of coins (see Figure 
2-15). 
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Figure 2· 15. Vertlcal String at Regular Intervals 

Since patterns recur at intervals of eight pixels, the Grid lets 
you pull one filled shape atop another with the same pattern so the 
two match exactly. This may sound like just a nice trick, but in fact 
it lets you fuse numerous shapes into one and create elaborate 
shapes (see Figure 2-16). For instance, it lets you easily merge a 
filled square and semicircle. Without the Grid, you would have to 
fine-tune them considerably to make them match. 

Figura 2·16. Fusing Patterned Shapes 
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The Grid also lets you stretch patterned shapes. How? If you 
select the end of a Filled Rectangle, say, with the Lasso or Mar­
quee, hold the Option and Command keys down, and drag with 
the Grid on, you get a string of copies at eight-pixel intervals. 
Hence, if you pull slowly, the patterns within overlap exactly, so 
the copies merge with each other and lose their identity. Only the 
final copy shows the border at the end of the Rectangle. In ~ffect, 
you have elongated the item (see Figure 2-17). If you hold Option­
Command-Shift, you constrain the image to vertical or horizontal. 
You can use the same technique to shorten figures but it works bet­
ter with the Marquee, because the Lasso does not select the outside 
white space. 
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If eight pixels seem too large or too small a mesh, you can set 
the Grid to 2, 4, 16, or 32 by choosing Preferences ... under the 
Goodies menu and clicking the corresponding radio button in 
Autogrid spacing. 

On the Menus 
MacPaint has further powers which appear mainly on the menus. 
Most salient among them are special effects like Brush Mirrors, In­
vert, Rotate, and Trace Edges. 

Brush Mirrors 
Brush Mirrors sets up symmetry. You choose the command in the 
Goodies menu, and a box appears with a vertical, a horizontal, and 
two diagonal lines crossing each other. These are the axes of sym­
metry. Click on as many as you want up to four, then click OK. 
(Clicking a second time deselects.) When the main canvas comes 
back up, you now find that every brush stroke appears in more 
than one spot (see Figure 2-18). Brush Mirrors works only with the 
Paintbrush and Spraycan and is an excellent avenue to intriguing 
work. 
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Figure 2·18. Brush Mirrors 
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Invert 
Invert is a simple command with a dramatic effect: It turns black 
pixels white and white ones black. You can select with either the 
Lasso or the Marquee, but of course the Marquee inverts the whole 
rectangle. Invert is especially valuable if you wish to paint white on 
black. It lets you work in the normal way-black on white-and 
Invert when you're finished. 

Trace Edges 
Trace Edges is an interesting command with much potential. You se­
lect an item with the Marquee-not the Lasso, because you need 
extra room-and then choose Trace Edges from the Edit menu. It 
turns the black pixels of each line white and then adds black pixels 
inside and out. The effect resembles that of the Outline style of 
Macintosh print. It is thus very useful for creating borders, since 
you can easily tum a rectangle into a double or triple rectangle. You 
can also trace the edges of many other items and, if you retrace 
over and over again, gain pseudo-labyrinth effects. 

Trace Edges performs especially well with certain patterns, par­
ticularly those that leave a lot of white space inside. If you trace­
edge a solid black rectangle, you get an open rectangle two pixels 
wider. But if you trace-edge a rectangle with a sparse pattern with­
in, you can generate arabesques. 
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• Hold the Shift key down as you choose Trace Edges and you also 
get a bit of shadow on all right and bottom edges. It lends a little 
depth. 

• For more condensed text in Outline style, select normal text with 
the Marquee and choose Trace Edges. For compact text in Out­
line-plus-Shadow style, select it with the Marquee, hold the Shift 
key down, and choose Trace Edges. 

Rotate 
The Rotate command in the Edit menu swings an area selected by 
the Marquee 90 degrees counterclockwise (to the left). Hence, the 
first time you issue this command, horizontal items stand on end; 
the second time, they're reversed and upside down. 

Fllp Horizontal and Vertical 
These commands in the Edit menu cause the selected areas to 
swing about an axis. The first causes one half-swing around a verti­
cal axis, the second around a horizontal one. In other words, Flip 
Horizontal completely reverses the order and left-right shape of 
pixels, but turns nothing upside-down. Flip Vertical turns the image 
upside-down but has no effect on the left-right order. Issue Flip 
Horizontal and then Flip Vertical, and you have the same result as . 
if you'd issued Rotate twice. 

Color 
Mac Ils offer a tremendous array of colors-about 16.8 million in 
all-and working with color is quite unlike working with black­
and-white, or even grayscale. Graphics are made for color. You can 
achieve intriguing effects with black and white. For instance, the 
movie The Third Man and the photographs of Ansel Adams would · 
be utterly different and diminished in color. Black and white draws 
you in, induces you to complete the image. It also accentuates 
shadows and can create a greater sense of austerity and even som­
berness, as in the work of Rembrandt. But the effect of color in 
general is so pleasurable and various that it transforms the 
experience. 

Whether you have access to all of the millions of colors or not, 
you can work with your choice of colors. The System for the Mac II 
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offers a Color menu, which lets you pick among eight colors­
black, brown, blue, light blue, green, orange, pink, and red-for 
coloring folders or files. This is a handy way to distinguish among 
files or folders for different purposes. 

You can obtain far more colors using the Color Picker, which 
you access by clicking the palette icon in the Control Panel. (Sever­
al programs also use it.) The Color Picker defines colors in terms of 
three technical qualities: hue, saturation, and brightness. 

•Hue refers to the color itself-red, green, and the other colors 
across the spectrum. In physics, these are created by different 
wavelengths of light, and we can describe hue by its wavelength. 
However, real-life colors are composed of hues as well as white, 
gray, or black. Hence, we need two more measures. 

• Saturation refers to how much hue is actually in the color, as op­
posed to white, gray, or black. A series· of various percentages of, 
say, yellow mixed with a steady gray would differ from each other 
only in saturation. 

• Brightness indicates the amount of white in the color and de­
scribes the nonhue part of the color. Black, gray, and white have 
no hue or saturation, and they differ from each other only in 
brightness. Thus, the hue and saturation of a string of colors 
could be the same-40-percent magenta-and differ only in the 
amount of white, gray, or black, that is, in brightness. Pure white 
would be 60 percent, pure black, 0 percent. 

The Color Picker is a circular device that lets you calibrate 
these three qualities numerically. By combining them in different 
degrees, you can derive all the colors the Mac II can display. 

Color perception is a complex field and abounds with subtle­
ties and limitations. For instance, the color you select in the Color 
Picker may differ slightly from the color that appears on the screen, 
for reasons of technology. Color also varies from one monitor to 
another. The kind of light in the room-solar, fluorescent-can 
also affect the color on the screen. Our age influences color too, for 
as we grow older, we tend to lose perception of blue and see the 
world in yellower tones. 

Color brings with it a whole new host of possibilities and po­
tentialities. A few of them include: 
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Smooth. To ease transition between two colors, some software 
automatically averages the hues and inserts lines of these colors 
between them. 

Smear. This feature lets you mix two colors at a boundary together, 
almost as if you were smudging them with your finger. It's good 
for creating a rough or hazy look, as with clouds. 

Cycle Draw. With this feature your brush continually changes 
color through the current range of colors, so you get brilliant 
spectrum effects. 

Of course, MacPaint is not the only paint program. There are 
many other fine ones, most of which work similarly, including 
SuperPaint, which can both paint and draw. And there is one pro­
gram that fuses paint powers with a panoply of others: HyperCard. 
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Hr11ercard 
After Bill Atkinson wrote MacPaint, he went on to write a far more 
ambitious program called HyperCard, which debuted in 1987 to 
great enthusiasm. HyperCard was a true innovation and, initially, 
hard to describe. Programmers around the world are busy making 
clones, so such software may soon develop a generic name. For 
now, perhaps the .best description is that it's an interface with spe­
cial graphics and database powers, which makes buttons, dialog 
boxes, scroll bars, and other Macintosh features readily available 
for you to manipulate. Hence, it gives you remarkable control over 
the machine. 

There are many thick HyperCard books on the market but, un­
fortunately, some are almost overwhelming. You can easily get the 
impression that creating a HyperCard stack is an arcane endeavor 
demanding much sober expertise. In fact, it's simplicity itself. This 
chapter shows you the basic steps to creating stacks, and it pro­
vides some special graphics tips for using this delightful program. 
HyperCard is a world in itself; for more information, you should 
purchase one of the comprehensive books, which are generally 
very informative. 

The Superficial Elements 
HyperCard works quite differently from most other programs. It's 
like a deck of playing cards, except you can jump around from one 
card to another with magnificent ease. Here are the major ele­
ments, as they appear to a casual user. 

Cards. Most programs contemplate printouts on sheets of pa­
per, and hence work with basic units of 8.5 X 11 inches. 
HyperCard is oriented to the computer itself, and thus its basic unit 
is the size of the original Mac screen, that is, 7.11 X 4.75 inches. 
Such a screen is called a card. (On the Mac II, cards are that size 
also, but since the screen is larger, they appear as rectangular isles 
in the center of the monitor.) 

Stacks. Cards in HyperCard are not isolated entities but appear 
one atop another, like a ream of paper. Peel one card off and you 
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see another beneath it. A single pile of cards is called a stack. The 
stack is the basic HyperCard document. 

Buttons. Buttons are one of the key tricks of HyperCard. They 
make things happen. Click a button and you can move to another 
card or stack, bring up a dialog box, trigger a sound, and otherwise 
cause action. The most important buttons are navigation buttons, 
which move you around. They are like instant secret passages, 
shifting you at once from one locale to another. 

Text. Many HyperCard cards have special areas where you can 
type in records or other data. 

From the Ground Up 
A creator of HyperCard stacks sees a picture rather different from 
the one the casual user sees. That's good. It means HyperCard uses 
a variety of tricks to simplify use. For the stackmaker, the following 
are the main elements: 

Backgrounds. This is a basic, unchanging format provided for 
a set of cards. A background might, for instance, simply contain a 
border. Each card using that background would also have that bor­
der but could have extra information as well. Backgrounds ease the 
creation of stacks, since they let you reproduce the same items over 
and over again. They give the cards a more uniform look, and not 
incidentally, they save disk space. 

Cards. Individual cards are areas where you supply the materi­
al particular to that card. 

Fields. These are the regions where the user can type in text. 
Fields may be completely transparent, look plain and rectangular, 
or have scroll bars; in any case, you must define them. You can put 
fields on either backgrounds or cards. 

Buttons. These are the tools for mobility that let you connect 
different cards or stacks, so you can jump about at will. Again, you 
can place buttons on backgrounds or cards (see Figure 3-1). 

User levels. Finally, HyperCard has a set of user levels invisi­
ble to the untutored user. They are: 

1. Browse, where you merely view the cards. 
2. Typing, where you can enter written information. 
3. Painting, where you can supply graphics. 
4. Authoring, where you can create buttons and fields. 
5. Scripting, where you can write· HyperTalk programs, which are 

called scripts. 
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Figure 3·1. Fleld and Button on a Background 
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Each level contains all the powers of the levels beneath. Most 
casual end users work in level 2, where they can't inadvertently do 
damage. If you are devising your own stack, there's no reason not 
to go straight to level 5. 

There are two ways to set user level: 

• From the User Preferences card, the last card in the Home stack. 
Here you simply click a radio button. 

•From the Message Box. Choose Message from the Go menu or 
press Command-M. When the box flashes onscreen, type set 
userlevel to 5 or whatever level you want, making sure that 
userlevel is all one word. Then press Return. This is the faster 
method. 

How to Make a Stack 
Here's a crash course in making a HyperCard stack. Again, if you 
intend to get serious about this program, you should probably buy 
one of the books devoted to HyperCard, particularly if what follows 
seems incomprehensible. But here is the procedure in a nutshell. 

Outline the stack on paper. Macintosh software can be so 
slick it tempts us to leap right in, without planning. Paper is still 
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good for many things, and one is preparation for using powerful 
programs. You should think through what the stack should do, 
what it should contain, and who's going to use it (Novices? 
Sophisticates?). 

Then you should map out a series of cards, indicating the func­
tion of each and the connections from one to another. This exercise 
provides the overall structure of the stack and shows the kind of 
mobility you have. Next, you should design rough thumbnails, or 
sketches, of each card or type of card-keep them rough. The 
thumbnails show you the graphics, buttons, and text of the cards, 
so you aren't lost when you commence card design. They also give 
you a chance to identify repeating elements, which you can place 
in a background. 

Access the power. First, press Command-M, type set userlevel 
to 5 in the Message box to establish the user level at Scripting, and 
press Return. 

Initiate the stack. Now, open any stack and choose New Stack 
from the File menu. A dialog box appears. Deselect the box next to 
Copy current background so you can begin with a clean slate. Enter 
a name for the stack and press Return. You now face a bare screen 
and can commence. 

Bring up the background. Choose Background from the Edit 
menu or press Command-B. The menu bar at the top develops dis­
tinctive little nicks. 

Add fields and buttons. Both are easy. 
For fields, select New Field from the Objects menu. A set of 

lines appear on the screen surrounded by moving dots, like an old­
time movie marquee. The field is selected, and you can now pull it 
around or change its size at will. (You can also create a field by 
choosing the Field tool in the upper right of the Tools menu, hold­
ing the Command key down, and dragging the mouse.) Now, double­
click on the field and a dialog box appears; you can name it and 
bestow upon it such qualities as scroll bar, shadow, and special font. 

Buttons work the same way. You select New Button from the 
Objects menu (or choose the Button tool from the upper middle of 
the Tools menu, hold the Command key down, and drag the 
mouse). A button appears surrounded by moving dots, and you can 
shift it around or change its size. Double-dick the button and a di­
alog box lets you name it and set its characteristics. The name ap­
pears within the button if you also choose Show Name (see Figure 
3-2). You can also add background graphics or prose at this stage. 
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Figure 3·2. The Button Box 
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Create the cards. To exit the background, press Command-B 
again. You are now in your first card. You add graphic~, prose, 
fields, and buttons to it as· you please, in the same way as above. 
Then you choose New Card from the Edit menu or press Com­
mand-N. Now you're on the second card, and once again, you see 
only the background. You design it, press Command-N again, cre­
ate the third, and so on. 

., 

Link the buttons and cards. Go to the first card, choose the 
Button tool from the Tools menu, and double-click the button you 
want to link. When the dialog box comes up, click on the LinkTo ... 
button. A dialog box appears, but you still have mobility through 
the cards and stacks of HyperCard. Go to the card to be linked and 
click This Card in the dialog box. (If you're going to another stack, 
go there and click This Stack.) If you misconnect, simply repeat the 
procedure and link up correctly. The prior link disappears. 

The stack is finished. Now, this is really not very hard. If 
you've never used HyperCard it may seem complex at first, but as 
soon as you've done it once or twice, the difficulty simply drops 
away. The hardest thing about HyperCard is taking the plunge. 

Stacks with more than one background. There is one compli­
cation that arises when you want a stack with more than one back­
ground, but even here, the adjustment is minor: 
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•Outline the cards on paper, and determine how many different 
backgrounds you need. 

•Create the first background, and as many cards as it applies. Add 
all the fields and buttons the background needs. 

•Go to the last card of the background and choose New Back­
ground from the Objects menu. This instruction generates both a 
new background and a new card. If you aren't at the last card 
when you issue this command, you'll find yourself with three 
backgrounds instead of two and you'll lose disk space. 

• Add fields and buttons to the new background. 
• Add as many more backgrounds as you need and fill in their 

cards. 
•Link the buttons. 

As you get more fluent with HyperCard, you'll find you don't 
have to follow these procedures to the letter. HyperCard is enor­
mously flexible. But at the outset, these procedures provide the 
basic guidelines. 

You can also modify existing stacks, a faster procedure. You 
simply enter the stack and change the user level to 4 or 5. You can 
then work with buttons and fields, alter the backgrounds, and other­
wise customize the stack. 

Hraercard Graphics 
HyperCard has most of MacPaint's features, so you can easily paint 
directly onto a card or background. However, paint in HyperCard is 
not quite the same as in MacPaint. There are a number of novelties. 

First, HyperCard's paint powers do not come into full view un­
til you select a paint tool from the Tools menu. At that time, three 
new menus appear to the right: 

•Paint 
•Options 
•Patterns 

In addition, the File menu gains the Import ... and Export. .. 
commands. 

The tear-off Tools menu has not only the familiar items such 
as the Pencil and the Spraycan, but also the vital Button and Field 
tools used to create buttons and fields; they're at the top and slight­
ly marked off from the rest. It also has the Browse tool, which is 
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essentially the familiar pointer. At the same time, it lacks the Grab­
ber, since you never need to pull hidden parts of a card into view 
(see Figure 3-3). 

Figure 3·3. Hv11ercard's Tear-OH Tools Menu 
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Though HyperCard automatically saves most acts at once, 
when you're working in graphics it holds back and gives you room 
to bail out. To save, choose Keep from the Paint menu or press 
Command-K. The program automatically saves when you go to an­
other card or leave the paint tools. To resurrect the card as it was at 
the last save, choose Revert from the Paint menu. 

HyperCard also has a few new graphics powers: 

Regular Polygon. HyperCard has a Regular Polygon shape, that is, 
one that generates polygons with sides of equal length. You 
choose Polygon Sides from the Options menu (or double-dick 
the Regular Polygon tool in the Tools menu), and a dialog box 
appears. Choose the number of sides you want, and then pull the 
shape out. The Regular Polygon has several interesting distinc­
tions. It's the only shape that automatically draws from center. 
Moreover, if you tum the mouse as you drag, the image rotates. 
This power thus provides an excellent way to tum a square into a 
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diamond, and otherwise to fully rotate it. To constrain rotation to 
15-degree increments, hold the Shift key down as you pull. 

Pickup. The Pickup command in the Paint menu lets you select in 
special shapes, rather than in the rectangle of the Marquee or the 
external edge of the Lasso. For instance, if you wish to Pickup a 
circle out of a graphic, you would choose Draw Filled from the 
Options menu; draw the circle (Shift-Oval); choose Pickup and 
see the shimmery outline; and then either move the item, Cut it, 
or Copy it to the Clipboard (see Figures 3-4 and 3-5). The Pickup 
command can be a potent device and yield unusual forms. 

Darken and Lighten. These two commands in the Paint menu let 
you add and subtract black pixels to and from a selected area at 
random. They're rather like an airbrush, working within limits 
you define. They are sparse, and you may need many commands 
to fill or deplete an area. Among other things, these commands 
are excellent for creating a neutral tone, because they can yield a 
grayish area that also· looks rather uneven. 

Draw Multiple. Here's a nifty trick: Choose Draw Multiple from 
the Options menu, then choose a regular shape from the Tools 
menu. As you pull it out, it yields a sequence of shapes of differ­
ent sizes, all starting from the same point. Thus, pulling out a 

Figure 3-1'. Pickup Command: Step 1 
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Figure 3·5. Pickup Command: Step 2 
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circle can yield a cone. (You can make the shapes concentric by 
choosing Draw Centered from the Options menu.) After you 
choose Draw Multiple, you can also press Option and any num­
ber from 1-9 to set the interval in which images appear. Some of 
these shapes make good buttons. For instance, the Rounded Rec­
tangle with Draw Centered yields unusual shapes, as does the 
Regular Polygon, especially when rotated. If you tum the mouse 
as you pull out the Regular Polygon, the images rotate as they 
grow, creating an effect like the iris diaphragm aperture of a cam­
era (see Figure 3-6). 

Transparency. You can make the white of any image transparent in 
HyperCard by selecting it and choosing Transparent from the 
Paint menu. This power also affects images you Paste in. You can 
always return to the default setting, which is Opaque. 
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Figure 3·6. Vortices 

The Tools 
As you've seen, the Regular Polygon replaces the Grabber on the 
Tools menu. Apart from that and the new top tier, the HyperCard 
Tools menu looks pretty much like the MacPaint menu. 

That similarity is deceptive. HyperCard graphics have a slew of 
subtle differences. For instance, HyperCard affords more freedom 
with the Option key. In MacPaint, pressing Option almost always 
changes the cursor to the Grabber. Here, with no Grabber, the Op­
tion key is free. 

HyperCard does, of course, retain a great many of the qualities 
of MacPaint. Let's go over the tools one by one and note the 
differences. 

The Paintbrush. The Paintbrush works a bit differently in 
HyperCard. For instance, it does not paint over buttons and fields in 
the same layer. In a background, it doesn't paint over background 
buttons and fields, and in a card, it doesn't paint over card buttons 
and fields . However, in a card you can paint over buttons and 
fields in the background-they're still there and still work, so 
painting over a background button enables you to hide it. 

• Hold the Command key down as you pull and the Paintbrush be­
comes an eraser, in whatever brush shape you've selected. 

The Spraycan. The Spraycan has one new trick. If you hold 
the Command key down and spray, you now get a mist of white. 

The Pencil. As we've seen, the Pencil switches the color of the 
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first pixel it touches and then changes every other pixel it touches 
to that color. In HyperCard, the Pencil reacts to the first pixel­
drawing black if it initially encounters a white pixel and vice versa) 
whether it's in the card or background. This is an unusual quality, 
since the graphics tools generally affect background only when 
used in background mode. However, if you're in a card, the Pencil 
doesn't actually alter the background. 

• Hold down the Option key and click the Pencil, and you go into 
FatBits at the point where you've clicked. 

The Eraser. The Eraser, too, has subtle differences. In a back­
ground, it turns black pixels white, as in MacPaint. In a card, how­
ever, it makes both black and white pixels transparent, so any 
black pixels from the background show through. Thus, you can 
find yourself passing the Eraser over white areas and making 
graphics appear, a seemingly non-Eraserlike function. 

• Hold the Command key down and pull, and the Eraser replaces 
all black and transparent pixels in a card with white ones. This 
method essentially gives you the Eraser of MacPaint. 

•Double-dick the Eraser icon and you eliminate just the graphics 
material on a background or card, not the buttons or fields. 

The Straight Line. The Straight Line works the same as in 
MacPaint, with these exceptions: 

•Press Shift as you pull out the Straight Line, and you constrain it 
to 15 degree increments, rather than 45 degree increments. 

• For patterned lines, hold the Option key down as you pull (not 
Command, as in MacPaint). 

• Double-dick the Straight Line icon and the Line Size box appears. 
The line sizes no longer repose in the Tools menu, but have their 
own command in the Options menu. 

The Paint Bucket. The Paint Bucket remains generally the 
same potent little monarch, prone to stunning error. 

• Double-dick the Paint Bucket icon in the Tools menu and the Pat­
terns palette appears. Double-dick it again and the palette 
vanishes. 
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The Shapes. The shapes-Rectangle, Rounded Rectangle, 
Oval, Freehand, Irregular Polygon-have most of the same powers 
as in MacPaint, but they do a few things a little differently. 

• To choose a filled shape, double-dick its icon. This act turns all 
six shape icons gray like the permanent icon in MacPaint. You can 
also choose Draw Filled from the Options menu. (To choose the 
filled Regular Polygon, you must double-dick another shape icon 
first, since double-clicking the Regular Polygon itself brings up 
the Polygon Sides box.) 

• Hold the Option key down and pull out the shape, and the border 
appears in the pattern selected in the Patterns menu. 

• Hence, for a borderless filled shape, double-dick the icon (or 
choose Draw Filled from the Options menu), hold the Option key 
down, and pull it out. This act replicates the Fill command in the 
Paint menu. 

The Irregular Polygon. The Irregular Polygon has one _extra fea­
ture missing from MacPaint. Hold the Shift key down for con­
straint, and you can create lines in increments of 15 degrees, not 
45. In this regard, it resembles the Straight Line in HyperCard. 

Text. You can add text to stacks in two ways: with fields and 
with the Text tool. There are a few differences. It's easier to use the 
Text tool, since you don't have to create a field and then make it 
invisible. Moreover, since Text tool characters become graphics, you 
can use special fonts without worrying whether someone on anoth­
er system has the same fonts. However, Text tool characters suffer 
at printout. As graphics, they go to the laser printer bit-by-bit, 
though you can usually improve quality by checking Smoothing 
under Page Setup in the File menu. Field text automatically turns 
into laser fonts in the LaserWriter and prints at 300 dpi. 

•Double-dick the Text icon and you see the font dialog box, the 
same one you get with the Field tool, which lets you select fc;mt, 
size, style, alignment, and line height. 

• As in MacPaint, you can alter font, font size, or line spacing by 
pressing the less-than key or greater-than key plus Command, 
Command-Shift, or Command-Option, respectively. 

The Lasso. Hold the Command key down and click the Lasso 
inside an item, and it selects black pixels near the point of clicking 
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plus any pixels that touch them. This is a very handy way to select 
a closed figure. 

The Marquee. Hold the Command key down as you pull out 
the Marquee, and it completely surrounds your item and changes 
to a Lasso. Why not just use the Lasso? Try this and you'll see. It's 
a whole lot faster. 

Hv11ercard Cllp Art 
HyperCard abounds in clip art, which you can select and move all 
over the place. The Art Ideas, Button Ideas, and Clip Art stacks 
have plenty of graphics, which you can dip into at will, and for 
snappy stacks it really makes sense to familiarize yourself with the 
wealth available. You may even wish to print out the clip art for 
fast reference. To move this art into your stack, follow the same 
steps as with any Mac program. You select with the Marquee, then 
Copy and Paste from the Edit menu. 

You can also use art as buttons. With buttons, however, the 
procedure is a little more involved, since you want HyperCard to 
recog~ize the graphic as a button. Here's how to put an arrow­
one of the most common buttons-where you want it: 

•Create at least one background. 
• Go to the Home card, click on the Button Ideas stack, and flip 

down to the card with the arrows (see Figure 3-7). (This stack also 
has Home and Macintosh icons, plus a raft of others.) 

• Choose the Button tool on the Tools menu, then click on an arrow 
and copy it by pressing Command-C or choosing Copy Picture 
from the Edit menu. 

• Return to your stack by choosing Recent from the Go menu and 
clicking on the mini-picture of the card in your stack. 

•If you want to place the button on the background, press Com­
mand-B or choose Background from the Edit menu. Otherwise, 
the button can exist solely on that card. 

•Paste the arrow by pressing Command-V or choosing Paste from 
the Edit menu. You can always move it once it's pasted. 

You can also import graphics from outside HyperCard, if they're 
in the MacPaint format. You simply use the Clipboard or Scrapbook 
to import parts of files, and it works fine. However, if you want to 
bring the entire file in with the Import ... command in HyperCard 
(under the File menu, but only after you've selected a paint tool 
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Figure 3· 7. The Arrow Buttons 
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from the Tools menu), you must realize that it will completely cov­
er whatever else you have on a card. Hence, the best approach is to 
create a separate stack especially for imported graphics, where each 
card is a single import. In building this stack, you choose Ne.w 
Card from the Edit menu, then choose Import. .. from the File 
menu, and pick from among the files listed. It fills the card, you is­
sue another New Card command, and so on. Why use Import. .. at 
all? HyperCard compresses these files, saving disk space. 

Transitions 
One of the slickest things you can do with HyperCard is control the 
transitions from card to card. It involves a dip into programming, 
that fearful domain, but the results are so appealing, the effort so 
minor, and the sense of accomplishment so pleasant that it's worth 
the plunge: 

•Choose Message from the Go menu or press Command-M. Type 
set userlevel to 5 and press Return. 

•Go to the card where you want to start. Choose the Button tool 
from the Tools menu, then double-dick on the button you're leav· 
ing to get its dialog box. 
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• Click on the Script. .. button. This act reveals the set of HyperTalk 
instructions that makes the button work in the first· place. 

• The first instruction is mouseUp. Place the insertion point imme­
diately after it and press Return, to open another line. 

• Type visual effect dissolve. Click OK (see Figure 3-8). 

figure 3·8. The Script Window 
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. Now when you click on this button, the card seems to break 
into tiny granules and fade into the next card. It's a striking effect. 

The words visual effect (or simply visual) constitute the basic 
command that tells HyperCard to use a special transition. The last 
word, dissolve, tells HyperCard which kind to use, and you can 
substitute a number of other effects for it. (These commands won't 
work alone; they have to be part of a valid script and .begin with 
proper commands like on mouseUp.) 

•scroll up. The new card first appears at the bottom and slides up 
to the top. 

• scroll down. The new card appears at the top and slides down. 
• scroll left. The new card appears at the right and moves left. 
•scroll right. The new card appears at the left and moves across. 
• wipe up, wipe down, wipe left, and wipe right. These commands 
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work just like scroll, except they move in only new material. The 
scroll instruction moves in a whole new card, whether the back­
ground is the same or not. 

• Barn door open. The new card appears first in a line down the 
middle of the screen and spreads to the sides. 

•Barn door close. Halves of the new card appear at the sides and 
spread to meet at the center. 

• Venetian blinds. Parts of the new card first appear at several lines 
across the screen, and slide up shutterlike to meet the lines above. 

•Checkerboard. Parts of the new card first appear at the bottom of 
numerous squares, and slide up to meet the squares above. 

• Iris open. The new card first appears at the center of the card and 
opens outward. 

•Iris close. The new card first appears at the sides and spreads in 
to the center. 

• Zoom open. The new card first appears where you click the 
mouse and opens out from there. 

• Zoom close. The new card first appears at the sides and moves in 
to the point of the mouse click. 

You can go wild with these instructions, but for most purposes 
a little discretion is appropriate. 

The open commands should generally unveil a new, unseen 
screen, and the close ones should return you to where you were. 

Commands with left and up in them also usually introduce 
new material, while the right and down commands retreat. 

The iris and zoom commands are often used to reveal cards 
with more detailed information on them. 

The dissolve instruction has several purposes. It can move you 
from the title card to the second in the stack, show the passing of 
time, or simply indicate a gradual transition from one card to 
another. 

There are two more aspects of transition which you can also 
control with instructions: speed of transition, and intermediate 
shade. 
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To determine how quickly HyperCard moves from one card to 
another, place the following words after the visual effect commands 
above: 

very fast 
fast 
slow (or slowly) 
very slow (or very slowly) 

For instance, you might type in: 

visual effect checkerboard very slowly 

For truly special effects, you can indicate an intervening shade 
after the speed. The commands here are: 

to black 
to white 
to gray 
to inverse 

Hence, a complete instruction might be: 

visual effect iris open slowly to inverse. 

This intermediate-shade command absolutely must come after 
the speed command, if you use one, or HyperCard does not under­
stand the instruction. 

What do these commands do? They add another little visual 
element. If you type to gray, for instance, the screen briefly goes 
gray before revealing the next card. If you type to inverse, it briefly 
displays an inverted image of the next card-white for black and 
vice versa-before showing the true one. This latter effect works 
best on very slowly, since at faster speeds it creates a weird and 
startling flash (which, of course, you may desire). In general, 
though, you should reserve showy effects for appropriate occasions. 

HyperCard mixes great graphics powers with a host of other ca­
pacities, but it still remains paint. To examine the next realm, we 
must move on to draw. 

66 



" Mastering Draw 
A paint program is like transparent tropic water, where you gaze 
down and see brightly-colored fish and think you've seen it all, un­
til you don scuba gear, swim down among the reefs and discover 
there is much more. In draw, on the other hand, the water initially 
seems much murkier. Yet it teems with life, and ultimately may 
hold more possibilities. 

If you come to a draw program straight from paint, you may 
find it constricting. Draw programs often have fewer commands 
than paint, and the approach may seem strange and arcane. Draw 
forces you to work with pieces-rectangles, circles, and lines­
rather than pixels. It lacks the safety net of fast erasures and 
FatBits. Draw is not as intuitive as paint and requires a bit of study. 
You have to lift up the unprepossessing lid to see what's really go­
ing on. 

But the very drawback of constraint can sometimes be a virtue. 
Since you work with shapes rather than pixels, you gain much more 
flexibility and control over your graphic. You may also gain access 
to features like fountains, which rarely appear in paint. Also draw 
yields better laser printout than paint, for reasons we have seen. 

The key to draw is planning. Unlike paint, where you sail out 
into the unknown with a smile on your face and a moistened finger 
for a weathervane, here you must sketch out your work in advance, 
breaking it down into components. Later you assemble the pieces 
by grouping, rather like welding, and obtain a resilient image. 

Let's go through a basic draw program, this time using 
MacDraw II as the model, and highlight its main aspects. 

Basic MacDraw 
MacDraw has a number of features that resemble those in Mac­
Paint, but often they work somewhat differently. If you are used to 
paint, the result can be occasional disorientation, almost like cul­
ture shock, in which normal things just don't seem to work the 
way they should. The differences are often minor-a matter of al­
tered approach rather than novel concept-but it may take awhile 
to understand this. 
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Creating ObJects 
The first set of differences comes with creating objects. Objects are 
the building blocks of draw; they can be circles, rectangles, lines, 
combinations of shapes, or almost any form you can conceive. 

Selecting Objects. Objects are easy to select, because the com­
puter already understands their shape. In paint, you have to use 
the Lasso or Marquee to select a group of pixels, but in draw, you 
have two quick options. You either surround an object with the 
marquee that is constantly available from the tip of the pointer, or 
you double-click near the invisible rectangle around the object. If 
you're not sure where the rectangle is (it's invisible), you can 
usually bring it up by double-clicking at the point on the object 
furthest from the center. 

You'll recognize a selected object at once by the tiny black 
squares called handles that appear around it. The pointer can grasp 
the handles to make further adjustments on the object (see Figure 
4-1). 

Group Selection. You can select numerous objects at once by 
Shift-clicking or pulling the marquee around them. Once they're 
selected, you can move them, clear them, fill them with a pattern, 
or perform some other operation on all at once. 

Figure 4· 1. Handles 
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Selecting Tools. You select tools for one of two durations: 
once-only or ongoing. Paint provides an example of the ongoing 
mode: You select a tool and it stays selected until you click another 
one. In draw, you have a choice, and the default mode is once-only. 

Normally when you choose a tool, its icon becomes only partly 
dimmed. You draw an object and the program automatically selects 
it on the screen, contemplating that you'll wish to alter it at once. 
At the same time it deselects the icon so it turns white again. To 
use the tool immediately thereafter, you must click it anew. 

You can select. a tool for ongoing use by double-clicking its 
icon. The icon goes black. You can now create as many shapes as 
you like without reclicking the icon. The shapes appear on the 
screen without boxes at the comers, indicating that they are unse­
lected. To bail out of ongoing mode, click the pointer icon in the 
upper left of the screen. 

The Tools 
MacDraw II has far fewer tools than MacPaint, and most of them 
are shapes. Their icons lie permanently along the left side of the 
screen, and they are: 

•Straight Line 
•Rectangle 
• Rounded Rectangle 
•Oval 
•Arc 
•Freehand 
•Polygon 

The Straight Line, Rectangle, Rounded Rectangle, and Oval 
work pretty much as they do in paint. However, the program lets 
you control the amount of curvature in a rounded rectangle by 
using menu commands. You create a square-comer Rectangle, 
choose Round Comers from the Edit menu, then type in the radius 
length under Radius. Since the curve is always 90 degrees, the ra­
dius equals the extent of the curve on each side. This dialog box 
also lets you tum two opposite sides into semicircles and create an 
oblong by picking Round ends. This command works by setting the 
radius to half the length of the side (see Figure 4-2). 
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Figure 4·2. Customizing Rounded Corners 
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The other three MacDraw tools merit a moment's attention. 
They don't fill automatically, and the Reshape command works 
only with them. 

Arc. MacPaint has nothing like the Arc, which yields one 
quadrant (90 degrees, or one quarter) of an oval. If you want an 
Arc larger or smaller than 90 degrees, create an Arc, select it, 
choose Reshape under the Edit menu, and extend or retract it. 

Freehand. The Freehand tool is the rough equivalent of the 
same item in MacPaint. You drag it wherever you like, and when 
you stop the shape is fixed. When you use it with line width at 0 
points to make a filled borderless shape, the line appears onscreen 
as you draw. When you're finished, it vanishes, a box with four 
handles arises, and you fill. The Freehand tool does not close 
automatically. 

Polygon. The Polygon is irregular, as in MacPaint. To make it 
close automatically, yoti must check the Close automatically box in 
Preferences ... under the Layout menu. 

., 

Borders. For all these tools, you set line or border width in the 
Pen menu. You either choose a preexisting option, such as eight 
point, or issue the Pens .. . command and type in a new size. That 
size then replaces the size currently checked on the menu and re-
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mains there until you replace it with something else. The Pen 
menu also offers arrows, dashed lines, and other useful effects. 

Fill. The Rectangle, Rounded Rectangle, and Oval always fill 
automatically with the pattern chosen from the array across the 
top. (The asterisk yields transparent fill, showing objects beneath.) 
To fill the others, you must select the shape and click on a pattern 
from the top. 

Borderless shapes. To create a borderless shape, choose or 
type in 0 point in the Pens ... dialog box under the Pen menu and 
then pull out the shape. If it's a Rectangle, Rounded Rectangle, or 
Oval, it appears in the prechosen pattern. Otherwise, it looks like a 
handled box around nothing and remains blank unless you fill it 
(see Figure 4-3). 

Figure 4·3. Shapes of MacDraw 
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Constraint 
MacDraw II has few of the secret commands that abound in Mac­
Paint, but Shift still has the effect of constraining the tools. With 
the Rectangle, Rounded Rectangle, and Oval, it yields a square, 
rounded square, and circle, just as in paint. Likewise, Shift with the 
Arc yields one quadrant of a circle. 

With the Straight Line and Polygon, constraint works a little 
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differently. Here, the result of pressing Shift depends on the setting 
under Preferences ... in the Layout menu. At default it's 45 de­
grees, so you can draw lines only at 45-degree intervals. 

However, if you set it to, say, 15 degrees, the program lets you 
draw lines either on the perpendiculars or 15 degrees from them in 
either direction. Hence, you can draw lines at 15 degrees, 75 
(90-15), 90, 105 (90+ 15), 165 (180-15), and so on. You can't 
draw a standard line at 45 degrees from the horizontal, as it would 
not be 15 degrees from a perpendicular. 

Constraint can be very useful with the Polygon for drawing 
parallelograms. You can simply set Preferences ... to the acute an­
gle within the parallelogram, press Shift, and draw the horizontal 
and angled lines. Shift is quite flexible in the Polygon. If you re­
lease Shift while you're adding sides, you suddenly have complete 
freedom, and you can depress the Shift key again at any time to re­
impose constraint. 

Erasing 
One of the most noticeable differences between paint and draw is 
erasing: It's simply harder in draw. There is no Eraser and you lack 
the pixel-by-pixel freedom of paint. Normally, you must erase one 
object at a time. You select an object, then choose Clear from the 
Edit menu or press Backspace, and it vanishes. If you have just 
pulled an object out, you can also vaporize it with Undo. 

However, you can partly overcome this problem with the tech­
nique known as masking. Masking simply entails placing a border­
less white object in front of whatever you want to erase. For 
instance, a borderless white rectangle can function fairly well as an 
eraser (see Figure 4-4). It doesn't truly erase, since the object re­
mains hidden below, but the effect is more or less the same. If you 
want to mask an item that appears against a patterned background, 
use a borderless shape with the same pattern as the background. 

Still another way to erase involves the Reshape command (of 
which there's more below). If you extend the line of a polygon a 
bit too far, you can often pull it back with Reshape. Select the ob­
ject, choose Reshape from the Edit menu, grab the handle of the 
errant line, and gently realign it to the rest of the figure. 

To erase the whole page, choose Select All from the Edit menu 
(or press Command-A), and choose Clear from the Edit menu (or 
press Backspace). 
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figure 4·4. Masking 
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Patterns 
MacDraw II lets you create your own patferns. You choose the Pat­
terns ... command in the Layout menu and a dialog box appears 
where you work pixel-by-pixel, as in FatBits. Double-dick on any 
pattern in the row at the top, and this box appears onscreen 
q.utomatically. · 

Replacing patterns, a headache in MacPaint, is a hayride in 
MacDraw. You just select the object and click a new pattern from 
above. 

At times you may want to extend a pattern within an object. 

., 

You can do so very easily by drawing a borderless filled shape atop 
the annexed area with the Freehand tool. It's like masking, which 
basically extends a pattern of white. 

Grid 
Like MacPaint, MacDraw II has a Grid, though here it's a more po­
tent item. The Grid gives orientation, showing you where to place 
objects and how large they'll be. It's a useful feature, essential for 
plotting precise dimensions. 

Most of the main Grid commands lie in the Layout menu. The 
first feature is the Show Gridlines command. Choosing it cross-
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hatches the screen in dotted lines, displaying the Grid for you. If 
you've dealt with the invisible Grid in MacPaint, you know a visi­
ble one is a mighty asset. 

For a better sense of place, choose Show Rulers from the Lay­
out menu, which lays down one ruler atop the screen and another 
down the left. In default these rulers show inches, but under Rul­
ers ... in the Layout menu you can alter it to show centimeters. It's 
not just frippery: The dots in the displayed Grid correspond to the 
markings on the rulers, so if you choose centimeters, you get a 
denser line of dots (see Figure 4-5). 

Figure 4·5. The Rulers Box 
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Moreover, the snap-to feature called Autogrid constrains regular 
shapes to the markings on these rulers, so centimeters can yield 
more finesse. Paint has a similar snap-to, as we've seen. Autogrid 
may be a big help or a fantastic obstacle. In default it's on, and if it 
gets in your way choose Tum Autogrid Off from the Layout menu. 

The inches or centimeters on the rulers often correspond to 
other units of measurement such as miles, and you select these too 
in the Rulers ... box. You can choose among not just inches and 
centimeters, but feet, miles, meters, kilometers, and other units. 
The Rulers ... box shows two different rulers, one above the other. 
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The top ruler displays inches or centimeters as they actually are, in 
"real-space." The bottom one shows the ruler that appears 
onscreen. For instance, if you set 0.25 inch to equal one mile, the 
top ruler would show an inch as an inch and the bottom would 
show multiples of four at every inch-4, 8, 12, and so on. If you 
set one inch to equal four miles, you will get exactly the same re­
sult, because the scale is the same. 

There are six different preset rulers under Rulers, and you can 
alter them to whatever you like and keep them conveniently 
available. 

The third feature crucial for exact drawing is Show Size. Choose 
it and two notational devices appear in the lower left, informing 
you of the coordinates of the cursor up to four decimal points. If 
you choose, this feature also displays the unit of measurement 
you've selected, such as miles. 

Movement 
In MacDraw II, you can slide objects easily about on the screen in 
two ways. If you press the mouse button when the pointer is over 
an edge of the object and then drag, you see the object's rectangle 
following along until you release. If you carry out the same act 
with the Command key held down, the actual contours of the ob­
ject follow. The latter method allows finer placement. 

There are times when you may have many different objects 
clustered together and wish to move some while keeping others 
stationary. You can hold an object in place by selecting it and 
choosing Lock from the Arrange menu. To give it freedom of mo­
tion again, choose Unlock. 

Dupllcatlon 
As in paint, you can duplicate an object. You simply select it and 
choose Duplicate from the Edit menu. A new object appears offset 
slightly from the first. This command is very useful for creating ob­
jects that appear to be three-dimensional, such as cubes. You create 
a square, duplicate it, and pull it somewhat away. At this point, 
you can link the comers with straight lines, but you won't be able 
to fill in the apparent sides with white to hide the back contours. 
Lines are just lines, and you need planes. You can do better by 
using the Polygon to trace over two of the existing edges and link­
ing the comers above and below. A second Polygon forming the 
top completes the cube. 
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MacDraw cannot leave an instant trail of objects in the manner 
of MacPaint, but if you select and then press Command-Dover and 
over again, you'll get a string of copies you can then manipulate. 

Zoom 
MacDraw has an even more powerful Zoom than MacPaint. It lets 
you magnify up to 3200 percent, and shrink to a minuscule 3.12 
percent. The Zoom commands are located in the lower left of the 
screen; they're the two boxes with what look like mountains inside. 
To magnify, click the box with the larger mountains. To shrink, 
click the smaller ones. 

Rotating and Fllpplng 
You can easily rotate an object to any degree you want. You select 
it, then choose Rotate from the Arrange menu. The cursor becomes 
a large X, you grab a handle with it, and tum it around. The Rotate 
command remains checked until you uncheck it. 

You can also flip an object by selecting it and choosing Flip 
Horizontal or Vertical from the Arrange menu. Flip replicates turn­
ing an object 180 degrees about an axis. There are two axes 
through every object, so Flip Horizontal swings the object around 
like a door, and Flip Vertical swings it like a flap. If you duplicate 
an object and then flip it, you can gain mirror images. 

Advanced MacDraw 
The true glory of draw comes less from creating items, as in paint, 
than from manipulating them. You've already seen how easy move­
ment and duplication are, but the formulaic nature of objects lends 
them even more powers. Once you have an object on the screen, 
you can work on it as a whole and alter it in almost any way you 
can imagine. You can change its size and shape, align objects, 
move them behind and in front of each other, fuse them together, 
and take them apart. 

Changing Shape 
Changing shape is easy. You select an object, pull one of its han­
dles, and it expands or contracts. For instance, a rectangle has han­
dles on each of its corners. Place the pointer on one and drag, and 
the rectangle swells or shrinks. 

Note that this power lets you change shape as well as size. 
You can make a squarish rectangle into a long, thin one. Where 
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you have an irregular shape, the change is even more dramatic. Se­
lect it and a box appears around it. The final shape can actually 
look quite different from the original. 

MacPaint performs this feat too, but in a cruder way. For in­
stance, MacDraw doesn't distort patterns as MacPaint does in 
stretching them, nor does it yield awkward double lines. Moreover, 
if you expand an image enough in MacPaint, you actually see the 
basic pixel shapes. You don't in MacDraw (see Figure 4-6). 

Figure 4-6. Reshaping 
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Reshape. Normally, handles appear only at the comers of the 
rectangles that enclose your object. You can move these corners in 
various directions, stretching and distorting the whole object like 
Turkish taffy, but you can't work locally. 

However, with the powerful Reshape command in the Edit 
menu, you can go farther . This instruction adds handles at angles 
or other significant places of the shape itself, and it lets you move 
them about to change shape locally. Instead of stretching the entire 
object, you stretch only part of it. Reshape works only with the 
Polygon, Freehand, and A.re. 
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• With the Polygon, it makes the handle you grasp mobile so you 
can move it where you like in relation to the stationary handles 
on either side. Since the handles appear at angles, you can devise 
forms very different from your initial creation. 

•With the Freehand tool, choosing Reshape creates a set of handles 
along the figure. You select one, and straight lines appear at once 
linking it to the handles on either side. You then move it about as 
you do with the Polygon, and when you stop, the program bends 
the new angle back into a curve (see Figure 4-7). 

figure 4· 7. Reshaping Locally with a Freehand Form 
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• Finally, with the Arc, Reshape works a little differently. It con­
strains you to extending or contracting the Oval you've already 
begun to form, so you can go from 90 degrees of arc to any 
amount above or below (see Figure 4-8). 
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Figure 4·8. Reshaping Arcs 
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Smoothing 
MacDraw II also lets you Smooth the sharp comers of Polygons. 
Select one, choose Smooth from the Edit menu, and angles become 
curves, rectangles, and ovals. The sharper the comer, the smaller 
the curve (see Figure 4-9). The Unsmooth command, also under 
Edit, lets you retract the Smooth at any time, a perpetually avail­
able Undo. It also turns Freehand shapes into Polygons. 
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Figure 4·9. Smoothing 
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The Grid is very useful in MacDraw, but another feature that's 
equally so is the Align command. This instruction lets you bring 
two or more objects into alignment vertically or horizontally, by 
center or by edge. Instead of carefully placing objects at various 
gridpoints, the program aligns them for you. You first choose 
Alignment. .. from the Arrange menu, to set the kind of alignment 
you desire. Then you multiple-select the objects you want to align 
by Shift-clicking them and choose Align from the Arrange menu. 
The objects fall into formation. 

Layering 
Since the program can keep track of objects whether they appear 
on the screen or not, you can superimpose one atop another in lay­
ers. You can even hide numerous objects, one beneath another, and 
later uncover them. It's a good idea not to tuck too many objects 
away like this, since the program retains them in memory even if 
you don't, and the secret existence of little hidden objects boosts 
file size and slows printing. 

Normally, the last object drawn is the one on top, but you can 
shuffle the objects around with commands in the Arrange menu. If 
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you choose Move to Front, the selected object jumps in front of all 
other objects. Likewise, Move to Back places it behind the pack. 
Move Forward and Move Backward shift the object ahead or be­
hind one layer. 

By checking Multi-layer selection under Preferences ... in the 
Layout menu, you can select items in different layers and execute 
commands all at once. 

Grouping 
You can also combine objects on the screen so they act as one. 
Mathematically, it's usually a simple matter of adding plus signs to 
join the different formulas . This act is called grouping. It's particu­
larly useful if you wish to move a collection of objects about on the 
screen, fill them with a pattern, or perform some other operation 
on them. You can distinguish ungrouped from grouped items by 
the number of handles they have. In MacDraw II, ungrouped ones 
will have four handles apiece, and the number of handles can rap­
idly proliferate. Grouped objects have four handles total (see Fig­
ure 4-10). 

Figure 4· 1 o. Grouping 
r S File Edit Layout Arrange Pen Font Size Style 

~O MDraw2-Layer#I 

rs;: "' 
~ 
~ ······ 

., 

81 



Chapter 4 

You can group items easily, by clicking on one, then pressing 
Shift and clicking on as many others as you like. Next choose 
Group from the Arrange menu. If later you wish to separate them, 
you ungroup them by choosing Ungroup from the Arrange menu. 
The Ungroup command leaves all the component objects selected, 
so if you immediately perform some other action such as a fill, it 
affects them all. You must deselect them and then select one if you 
wish to act on it alone. 

Beyond MacDraw 
There are a number of programs such as Cricket Draw and Illustra­
tor 88 which go quite a bit beyond MacDraw in their capacities. 
Some of the new features are listed below: 

Shear. Much of this software lets you slant an object. A rectan­
gle, for instance, becomes a parallelogram of an angle you 
determine. 

Autotrace. In Illustrator 88, autotrace is a tool that works like 
this: You click it near a bit-mapped form on a template. The pro­
gram then creates a draw image of the outline of the form. 
Autotrace may work somewhat differently. on other programs. 

Fountains. Fountains (or gradients, ramps, or blends) are areas 
where the hue or. shade changes smoothly into another, like a spec­
trum. You specify a beginning and end shade or color, and the soft­
ware provides the gradient. A program like Cricket Draw lets you 
deploy not only such linear gradients, but also logarithmic and radial 
ones; the latter amounts to a concentric fountain (see Figure 4-11). 

Figure 4· 11. Fountains 

These can be delightful and pleasurable effects, but you may 
want to use some caution here, especially if you're printing out­
even more especially if you're printing in color. Fountains work by 
supplying bands of hue across a certain area. Since the bands 
should be imperceptible, there are three basic cautions here. 
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The first is size of the gradient area, because the greater the 
area you must cross, the more obvious the bands become. It's like 
the basic concept of resolution. 

The second is the range of difference among the colors. If the 
colors are similar, you get a smoother blend, because you don' t 
have to traverse as much territory. A centimeter-wide fountain 
from light to dark yellow can contain much finer intermediate hues 
than one from green to deep red. 

The third is reducing the presence of black as much as possible 
in color, because black makes banding more visible. In the chapter 
on Output, you'll see that there's a fourth factor too- the resolu­
tion of both the halftone and the printing device. 

Shadow. A program like Cricket Draw also creates automatic 
shadows. You select an object, pull out a duplicate, and the software 
fills the space between them with black or a gradient of your choice 
(see Figure 4-12). 

Figure 4-12. Shadows 

Conclusion 
Although draw may seem a bit awkward at first, it really is a realm 
of intriguing effects. Draw programs are highly versatile and easily 
capable of creating much of the art we associate with paint. 
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From Pixel to Picture 
From the bison-painters at Lascaux to David Hockney and his en­
trancing vacancies, people have sought to commit their visions of 
life to a permanent medium. Paint and draw programs give you the 
same splendid opportunity, and there's no reason not to take ad­
vantage of them. However, without a few tricks of the trade, your 
art may well just lie there, flat and unconvincing. 

Artists aren't wunderkinder born with a transcendent gift, who 
simply sit before the canvas and respond to perfect inner dictates. 
Though excellence does require native talent, most artists also labor 
hard to master their craft and outline many versions of each picture 
before they finish it. For such reasons, a complete course in art is 
far beyond the scope of this book. Nonetheless, we can pass on 
certain tips. They won't make you a Dali, but they may lift your 
work off the ground. 

Line Ari 
Line art is art made of lines only, without fill. It's all around us, 
and the original Macintoshes lend themselves well to this genre. 
Line art has a great many uses. On the simplest level it lets you 
create icons, and in higher spheres it appears in newspaper ads, ar­
chitectural drawings, engravings, and many other places. 

Line art can be effective because it's usually enough to hint at 
what we're drawing. In fact, it's often preferable. If a picture en­
gages the brain, inducing it to fill in gaps and provide sense, we 
often feel more interested in the work. So, you don't have to fill in 
every detail; you only need capture the basics. 

A major challenge to line art-to most art, in fact-is to render 
three-dimensional objects on a flat medium. There are an assort­
ment of techniques to do this. 

Line Width 
It's vital to vary the width of lines. A picture with lines of uniform 
size lacks emphasis and richness, almost like a musical note with­
out timbre. To the brain, some lines matter more than others, and 
you can play on this fact by thickening them. 
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In particular, the outside contours of an item should be darker, 
to detach it from its surroundings. This rim is sometimes called the 
cutting edge. A cube, for instance, normally has six dark cutting­
edge lines, and you can add them easily in both paint and draw by 
drawing over existing edges with the Straight Line at thicker width. 
With an irr~gular cutting edge, such as the crest of a mountain 
range, it depends more on the program. In paint, you should use 
the thicker width from the outset. In draw, if you make the crest an 
object, you can select it any time later and set a new width by 
choosing it from the Pen menu. Most people don't notice the cut­
ting edge, though they pick up the effect subconsciously. 

As thicker lines have more impact, thinner or broken lines 
have less and do well for internal contours or folds. For instance, in 
the portrait of the man lighting a pipe that comes with HyperCard, 
the outline of the figure is bold and black, but lesser lines, such as 
the creases in the hat and the breaks between fingers, are broken 
and impress us almost as gray. They engage the attention less, as 
they should. 

Contour Lines 
As the name suggests, contour lines (or wraparound lines) are lines 
that follow the contour of an item. The eye quickly identifies them 
and understands that they convey shape (see Figure 5-1). For in­
stance, if you're drawing a salami, the cutting edge alone would 
look like an oval or oblong. But add a string of semi-circles down 
its length, and it fills out and we perceive it as a solid object. In 
paint, you can achieve such semi-circles easily, by Lassoing one 
end, pressing Option, and making several duplicates. In draw, if 
the end is an Arc object, you can make such duplicates by selecting 
and pressing Command-D. Contour lines are often not so simple, 
and each may demand separate labor. 

Figure 5-1. Contour Lines 
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Scale 
In general, we construe large items as being close to us and smaller 
ones farther away, since distant items occupy less of our field of vi­
sion. However, with items of significantly varied size, such as trees, 
it may be hard to tell whether they're short and close or huge and 
faraway. We can indicate the scale more precisely by including ob­
jects of known size, such as people, next to trees or buildings. 

Overlap ping 
One of the plainest ways to show depth is by placing one item in 
front of another, or overlapping. It sounds too simple to be worth 
mentioning; however, overlapping has other virtues, not immedi­
ately apparent. It can give scale, especially if some items are imme­
diately recognizable. In addition, if numerous objects overlap, you 
create an ample sense of depth pleasant to the eye. Overlapping 
also binds parts of a picture together, creating the sense of a coher­
ent whole. Where items do not overlap but merely stand beside 
each other, we not only lose valuable clues about depth, direction, 
distance, and size, but also find ourselves confronting several little 
centers of attention, and the picture loses unity. 

Distance and Shading 
The shade of an object is also an important cue to its distance. As 
items recede, they tend to pale. Why? In real life, dust in the atmo­
sphere filters out more and more light so less reaches the eye. You 
can see this effect yourself dramatically in mountain ranges that 
rise above each other in successive waves. Those farther away are 
distinctly lighter than those closer. Hence, as objects recede, you 
should lighten their shade. 

Perspective 
As every child knows, an item seems smaller at a distance than 
nearby. But how much smaller? And what about large buildings 
and other objects that recede uniformly-how do we convey their 
increasing distance in a convincing way? · 

Railroad tracks provide an important clue. We know the tracks 
are strictly parallel, or trains would have an unhappy time of it. Yet 
they narrow progressively as they recede and finally unite in a 
point on the horizon. Not before the horizon or beyond it, but right 
on it. Th~s interesting fact is the key to perspective (see Figure 5-2). 
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Figura 5·2. The Vanishing Point 

Developed by artists in the Renaissance, perspective in art 
seems highly improbable when explained directly, but it works dra­
matically. On the Mac, the Straight Line tool is a great help in 
achieving it. 

There are three kinds of perspective: one-point, two-point, and 
three-point. They basically refer to the number of "railroad tracks" 
you have. Let's look first at one-point perspective. 

Suppose you're facing a large block and the side nearest you is 
a full rectangle. Neither its height nor its width is receding, but its 
depth is. Hence, you have three kinds of lines: vertical, horizontal, 
and perspective. 

Here's how you make the perspective lines, the lines of depth. 
First, determine where you want the eye level to be and draw a 
horizon line there. Often that line extends across the middle of the 
screen, but to look down on objects you place it near the top. It's 
just like moving eye-level to the apex of the picture. Conversely, to 
gaze up at items, you place the horizon line near the bottom. If the 
items are of human scale, looking down on them makes them seem 
miniature and looking up, huge. Thus, a table drawn with a low 
horizon line resembles something out of Brobdingnag, the land of 
giants in Gulliver's Travels. 

Next, select a vanishing point on the horizon. The vanishing 
point establishes your eye position along the horizon line. It can be 
any point left, right, or center, but if it's on the right, say, you're 
looking at items from the right in the drawing. 

Let's suppose it is on the right. Now, create the rectangle part 
of the block, then draw spokes from its top left, top right, and low­
er right comers to the vanishing point. These are the perspective 
lines, and they show the structure steadily diminishing in size with 
distance. It's just as if railroad tracks emanated from the top and 
side of the building, and these lines show how the structure would 
appear to shrink if it extended to the horizon. 
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It doesn't, of course. You decide where you want it to end, and 
at that point insert lines parallel to the original rectangle. Erase the 
remnants of the perspective lines, and you now have a rectangular 
prism, in lifelike perspective (see Figure 5-3). Hang an array of 
them on the same vanishing point, and you get something that 
looks like a city. 

Figure 5·3. One-Point Perspective 

The procedure also works with curved items, like globes, peo­
ple, and animals. You simply enclose the shape in a box and follow 
the lines to the vanishing point. 

Perspective can also help determine the size of discrete objects 
at distance. For instance, perspective lines show the proper size of 
telephone poles following railroad tracks to the horizon. You begin 
by treating the poles as a single unit, drawing perspective lines 
from the top and bottom of the nearest pole to the vanishing point. 
Then you use the lines to determine the height of each pole. Note 
that, as the poles dwindle, you must place them closer and closer 
together. When done, you erase the perspective lines. The same 
trick works with people and almost any other item. 

So far, we've assumed the structure we face presents at least 
one flat side to us. But what if we rotate the block so we're looking 
at it on edge. Now, instead of dealing with height, width, and 
depth, we have height, depth, and depth. How do we render it? 

It's fairly easy. We just create a second vanishing point and a 
second set of perspective lines. One point lies to the left of the 
cube, the other to the right. We then mark off the two receding 
sides (see· Figure 5-4). This approach is called, not unnaturally, two~ 
point perspective. Two-point perspective uses only two kinds of 
lines: vertical and perspective. 

BB 



From Pixel to Picture 

Figure 5-4. Two-Point Perspective 

Suppose now we tilt the cube, so we're looking down on a 
comer. Instead of height, depth, depth, we have depth, depth, 
depth. The cube recedes from us in three directions. We solve this 
problem by adding a third point, creating three-point perspective. 
Of course, that point can no longer go on the horizon line. We 
place it somewhere near the bottom or top (see Figure 5-5). 

Figure 5·5. Three-Point Perspective 
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In theory, all perspective really has three vanishing points. 
With one-point, you have simply removed two of the points to in­
finity, so the horizontal and vertical lines can be parallel. With two­
point perspective, only one point is at infinity. 

Perspective is easy to render with paint, since you just draw 
the perspective lines with the Straight Line and then erase the parts 
you don't need. But it's also fairly simple with draw, though the 
technique is slightly different. You draw the perspective lines with 
the Straight Line and then carefully pull out trapezoids with the 
Polygon so they lie atop the perspective lines. (Here's a case where 
the "Close automatically" option in Preferences comes in very 
handy.) Then you select the perspective lines and Clear them. 
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Shadow 
Shadow is another major means of conveying depth. It, too, relies 
on a matter of basic subconscious knowledge: shade means space. 
Shadow is impossible in a two-dimensional flatland. Where we see 
it, we know we're looking at an object in depth. . 

How do you draw a shadow? Consider how it arises. A source 
of light strikes an object, illuminating it. That object, in turn, pre­
vents the light from reaching beyond. The area blocked out of the 
light is the shadow. 

Hence, you begin by determining the height of the light. You 
draw a line from the light source to that part of the item's top 
nearest you and beyond to the ground. With most objects, you 
wind up forming a triangle in which the bottom portion shows the 
depth of the shadow. Once you have this triangle, you cai:i use 
congruent triangles to place the shadow everywhere. 

With a plane like a billboard, for instance, you can create the 
triangle at one end and then simply move it down to the other. 
You draw a line between the two (parallel to the base of the bill­
board itself), erase the lines through the air, fj.ll the new shape, and 
you have the shadow. 

With a solid shape like the cube, the process is slightly more 
involved. You may have to draw the triangle from three top cor­
ners: the one nearest you, the one farthest from the light, and the 
one farthest from you. You connect three bottom portions, erase 
extra material, and fill in. With a sphere, you identify a circle gir­
dling it which ends the light, and draw a series of different sized 
triangles. · 

As it happens, this pleasant scheme gets a bit more complicat­
ed the more closely you inspect it. For instance, with large objects 
like buildings, you may need to adjust the shadow a bit with per­
spective, for the shadow recedes to the vanishing point, too. 

Moreover, congruent triangles work fine as long as the light 
comes from the sun. The sun is essentially an infinite distance 
away, so we can say it casts shadows in parallel lines. However, 
suppose the light comes from a light bulb quite close to the object. 
Suddenly, the lines are no longer parallel. They diverge, and the 
shadow is now larger than the object that casts it. Moreover, if the 
light bulb is at one end of the object, the shadow is irregular. Here, 
we must simply project a C<?ne fro.m the light source to the object 
and beyond, and then devise the shadow. 
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In addition, if the surface the shadow falls on is itself irregular, 
or if it angles away, the shadow grows more distorted and complex. 

Finally, shadow is not simply an affair of black or white. Most 
shadows have penumbras, grayish areas about the periphery where 
waves of light lap into the darkness despite the neat schema above. 
(Light is a very complex physical phenomenon.) Hence, you should 
blur the contours of large shadows, so they don't look crisp and 
clean. Penumbras are also apparent on the surface of curved ob­
jects. So, in shading a cylinder or sphere, you should provide a 
transition zone, perhaps of two different grays or a narrow 
fountain. 

Reflected light often partly illumines areas that would other­
wise be black. For instance, though the sides of a cube facing the 
light are white, the sides partly away from it should be light or 
dark gray. Only the side deepest in shade should be black. 

Shadow is not just important to show bulk. It can also indicate 
bumps and dips in a surface. For instance, it's invaluable with 
faces-beneath cheekbones, in eye sockets, under the lips-to 
bring out the full contour. You can also show surface irregularities 
by means of little patterned shadows on walls. 

Texture 
A common problem is how to render areas full of random yet rela­
tively uniform detail, such as fields or rocky cliffs. One possible ap­
proach is to sketch in everything, down to the smallest detail. You 
can do this, but it is wearying, both for you and the viewer. More­
over, such details are usually not important. The mind doesn't 
bother to register them, because we care more about the nature of 
the field than its precise constituents. In fact, too much detail can 
actually attract the eye to an area that just doesn't matter. Here, 
you want the equivalent of a broken line in line art. 

The solution is to render such areas by texture. That is, a 
sparse, semi-repetitive pattern can often convey the waving grains 
of wheat or the fleecy outline of an oak forest better than a mass of 
detail. 

A variation of this technique comes in handy when depicting 
crowds. To convey a crowd, you need not paint a set of individual 
portraits. In fact, the essence of a crowd is a mass of anonymous 
faces. Hence, you can individualize a few figures near the front of 
it, and tum the rest of the faces into more or less faceless copies. 
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This approach suggests the crowd as an entity rather than a com­
ponent of individuals, and greatly simplifies your work. Likewise, 
you can supply the details of nearby cobbles in a road and schema­
tize them as they grow farther away. 

Capturing Realltv 
Despite the tricks above, there is, unfortunately, no magic route to 
drawing a tree, a dog, a face. You simply must study a tree, say, to 
understand the pattern of the leaves and the basic structure of 
trunk and limbs. Though a tree may seem extravagantly difficult to 
draw, with its myriad tiny leaves fluttering in the breeze, it's not as 
hard as you might think. The very combination of repeated detail 
and motion aids the task. The eye does not register the peculiarities 
of each leaf, so we can render them with little splotches. 

To sketch animals and humans correctly, you need at least 
some study of anatomy, though not necessarily formal. For in­
stance, you might think you could render the feathers of a bird 
with texture, but in fact it doesn't work out well, since feathers 
cover a fairly intricate substructure-and they often change in ap­
pearance according to whether they're· beating down, when they 
close together, or up, when they spread open to let air through. 
Moreover, careful examination of bone and muscle structure is par­
ticularly important for drawing animals and people in motion. 

Faces in particular demand study. Eyes, noses, and lips all vary 
subtly but potently from one individual to another. Moreover, hair­
line differences separate one facial gesture from another. While we 
can understand these gestures instantly when we see them, most of 
us find it preternaturally hard to explain what it is, exactly, that 
we' re understanding. 

But even here, there are tricks of the trade. For instance, con­
sider the smile of the Mona Lisa, long synonymous with mysteri­
ous depths of character. In fact, the lips do seem unusual, smiling 
one moment, graver the next, as though in the same kind of subtle 
motion as a living person's. Yet the explanation is anticlimactically 
simple. Leonardo touched up the corners of the mouth with sfuma­
to, a smokiness akin to soft-focus in a camera. As a result, the cor­
ners lack fixed lines, and the mind supplies varying contours itself. 

Color 
If you've never worked in color before, you may be a bit over­
whelmed by the possibilities. Of course, you can splash the colors 
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around for their own sake. It's fun, and some artists have made a 
genre out of it. But you can also use them for more interesting 
effects. 

Color can convey distance, with at least three techniques: 

Pallor. As we've seen, dust in the earth's atmosphere always de­
flects light beams. Hence, distant objects lack the vibrancy of 
closer ones, and paler and grayer items seem further off. If you'll 
want a hillside to look miles away, don't paint it electric green. 

Receding colors. Even in abstract art, reds, yellows, and browns 
seem to advance toward you, while greens and blues recede. 
Thus, landscape painters tend to put brownish hues in the fore­
ground, greens and moderate yellows in the middle distance, and 
blues and grays far away. 

Blue. Blue is not just a receding color, but the typical cast of far-off 
objects. Sunlight stimulates air molecules to emit this color. 
That's why the sky is blue. By the same token, the more distant 
an item, the more blue creeps into it. Don't overdo the blue­
ness~it' s a subtle phenomenon, and few people are consciously 
aware of it. 

What color is a shadow? Until the 19th century, most artists 
rendered shadow with neutral tones like browns and grays, which 
correspond to our sense of what a shadow should look like and, in 
fact, suffice. But if you examine a shadow closely enough, you see 
it's a bit more complicated. Sand in shade can actually appear pur­
plish next to sand in sunlight. Shadows on pink look greenish. Re­
noir even painted healthy flesh a bright green, and it was 
convincing in the context. Again, the effect is subtle, but you can 
explore it freely on the Mac II, since it affords almost endless gra­
dations of color. 

You can eschew shadow and achieve a light, airy feel. The ear­
ly Impressionists, for example, filled their canvases with colors of 
uniform brightness, and it suggested a world full of sunlight, but 
also one without corporeality. If your work on the Mac II seems to 
lack body, you may be overusing the brilliant colors. 

You should also be aware of a couple of pitfalls. Be careful 
about the colors you put next to each other. Some, such as bright 
red and green, create a vibrancy at their border that seems almost 
electric, and it may well distract from elements you wish to high­
light. At the same time, beware of placing colors next to each other 
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that are too similar, unless you wish to have hues shade into each 
other. If you wish them to be distinctly recognizable, be sure the 
colors are sufficiently different that the eye easily tells them apart. 

In real life, objects tend to pick up some of the color of other 
objects nearby. Thus, a yellow kite against the sky picks up a little 
extra blue. A white paper posted on a green wall gains extra green. 

Art provides an excellent way to reproduce the real world, but 
of course on the Mac there is still a better way. You can import it. 
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Imported Art 
The world is a vast place, teeming with graphic images. Every day 
we see billboards, drawings, and magazine photos of everything 
from Hawaiian waterfalls to DNA molecules to Ukrainian beet 
farmers. The range and scope seem almost infinite and, as it hap-
pens, it's all accessible to you at the Macintosh. · 

You don't have to be an artist to exploit Macintosh graphics. 
The computer can imbibe images from almost any source and place 
them at your feet. It lets you not only trace drawings but pop in 
predigitized art, copy images from paper, read in frames from a 
VCR, and even take photos of the world directly. It also lets you 
alter these images in strange and magnificent ways. 

Manual Copying 
The most obvious way to copy art is to do so manually. It's very 
easy with the Macintosh, provided you have a digitizer pad. You 
simply place the art on the pad and trace over its lines with the 
stylus. It's even simpler than traditional tracing, because you don't 
have to worry about an extra layer of paper. 

The mouse is not very good at this task since it lacks a central 
focus, but you can partly overcome this drawback by focusing on 
the point at the top of the mouse where the wire leaves. Place that 
point over the artwork and pull, and you may get a reasonable fac­
simile. Note that if you have an optical mouse, the kind that re­
quires a special reflective pad, you probably can't use it to trace at 
all. 

Clip Ari 
Clip art is simply art someone else has created on the computer­
or scanned in from the public domain-and made available to you. 
It's like a digital decal. 

When clip art first appeared soon after the introduction of the 
Macintosh, many viewed it as a frivolity. It received eager attention 
because of the void in Mac software, yet most people used it main­
ly to adorn letters. 
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Today the story is different. Since most deskt<;>p publishers 
prefer to paste art into their publications rather than create it them­
selves, clip art has grown into a sizable market. Over 30 companies 
now offer clip art for the Macintosh alone, and the number of disks 
available exceeds 100. Moreover, its use is spreading into the upper 
echelons. USA Today, for instance, uses the maps of MacAtlas from 
MicroMaps as the foundation for many illustrations. 

Most Macintosh clip art comes in paint format. Thus, once you 
load it, you can modify it at will with MacPaint tools and move it 
directly into most page layout programs. Clip art is also appearing 
in PICT for programs like MacDraw, but the best is laser art in 
EPSF format; it has the virtue of occupying much less room in 
memory, and it prints out very well on laser printers. 

The subject matter of clip art covers the gamut. Traditional 
topics include arrows, stars, pointing hands, portraits of famous 
people, patterned borders, animals, and cartoon characters. More 
exotic disks feature Mayan ruins, monsters from the grave, architec­
tural symbols, Japanese lanterns, and so on. Since you might not 
know if you even want a clip art program without some preview, 
good computer stores keep a sample book on hand so you can see 
what you're getting. 

A preview also tells you about its quality.· Anyone can draw or 
scan in clip art, so its caliber varies wildly. The worst is simple 
stick figures with no conceivable appeal. The best is complex, pre­
cise, imaginative, and often clever. 

Bulldlng a Library 
The more graphics you have in stock, the better prepared you are 
and the more variety you can impart to your work. Yet clip art can 
multiply out of control, and it soon becomes vital to organize it in 
some way. There are several ways to do this. 

Printout. You can print out every page of every disk, and· store 
the sheets in a convenient place, each labeled with the name of the 
disk and file. Then, when considering illustrations, you can flip 
through the sheets until something strikes your fancy and boot it 
up. This approach is fast and lets you compare many different 
graphics at a glance. 

You can organize the printed sheets by disk or by topic. If you 
group images by disk, choosing the right graphic may take longer, 
but you can locate the image quickly once you have it. If you 
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group them by topic-for instance, taking all the borders from all 
disks and putting them in one place, as well as all the flowers, all 
the portraits, and so forth-you normally find the right image fast­
er, but you may encounter problems with organization itself. Some 
images fall into more than one category, and you should place 
those in both to be sure you don't miss them. 

Software. You can also buy desk accessories that let yo11 
quickly scan through your clip art, so you can see what's there 
without leaving the computer. These, however, may take more 
time than flipping through paper, and you must keep your clip art 
at hand on the hard disk to access it. Image databases are also 
available, but they can consume vast amounts of disk space. 

Digitizers 
Clip art lets you paste other people's drawings directly into your 
publication, but clip art has already been digitized. A number of 
hardware products let you copy images from the real world­
photos, sketches, maps, whatever. These items are called digitizers. 

Digitizers originated in the space program. In the early 1960s, 
NASA found that analog video images from satellites were arriving 
distorted. So, with the Ranger 7 probe to the moon, NASA began 
converting the video signals to digital images so a computer could 
clean the images up. Costly digitizers soon migrated to other fields 
like medicine, where they evolved into CAT scans and other nota­
ble devices. In late 1984, companies began making inexpensive dig­
itizers for the Macintosh. 

At first, these devices encountered curious interest but no over­
whelming demand. However, desktop publishing soon sparked 
sales here as it has in clip art, and new digitizers are now being 
launched onto the market at a rapid pace. 

Since few Macintosh digitizers yield perfect renditions, you 
may have to touch up the image. A class of software called image 
processors exists for this purpose, and these programs can take you 
far beyond mere mopping up. Indeed, this software can convert the 
Mac into a sophisticated darkroom, where you can alter an image 
in a hundred different ways and create vivid and striking effects. 

Digitizers come in two types with quite distinct capacities. The 
first is the scanner. Scanners act like copier machines, which they 
often resemble, and they transform patterns of light directly into 
digital data. The other is the video digitizer. Video digitizers are 
more like cameras; in fact, they require a video camera, VCR, or 
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some other source of video signals, and they transform those sig­
nals into digital data. 

Scanners 
Scanners read in th~ highest quality images, yet they also boast the 
highest cost. Moreover, they are limited to flat images, generally on 
pap~r. _ 

Scanners work like copiers. Flatbed scanners even have a glass 
plate on which you put the paper and a traveling hardware mecha­
nism that reads the paper from one end to the other. Tl'~ese are es­
sential if you commonly scan material from books or other material 
not in sheet form. The majority, however, use paper-feed rollers, 
pulling the paper through the read instrument. Since these often 
have automatic feed, they can free you from dawdling about the 
machine. 

Here's how scanners work: Light from the original graphic 
strikes a photosensitive device, which translates it into a pattern of 
digital signals. In the case of most scanners, the light enters the 
machine straight from the page. However, one of them, Thunder­
Scan, works a little differently. It emits two tiny beams of red light 
that the paper reflects and returns to the photodetector. 

Scanners for the Macintosh today generally yield a resolution 
of up to 300 dpi-high enough to send to the laser printer. 
(Though if you're making halftones, you need scan in at no higher 
resolution than that of the halftone. For instance, if the halftone 
will have 150 dots per inch-very high quality-you don't really 
need 300 dpi at scanning, as the printer rejects the extra infor­
mation.) They read both black-and-white and grayscale. They're 
also generally very fast, and some can scan a page in less than a 
minute. Scanners usually store information in TIFF format, and the 
files can be huge. 

These devices remain relatively expensive, between $1,000 and 
$2,500 or more, though you can often rent them at a service bu­
reau. But the best-selling Macintosh scanner of all is completely dif­
ferent, both in mode of operation and in price. It is ThunderScan. 

ThunderScan costs about $250 and fits snugly into the 
lmageWriter printer, where it replaces the ribbon cartridge. You 
place the original document beneath the platen, where your print 
paper normally goes, and Thunderscan takes over. It inches the 
document forward, reading it line by line until the complete image 
enters the computer (see Figure 6-1). 
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Figure 6-1. The Thunderscan Image Processor 
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Why hasn't Thunderscan vaporized its more expensive com­
petitors? Well, it has drawbacks. It's more cumbersome to set up 
and use; it's also slower. ThunderScan can take 20 minutes to digi­
tize a full 8 X 10-inch document-though it lets you set the area to 
be read in, which is often much smaller-and during this time your 
computer is normally immobilized. 

Moreover, sometimes you don't notice problems with your 
scan until ThunderScan is well into the process. Problems can stem 
from several sources. Infrared waves from nearby incandescent 
bulbs or sunlight can cause the sensitive photodetector to mis-scan. 
An improperly aligned original can cause problems for Thunder­
Scan, which in any case sometimes has trouble with vertical lines. 
Probably the best way to use this instrument is to scan at 200 per­
cent and then print at 50 percent. The final output has the same 
size as the original, but because you've enlarged and then reduced, 
you get finer detail. 

The ThunderScan software has certain virtues. For instance, in 
halftone mode it captures grayscale data (see Figure 6-2). It also 
lets you go back over the scanned image, select a portion of it, and 
change the contrast and brightness, so you can retouch the image. 
Though ThunderScan is not the best scanner on the market, it may 
suit you well, particularly if you don't have deep pockets. 
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Figure 6·2. ThunderScan Grayscale 

Photo by Rosalind Gold 

Video Digitizers 
Video digitizers give the computer a camera-like power, letting it 
digitize snapshots and other video images. However, unlike scan­
ners they don't interact directly with visible light. They accept 
video signals and turn them into digital ones, and hence require an 
initial source of video signals, such as a video camera or a VCR. 

Video digitizers have a whole new set of benefits and draw­
backs. A prime benefit is cost. They start at around $300. Black­
and-white video cameras can be had for as little as $200, so your 
initial investment would be at least $500-more than ThunderScan 
but far less than most scanners. 

If you buy a video camera solely for desktop publishing, be 
careful. The most important factor to look for is resolution, which, 
in this field, is often expressed in terms of number of horizontal 
lines per inch. Most black-and-white cameras resolve 300 lines per 
inch, while most color ones resolve only 250. It's also important to 
note the size of the image pickup device-it should be at least 1h 
inch, and 213 inch is even better. Avoid features like stereo sound 
and automatic focus, which steepen the cost but don't help you out 
appreciably. 

You should also realize that most video camera zoom lenses 
can focus on an area no smaller than 5 X 7 inches. To pick up 
smaller images you need auxiliary equipment. A set of close-up 
lenses, which you can screw onto the regular lens, lets you focus 
on objects as small as three inches square. A macro lens lets you 
digitize objects even smaller, ()uch as stamps. 

A video digitizer may require more than just a video camera. 
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For instance, MacVision, from Koala Technologies, requires 5 to 25 
seconds to scan an image. Hence, the camera needs a tripod to 
keep it from quivering during exposure. 

Most important of all, if you're using a video digitizer repeat­
edly to scan flat documents, you need to set up a formal copy 
stand. Video cameras require light at particular angles for best re­
sults, unlike scanners, which accept only flat images and hence 
have solved the light problem in advance. 

A copy stand can be simply a table with a swivel lamp on 
either side. For best results, the camera should go directly over­
head, facing downward. The lamps should shine down from either 
side at an angle of about 45 degrees. If one is brighter than the 
other, you see it in your results and you'll have to adjust for it. 

Should you get a scanner or a video digitizer? Part of the an­
swer depends on what you can afford. The scanners are like book­
ends of the spectrum. ThunderScan is economical; the other 
scanners are costly but faster, more convenient, and yield very high 
quality work. The video digitizers inhabit the midrange, though 
they appear to save more money than they do because of the hid­
den cost of auxiliary equipment. 

Part of the answer also depends on your purpose. If you want 
to digitize three-dimensional objects or VCR images, you require a 
video digitizer. On the other hand, if you do either massive or oc­
casional digitizing of flat images, a scanner may be right for you. If 
you need high quality picture~, you require a scanner, and if you 
want to read in prose, you need one with OCR (optical character 
reader) software. 

Image Processors 
Here is the ambrosia of imported graphics, the creative reward that' 
comes after the hard work of entering the document. Image proces­
sors were invented to solve a very specific problem: Scanned docu­
ments were rarely perfect, as NASA found, so users needed soft­
ware to spruce them up and enhance their qualities. Programs that 
perform this feat are called image processors, and they can be 
magical. 

Image processors can give you a control over grayscale similar 
to that of a darkroom, but they work much faster and cover a far 
wider range. At the top of the line, with lmageStudio and Digital 
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Darkroom, they work best with a Mac II, 2MB (megabytes) of 
RAM, and at least an 8-bit monitor. You can use them, however, 
with the Mac Plus and black-and-white monitors, though many ef­
fects are too delicate to show up, and they work with color too . 
They can eat up great gulps of memory; their images are often be­
tween lMB and 2MB, and some can reach lOMB in size. Image 
processors print out in halftones and even let you control the pat­
tern of the halftone. 

Among an image processor's powers are: 

Despeckle. It can identify "noise" in an image, the places where 
random and incorrect pixel values have crept in, and eliminate 
them, yielding a smooth, sharp picture. In Figure 6-3, for ex­
ample, the flatbed scanner has incorrectly added a white line to 
the photo of the mountain goat. After despeckling (Figure 6-4), 
the line is gone. 

Brightness. It can brighten a dark image or darken a light one. 
Contrast. If an image runs to mostly middle shades of gray, it can 

spread them out and make them more extreme. 
Sharpening. It can sharpen the edges of items in the picture, to 

bring them into higher relief (Figure 6-5). 

Figure 6·3. Scanned Image of Mountain Goat Before Despeckllng 

Photo by Rosalind Gold 
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Figure 6·4. Atter Despeckllng 

Photo by Rosalind Gold 

Figure 6·5. Sharpened Image 

Photo by Rosalind Gold 

Softening. It can blur the edges to give the image a softer look. In 
photography, this trick requires a special filter. 

Posterization. This process can drastically reduce the number of 
gray shades in an image, yielding images of stark contrast (Figure 
6-6). To achieve the same effect in photography, you must make 
several negatives with different densities and contrast, then print 

105 



Chapter 6 

Figure 6·6. Posterlzed Image 

Photo by Rosalind Gold 

them together. You can see a crude kind of posterization by run­
ning a photo through a copier; it reproduces those grays that are 
dark enough and omits the others. Be careful with posterization. 
By reducing an image to, say, black, white, and mid-gray, you 
can make it bizarre and hard to grasp. Perhaps the best way to 
start is with a fairly simple image and experiment. An adroitly 
posterized image can have a surreal, haunting quality. 

Pseudocolor. An image processor can let you assign specific, arbi­
trary colors to shades of gray. The result may resemble 
LANDSAT photos of the earth's surface, with crimson fields and 
cobalt-blue hillsides. 

Warping. You can use this feature to change an image from a 
square to, say, a trapezoid, squeezing it at the top and creating 
an intriguing effect. Warping can be especially useful in design­
ing logos or otherwise using display type, where you can alter 
the type to fit a novel shape. 

Filtering. This feature can locate all the edges of an item and make 
a new image of them, or even let you lift the item out of its 
background and move it elsewhere. 

So far, most image processors have addressed the desktop 
publishing market. However, there are also a few expensive image 
processors for the Mac II that work in color and serve the scientific, 
industrial, and medical community. These help analyze images by 
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highlighting salient portions in pright colors, harking back to the 
original use for image processors. 

A Note on Copyright 
It takes time, effort, training, knowledge, and often talent to write a 
book or draw a picture. Not everyone can do it, and few do it well. 
Yet once completed, prose and graphics can be copied easily by al­
most anyone. 

To protect the creator, the U.S. copyright laws make it illegal 
to copy works without the creator's consent, who can rightfully 
make consent contingent upon payment of some sort. Without such 
laws, there would be little incentive to create original works, since 
pirates would steal them at once and siphon away the profits. 

The copyright laws apply to a work as soon as you finish it. 
You no longer have to file a special form with the U.S. government 
to gain protection, though you may have a difficult time proving 
your copyright unless you file. Filing helps establish an approxi­
mate date of creation, which is useful if the issue ever requires ad­
judication in a court of law. 

Copyright applies not just to writing and drawing but to pho­
nograph records, software programs, and a wide variety of produc­
tions, including photographs. A photographer-or if the photo­
grapher is on salary, his or her employer-gains copyright instantly 
to all photos taken, and you can't use them without permission. 
You can usually gain permission easily by writing the artist, the 
artist's agent, or the publisher. 

There are a few ways around this problem. First, after a certain 
iength of time all works pass into the public domain, where anyone 
can use them. For instance, the novels of Herman Melville are pub­
lic domain, and you can publish them without paying a cent to his 
heirs. By the Copyright Act of 1976, the life of copyrights was ex­
tended to the lifetime of the copyright holder plus 75 years, to pro­
vide a nest egg for descendants. In practice, because of the prior 
laws, almost everything created before August, 1906 is in the pub­
lic domain. You can therefore copy old photos, pictures, and prose 
with impunity. 

Second, there is the fair use exception. In essence, it means 
that if your copying plainly does not deprive the author of any 
profits, it is lawful. Thus, you can quote an author in a term paper 
or photocopy materials for your own use. 
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Third, you can copy material if you then alter it so much that 
it partakes substantially of your own creativity. Hence, you can 
scan in a photo and use it as a foundation for your work, making 
of it something different in kind. If the final product was not con­
templated by the original creator and is substantially yours, the 
copyright rests in you. 

Do not push these too far. Computer technology is new and 
changing very fast, and the courts move slowly. The emphasis lies 
on the amount of creativity you contribute, not on the amount you 
have changed a document. You must alter the document in a major 
way, and that way must embody creative thought of your own. 

F0r instance, if you read in a photo and posterize it instantly 
with Digital Darkroom, you generate a very different graphic but 
your own contribution is minimal. Moreover, the computer graphic 
would still be derivative, that is, clearly dependent upon the 
original. 

If you alter it further, so it is perhaps recognizable as stemming 
from th~ original but not yet fully your own, you could still be 
sued. You must change it in a major way, and to be safe, the alter­
ation should be so great that the final product is not recognizable 
as deriving from the original. In that case, your own creative contri­
bution will likely dominate. 

Virtually all clip art is sold along with the right to copy it, 
otherwise it isn't worth much. Scanned photos you've taken are 
safe as well as your own scanned drawings. Traced drawings made 
by others are not; these are derivative works. For instance, a movie 
made from a novel is a derivative work-a work in another medi­
um using the basic creative material of the original. 

It's not merely sensible to follow these cautions, but it's 
shrewd. You may want the umbrella of copyright protection your­
self some day. 
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Charts 
John von Neumann, the brilliant mathematician and coinventor of 
ENIAC, the first U.S. computer, was himself a lightning calculator. 
He could compute elaborate sums instantly in his head, a trick that 
always impressed his party guests. Most of us are. not so fortunate. 
We calculate awkwardly and fallibly, and even when finished we 
may have no clear sense of our number's portent. 

Hence, statistics is not the Oktoberfest of academic disciplines. 
At best, a list of figures is a kind of delphic parchment, over which 
we may pore endlessly as if it holds some secret meaning; at the 
worst, it numbs the mind. Yet there is a simple tool that brings sta­
tistics instantly to life: the chart. 

Charts are invaluable; for depicting numerical relationships, 
there's just no substitute. They turn numbers into simple shapes 
and juxtapose them to yield quickly perceived breakdowns, com­
parisons, trends, and contexts. They are like subtitles in a movie, 
translating foreign concepts into a language with which viewers are 
more comfortable. Hence, charts are vital in reports and they 
bloom in presentations, where viewers must grasp a mass of data in 
a moment. 

All charts seek the same goal: to convey the gist of numbers 
quickly, clearly, and memorably. However, pay attention to your 
audience when devising them. A chart in a report can be a fairly 
detailed item, over which the reader may wish to linger. A chart in 
a presentation must be much simpler, since it appears for a mo­
ment and is gone. 

In either case, mastery of charts is a great professional advan­
tage. It provides you with a wealth of persuasive and explanatory 
tools, and gives you power to communicate difficult facts almost 
instantly. 

Note: The nomenclature in this field has run amok for some 
reason. A single chart can have three, four, or even five different 
names. Don't worry about it-the important thing is their capacity. 
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Parts of Charts 
Before we leap into the charts themselves, we need a brief recon­
naissance to survey the ground we'll be talking about. 

Most charts are either circles or rectangles. The circular ones, 
pie charts and polar charts, are plain and easy to understand; the 
rectangular ones are less so. However, all share the following traits: 

Title. A good title not only describes the chart but provides a guide 
to its workings. For instance, a chart comparing eligible., regis­
tered, and actual voters could be called Voter Participation, but a 
better title would be Voter Participation by Group. The informality 
of presentations permits the best title of all, the summation: Eli­
gible Voters Far Exceed Actual Voters. Some charts simply squirm 
away when you try to pin pithy titles on them, and you may 
have to choose between vagueness and prolixity. The biggest pit­
fall is the title with more than one meaning, which confuses or 
misleads the reader. 

Data. Charts rarely show great precision., and often you must in­
clude the data figures nearby. 

Labels. You must indicate what you're measuring. To heighten im­
pact and clarity, you should place labels as close as possible to 
the feature they describe. 

Rectangular charts have these special characteristics: 

Horizontal and Vertical Axis. Sometimes called the x- and y-axis, 
respectively, these lines form the framework of the chart. Com­
monly the horizontal axis runs along on the bottom and the ver­
tical down the left, but either may bisect in the middle, partic­
ularly if the chart shows negative numbers. The horizontal axis 
often indicates time, which we tend to think of as a flow. The 
vertical normally indicates amount. 

Scale. The scale is the set of numbers along an axis. It defines each 
point on the graph, showing how much is being measured per 
unit of distance. It's rather like the scale on a map, but more im­
portant. Occasionally you see charts without a scale., especially in 
pain reliever ads on TV; such a chart is almost meaningless. 

Grid. The grid is a net of lines extending from the numbers on the 
scale to make the meaning of data points more apparent. Grids 
can be whole or partial. A whole grid has lines from every major 
number and is usually dense with them. A partial grid has lines 
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from every second or third major number. Whole grids are useful 
where it's vital to grasp every point in the graph quickly. Partial 
grids work better where specifying each point is not so essential, 
since they reduce the clutter. You need not show a grid at all. 

Kinds or Charts 
In the presentation jungle, charts come in a few genera and in wild­
ly various species. It's crucial to master the major types, so you can 
select the best one for your purpose (though the bar chart does al­
most everything). The first three are the most important, while the 
fourth and fifth are sometimes also useful. The graphs and their 
main uses are: 

•Pie Chart: Percentages. 
• Bar Chart: Absolute numbers, range of numbers, comparison of 

breakdowns, comparison of percentages. 
• Line Chart: Trends, absolute numbers, range of numbers, compar­

ison of breakdowns, comparison of percentages. 
•Scatter Chart: Correlation. 
• Polar Chart: Geographic distribution. 

A good chart program can render these graphs, but it may not 
give you all of their subtypes. For these, you need to save the chart 
in PICT format and move it to a paint or draw program. As it hap­
pens, this process is easy and paint gives you much control over 
charts. 

Percentages: The Pie 
The pie chart is a virtuoso with a narrow talent: It does percent­
ages. While other charts can also perform this feat, none does so 
with the flair and grace of the familiar pie chart. 

The pie is the simplest chart of all and the most popular. It's 
simply a disk cut into slices, each a portion of the whole. For in­
stance, if a pie has two perpendicular lines dividing it into four 
equal pieces, each would represent 25 percent. Part of the pie's ap­
peal lies in its self-evident nature. As a circle, it can only represent 
percentages-no one is going to confuse the slices with absolute 
numbers. The analogy to a pie works perfectly, and the contours 
attract the eye. Do not hesitate to use this helpful little tool if it's 
appropriate (see Figure 7-1). 
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Figure 7·1. The Pie Chart 
The Great Lakes, by Area 

Superior 

Michigan 

However, not all situations call for the pie. If you divide the 
pie into more than six or seven segments, it becomes crowded and 
hard to grasp. Moreover, slices smaller than 2 percent are very dif­
ficult to tell apart. Finally, the pie is ill-suited for comparison, since 
you need two full pies to contrast two sets of figures, and even 
then it's hard to match the segments against each other. Percentage 
comparisons work much better on bar or line charts. 

Each slice should have a diff€rent color or pattern. By tradi­
tion, the largest slice is black and the smaller ones are progressively 
lighter, but don't feel bound by this custom. Exploit the patterns. 
For instance, darkness draws attention to a slice, so if you really 
only care about one or two slices, make them black and leave the 
others white. Likewise, if you have narrow slices, around 3 or 4 
percent, a darker color helps keep them from going unnoticed. 

You can achieve special effects in other ways: 

Exploded Pie. An exploded pie has one or more slices extracted for 
emphasis (see Figure 7-2). Avoid pulling out a hefty segment like 
47 percent, since it splits the pie down the middle, and a slice 
that large really doesn't need emphasis. Never extract a majority 
section, like 70 percent, because you wind up spotlighting the 
leftovers. If you pull out all the slices, you make the smaller seg­
ments more distinct. 
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Figure 7-2. Exploded Pie 
The Great Lakes, by Area 

Michigan 

Three-Dimensional Pie. The three-dimensional pie usually looks 
better because it affords a pleasing sense of depth, of concrete 
presence rather than intangible disk (see Figure 7-3). It may re­
semble a coin, in which form it's particularly useful for repre­
senting money. However, be sure that the pie really looks three­
dimensional. Some coin-like pies simply have a second line more 
or less parallel to the bottom curve and strain for effect. 

Figure 7-3. Three-Dimensional Exploded Pie 
The Great Lakes, by Area 

Ontario 

Michigan 

Pies are fairly simple to label. As a general rule, place the 
data-the percentage-within the slice if there's room. If not, set it 
just outside on the rim. Don' t worry about the inconsistency of 
placement. It's a common practice, and the reader grasps it quickly 
and easily. 
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Here are some ways to label slices: 

• Place the label outside the pie near the segment, attaching it to 
the segment with a line if necessary. This method is clear and 
straightforward. 

• Use a legend (or key). That is, create a set of boxes with the same 
color or pattern as the segments, and label the boxes~ This ap­
proach may look cute, but it slows comprehension by forcing the 
reader to make an extra stopover, going from chart to legend to 
label. It also takes up space. 

• If you have short labels and ample slices, you may be able to 
place both name and data within the segments. 

The Versatlle Bar Chart 
In contrast to the pie, the bar chart is a multifaceted, protean item, 
the Renaissance man of charts. It has an array of varieties and uses, 
and it particularly repays study. 

Bar charts come in almost tropical profusion. Special indicia 
distinguish each kind, and occasionally they fuse into a single hy­
brid chart. Let's begin with the most basic trait: bar direction. 

Bars can be either horizontal or vertical, and in the latter case 
the graph is commonly called a column chart (or pipe-organ chart). 
Statistically, the two are identical. How do you decide which to 
use? 

•Horizontal bars show timespan better, since they follow the time­
oriented horizontal axis. In addition, they let you place data be­
side the bars more easily, since most data is also horizontal (see 
Figure 7-4). 

Figure 7 ·4. Slmple Bar Chart 
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• Vertical bars do almost everything else better. The column chart 
excels at absolute numbers, such as earnings or stock market clos­
ings, which we normally see in terms of height, and they also ren­
der percentages well. Visually, they seize the viewer's eye. 
However, you may find it hard to place complex data near the 
column (see Figure 7-5). 

Figure 7-5. Simple Column Chart 
so..--~~~~~~~~~~~~~~~~ 
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The simple bar chart is the prototype: a row of bars starting 
from a baseline. Despite its fundamental nature, it's extremely 
useful for comparing a string of numbers, and you can easily en­
hance it: 

Emphasizing bar chart. You can darken one or two bars of special 
interest and leave the others white. 

Three-dimensional bar chart. As with the pie, adding a third di­
mension conveys a sense of perspective, of objects in space rath­
er than ink on the page, and so pleases the eye. A three­
dimensional bar chart can yield columns that look quite thick, 
like square~pilings. 

You can enhance the look of a bar chart with another trick: 
drop shadows. These are dark rectangles behind each bar that sug­
gest shadows cast onto a second plane that's otherwise invisible. 

- Drop shadows are absent from most chart programs, but you can 
fairly easily create them in paint or draw with the duplicate power. 

Even a simple bar chart can become complex. There are three 
major variations on it: the bilateral, the paired bar, and the range 
chart. Within the last category you'll find a number of subcategories. 

Positive and negative: Bilateral bar charts. Suppose you wish 
to trace the net earnings of a company with both profits and losses. 
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You can easily show the profits, but what about the losses? That's 
easy, too. You hoist the horizontal axis to midpoint, call it zero, and 
hang the bars representing losses below like stalactites. 

Of course, you could also shift the vertical axis to the center 
and pull bars right (profits) or left (losses). In either case, the graph 
is called a bilateral (that is, two-sided) bar chart. Most chart pro­
grams generate bilaterals automatically with negative numbers. 

Two parts of a whole: Paired bar charts. With just a minor 
adjustment to the bilateral chart it can show figures for two parts of 
a whole, in which case it's called a paired bar chart (see Figure 7-6). 

For instance, if you're measuring total population by age, you 
can move the vertical axis to the middle and use it to separate men 
from women. For each age group, such as 60-65, the number of 
men would extend to the left, of women to the right. At the same 
time, the overall bar would show the total number of individuals of 
that age. 

Figure 7-6. Paired Bar Chart 
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The paired bar chart is beyond much chart software, but you 
can still generate it, with help from paint or draw. The best way is 
to trick the chart program into thinking you're working with posi­
tive and negative numbers. Since it doesn't place both a "positive" 
and a "negative" bar on the same line, you must create them sepa­
rately and later shift one part of the chart atop the other. Here are 
the steps: 

• In the data table, type the numbers for the right-hand bars. Then, 
immediately below and in the same order, type those for the left­
hand bars but give each of these a minus sign. 
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•Generate the bar chart. In the upper half, bars extend in one di­
rection; in the lower half, the other. 

•Save the graph as a PICT. Open it with a draw program, press the 
mouse button, pull the selection rectangle around the chart, 
choose Copy from the Edit menu, and Paste it into paint. 

• Select the top half of the chart with the marquee and move it. 
down adjacent to the bottom half. 

• Erase the minus signs on the scale, and otherwise dress up the 
graph to please the eye. 

Outer limits: Range charts. No rule says the bars in a bar 
chart must be moored at an axis. They can hang in air, as they do 
in a range chart (or floating bar chart). 

Range charts, not surprisingly, show the spread of numbers. 
Here, too, the bars can be vertical or horizontal. A range chart with 
horizontal bars is called a progressive bar chart, and it comes in 
handy for depicting time. 

For instance, suppose you're illustrating the life-course of vari­
ous Paleozoic reptiles from first appearance to extinction. Above a 
timeline on the bottom, you can place a horizontal bar for each an­
imal, beginning and ending in empty space. Start at the upper left 
with the creature that evolved earliest, and proceed in order of ad­
vent. Hence, the left side slants down and right, while the right 
side is ragged. 

The progressive bar also works well with the lifespans of indi­
viduals such as famous authors, showing instantly whose lives 
have overlapped (see Figure 7-7). You could also indicate events on 
the scale, such as the invention of the light bulb, to give the social 
context. 

A special kind of progressive bar chart is the Gantt chart, 
named after Henry L. Gantt, who devised it during World War I. 
The Gantt chart helps organize projects by mapping out their 
stages. If you're writing a report, for instance, you can plot re­
search, outline, first draft, outside critique, and final draft against 
the time line, and gain a helpful picture of the workplan (see Fig­
ure 7-8). Gantt charts accommodate themselves well to computers, 
since they fit in well at presentations and since schedules often 
change. 

The range chart can also use vertical bars, in which case it's 
called a high/low chart, since it normally measures fluctuation in 
quantity. Each bar extends from the high to the low for a given pe-
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Figure 7 • 7. Progressive Bar Chart 
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Figure 7 ·8. Gantt Chart 
Report Timellne 

Research 

Outline I 
First Draft 

Outside Review • 

Final Draft 

Jan 1 Feb 1 Mar 1 Apr1 May 1 Jun 1 Jul 1 

riod and emphasizes the ·stretch between them. Such a chart can 
yield a vivid record of the highs and lows of temperature, tides, or 
stock prices. Each bar may have a tick to mark a significant datum, 
like average temperature or closing price (see Figure 7-9). 

We end this section with a mimic, not a true range chart at all. 
It's the step-bar chart, which shows percentages. Though the bars 
hang in the air, they represent segments of the whole, not ~eparate 
entities. The chunks begin at upper left and move down toward the 

· lower right like floating steps. The tipoff here is that they never 
overlap. Where one ends, the next begins (see Figure 7-10). 

Of course, the step-bar chart lacks the talent of the pie. It can't 
compare percentages as well, since the bars don't line up, and it 
doesn't show the amount of each percentage as well either, since 
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Figure 7·9. Hluh·Low Chart 
Dow Jones Average, Over Two Weeks 
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Figure 7·10. Step-Bar Chart 
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most don't touch the baseline. However, sometimes these are 
advantages. 

Charts 

Up to now, this tour of bar charts has resembled a walk 
through an aquarium, where one tank succeeds another and we 
gaze at the contents. So far the fish we've seen have remained fair­
ly plain-flounder, bass, and trout. It's time to move on to the 
tangs and Moorish idols. 

Breakdowns: Stacked bar charts. The simple bar chart is fine 
for many purposes, but it may lack power. For instance, suppose 
you wish to show not just quarterly gross income, but also the 
breakdown of that income. You could devise a separate bar chart 
for each source of revenue and watch graphs proliferate over the 
page. Or you could divide the bars into segments, each represent­
ing an income source and each with its own color or pattern. The 
result is a stacked bar chart (or subdivided, divided, segmented, com-
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pound, or component bar chart). A stacked bar chart shows compo­
nents very well and, if you haven't partitioned it into too many 
pieces, remains fairly easy to grasp (see Figure 7-11 ). 

Figure 7 -11. Slacked Bar Chart 
Parka Sales for 1989, in Thousands 
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It has one major problem: Since some segments sit atop other 
segments of varying height, they lose contact with the uniform 
baseline. Hence you can derive their absolute value only by a kind 
of mental subtraction. Since the section on the baseline is the easi­
est to grasp, you should give thought to it. It should be 1) Plainly 
the most important or 2) (if no clear winner exists) the least vari­
able, or 3) all else being roughly equal, the largest. 

The stacked bar can fuse with the paired bar chart above. If 
the segments fall into two categories with a clear and special gap 
between them, and you want to emphasize these categories, you 
can set up a paired stacked bar chart or a sliding bar chart. 

For instance, suppose you're charting the favorite rock per­
formers of students in each year of high school and college. The 
figure per year matters, but you might also want to highlight the 
difference between high school and college. Hence, for each per­
former, you can float a horizontal bar with the vertical axis separat­
ing high school and college. You can then divide each category into 
four parts, one for each year (see Figure 7-12). 

A stacked bar chart can depict not only absolute numbers but 
percentages. In fact, a lone stacked bar can replicate an entire pie, 
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Figure 7-12. Slldlng Bar Chart 
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though it lacks the pie's visual impact and instant comprehensibil­
ity. However, as we've seen, the pie falters when comparing per­
centages of several different items, and here the bar chart comes 
into its own. You can set several percentage bars next to each other 
and see the differences at once. This chart is sometimes called a 
stacked 100-percent bar chart, and, unlike most bar charts, the height 
of each bar is the same: 100 units. The columns line up like pickets 
in a fence, and the effect is immediate and clear. 

A sliding bar chart can also show percentages with a simple 
twist on the rock performer example above. However, it's less fa­
miliar than the stacked 100 percent bar chart, and since the bars . 
don't match up and are less obviously the same size, presentation 
viewers may not grasp the information as quickly. 

A stacked bar chart can bear a great deal of information if you 
let it but it's not always wise, especially in presentations. Bars di­
vided into more than five or six parts offer an admirable wealth of 
information, but they also demand more of viewers, especially if 
you use a legend. 

Clusters: Group bar charts. Suppose you wish to compare the 
revenues of Companies A, B, and C across the four-year period 
from 1985 to 1988. You could set up four separate bar charts, one 
for each year. Each would have the same axes and scale, and only 
three bars . The eye would roam from one to another, attempting to 
compare the bars. 

Or you could save space and heighten effect by telescoping 
them into a single chart: a group bar chart (or grouped, multiple, or 
multiple unit bar chart) (see Figure 7-13). 
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Figure 7-13. Group Bar Chart 
Company Revenues, in Millions of Dollars 
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Note what happens: Each former graph becomes a cluster of 
bars and instead of a series of columns you now have a series of 
clusters. It's as though you've stretched the horizontal axis of the 
first chart out to cover all four of them. 

Hence, the baseline now has two different variables at once: 
firm and year. Companies A, B, and C sit atop four invisible 
subscales, and the broader horizontal scale shows the years. 
1985-1988. 

Thus, you need some way to differentiate the companies. Of 
course, you give each its own color or pattern- say, black, stippled, 
and lined. The year-by-year comparison is now vivid, as is the 
companies' relative annual progress. 

A major hazard of group bar charts lies in trying to cram too 
much detail into them. You should avoid clusters of more than 
three or four bars, as they start to resemble city skylines. And don't 
try to subdivide a group bar chart; stacked group bar charts-the 
very name is clumsy-just baffle the eye and look like quilts. You 
can enjoy more latitude with reports and books, where the reader 
can study a chart at leisure, but in presentations, a stacked group 
bar chart stuns the viewer and deadens the optic nerve. If you have 
any concern that a group chart is overdone, simplify it. 

Data placement. Placing data on bar charts may seem like a 
mechanical matter, but it's actually an exercise in good sense, taste, 
and even craftiness. 
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For horizontal bars, numerical data should go just to the left of 
the vertical axis. Tacking it to the right of the bars, some argue, cre­
ates an optical illusion that seems to. extend their length, so bars 
with long data or short length appear proportionately greater. Plac­
ing data within the bars fosters the opposite illusion: The eye tends 
to match up the blank parts of the bars, so bars with short data or 
greater length seem longer. 

For columns, you have a set of choices. You can place data be­
neath the bars but rotated 90 degrees, so the viewer cranes his or 
her neck to read it. This choice saves space but is otherwise poor. 
Second, if your data accommodates, you can place it beneath each 
bar horizontally. This approach may call for extra white space be­
tween the bars, and it can make the data itself look cramped and 
unsightly. Third, you can display a table before the graph or along 
with it, a particularly effective approach if the numbers are com­
plex. The approach you take may depend on the importance of pre­
cision. If exact numbers are not critical, as in occasional 
presentations, you may be able to omit the explicit data and just 
rely on the scales. 

Label placement. Labeling the axes is fairly simple. To save 
space, you commonly can label these axes parallel to the axis itself. 
Thus, you may have to tilt your head to read the vertical axis, but 
since it's usually brief the hardship is small. 

The best approach to labeling bars is to identify the labels as 
closely with the bar as possible. You can place the label inside the 
bar, and a good program easily lets you do it, though as we've 
seen, this method heightens impact with short names or long bars. 
The purist's solution is to place the label just above a bar, if there 
is room, or below a column. 

With a stacked bar chart you must label segments, and you 
generally have two alternatives. The first, and preferable, is to 
place the label near the segment on one bar and draw a line con­
necting the two. You need only link label and segment on one bar, 
since the analogous parts on the others have the same pattern and 
order. Second, you can use a legend, as with the pie, and label its 
boxes. Legends add an extra step, but they're helpful with group 
bar charts, where it may be awkward to connect labels directly. 

Trends: The Line Chart 
A bar chart with columns packed tight-a staircase chart-can even 
indicate trends, at least in the short term. For instance, a 
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string of columns showing the Dow Jones average. over the last ten 
days illustrates its progress quite nicely. But the master of the trend 
is the line chart. 

The line chart resolves a trend into a single shape and thereby 
crystallizes it. With a bar chart, you must follow the tops of the 
bars. 

The line chart has another advantage: It divides into theoreti­
cally infinite units. While each column must represent a discrete 
moment, the line fuses all moments together into a smooth time­
stream, and thus conveys a greater sense of progression (see Figure 
7-14). 

Figure 7·14. Line Chart 
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Of course, the line does not truly indicate exactly what has 
happened at any moment. You derive the line by plotting as many 
points as you can and then joining them together. But it gives the 
effect of continuous change over time, and thus strikes the eye 
more vividly in this regard. 

However, the line chart has drawbacks. It lacks solidity. The 
bar chart dramatizes each number in terms of its distance out or 
up, while the line chart simply shows endpoints. The bar chart is 
thus more visually appealing. 

The line chart also falters where variation is relatively slight. 
The steplike bars stand out more clearly and seize the attention, 
while the wavering line is harder to comprehend. 

The line chart has uses other than plotting changes over time. 
For instance, it can indicate frequency, as in the familiar Bell curve, 
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in which case it's called a histograph. But it generally shows the 
same data as the bar. Hence the question arises: When should you 
use a line chart and when a bar? 

All else being equal, choose the bar. It is simply more dramat­
ic, and flair matters, especially in a presentation. However, you 
may want a line chart where: 

•You have many separate values in a series, particularly more 
than 15. 

• You are stressing movement over time-the line-more than indi­
vidual amounts. 

• The group bar chart becomes too bulky. The group bar chart suf­
fers when comparing performance of two or three entities at 
many points in time. 

You should avoid the line chart where: 

• You have relatively few plotted points. 
•You wish to stress change in amounts over time rather than over­

all trerid. 
•You have three or four lines intersecting in a complex skein. 
• You seek impact. 

Like the bar chart, the line chart comes in prolific varieties. 
Many simply mirror the bar chart, but sometimes the line chart 
yields offspring of its own. 

Positive and negative: Bilateral line charts. The most com­
mon bilateral line chart has the horizontal axis in the middle and 
shows a line swinging above and below it to indicate profits and 
losses. Its familiarity suits it well for presentations. 

Outer limits: Range line charts. There's no reason why you 
can't create progressive or high/low charts with lines instead of 
bars, except that bars are thicker and make more of a visual im­
pression. In fact, the term high/low chart most often refers to a line 
chart. 

Breakdowns: Stacked line charts. You can subdivide a line 
chart like a stacked bar to show parts of the whole. For instance, if 
the chart depicts earnings over a three-year period, the top line 
shows total revenue and lines below illustrate income from various 
sources (see Figure 7-15). 
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Figure 7·15. Stacked line Chart 
Revenue Breakdown of Broadbase, Inc. 
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Of course, when you place multiple lines on a chart you have 
to differentiate them, and you do so mainly by: 

Pattern. Lines can have myriad patterns, such as solid, double, dot­
ted, dashed, dot-and-dash, triple-dot-and-dash, dash-and-cross, 
line-and-dot, and line-and-crossline. Hence, patterns are useful 
with numerous lines, but be careful not to confuse the reader by 
placing similar patterns beside each other. 

Symbol. You can repeat certain symbols-square, triangle, circle, 
and so forth-along each line. However, these devices are small 
and not always conspicuous. 

Thickness. Thickness not only differentiates lines but helps em­
phasize them. Hence, if you wish to show the relative signifi­
cance of two or three lines, use thickness. 

Color. Colored lines are the most effective of all, since few people 
might mistake one color for another. 

The stacked line chart shows trends among segments better 
than the stacked bar, since it highlights their performance over 
time. · 

However, the stacked line chart comes with a caveat: It tends 
to exaggerate the items highest on it in a kind of piggyback distor-
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tion. Since it relies on curves, the effect is more misleading than 
with the stacked bar. 

For instance, suppose a stacked line chart measures the rising 
cost of food, clothing, housing, and fuel over the years and arrays 
them in that order on the chart. If all increased at the same rate, it 
would appear at a quick glance that the price of fuel was rising 
most rapidly, because it would have the steepest curve. Actually, its 
slope would derive from its position atop three other curves, each 
steepening the curve below it. In fact, each curve really measures 
the cumulative total. The first shows food, the second food plus 
clothing, and so on. It's just not obvious at first sight. 

Clusters: Group line charts. A line chart can also compare · 
clusters, like the group bar chart. For instance, you could represent 
Company A by a solid dark line, Company B by a dotted line, and 
Company C by a double line. 

At first glance, this chart may look very much like the stacked 
line chart, since both show several lines zigzagging across the 
chart. Here, however, the lines may intersect. In the stacked chart, 
they never do (see Figure 7-16). 

The group line chart is far more elegant than the group bar for 
comparing entities at many points in time. However, it suffers 
when the items change rank often, as that leads to crisscross lines 
and ultimately a complex weave that challenges the eye. 

Figure 7·16. Group line Chart 
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One effective enhancement of this chart highlights positive and 
negative differences by shading in the space between two lines. Say 
you're comparing production and supply of bricks in Belgium. 
Wherever the nation's production exceeds its supply, some have 
plainly left the country, and you can indicate net exports by filling 
the gap between the two lines with one pattern. Where Belgium's 
supply exceeds its production, some have been brought in, and you 
can show net imports by filling in with a second pattern. 

Area charts. As you've seen, the line chart looks insubstantial, 
like a mass of telephone wires. You can partly overcome this draw­
back by filling the chart below the line, in which case it's called an 
area chart (or surface or silhouette chart) (see Figure 7-17). You can 
go further and render it in three dimensions for even greater presence. 

Figure 7·17. Area Chart 
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An area chart can replicate a stacked bar graph, in which case 
it's often termed a band chart (or multiple surface chart). The band 
chart, which derives its name from the layers of different patterns 
or colors spanning it, is useful for displaying the growth or decline 
of parts of a whole. However, it, too, suffers from the piggyback ef­
fect, and since it's more vivid the effect is more pronounced. 

The band chart is most effective as a 100-percent band chart­
that is, where each band is a percentage of the whole. Since this 
chart fills a rectangle, the steepness of line has less impact. More-
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over you tend to read it from top down as well as bottom up, re­
ducing the cumulation effect. Finally, since it measures percentages 
rather than absolute numbers, it's easier to grasp. This band chart 
is also, of course, very similar to the 100-percent stacked bar chart. 

An area chart can replicate a group bar chart, but only with 
pain and difficulty. If you place the revenues of Company A atop 
Company B atop Company C, you wind up with a .chart that looks 
very much like a breakdown of components. You also make it hard 
to compare the figures; it's particularly demanding to assess the in­
come of Company A, which rests upon the cumulated revenue of 
the other two. You forestall all kinds of problems by sidestepping 
this one. 

Multiple scale charts. Finally, there's a special line chart that 
can be very powerful but demands caution: the multiple scale chart. 
This graph matches up two trends that share one variable but not 

-another. Hence, one of its axes has two completely different scales. 
When the dual scale is on the vertical, it is sometimes called a 
double-y chart; on the horizontal, a double-x. 

Why plant two scales on one axis? Well, it can show corre­
spondences. For instance, a multiple scale chart can depict the rela­
tion over time between sunspots and auroras. One line could show 
the rise and fall of sunspot levels, the other of auroras. They would 
parallel, and the correspondence would be plain. 

How do you depict the two scales? You could simply align one 
beside the other to create two adjacent strings of numbers, but this 
method is clumsy and bewildering. The better tack is to place one 
scale on one side of the chart and the second across from it on the 
opposite side. Thus, in a double-y, one appears on the left, the 
other on the right (see Figure 7-18). 

The multiple scale chart has several pitfalls, especially for pre­
sentations. It's not instantly obvious, and hence can be confusing. 
Though the scales on either side differ, the chart seems at first to 
measure similar items. In addition, the multiple scale is not a com­
mon chart, and the audience may need time to assimilate it. 

Yet, it's a good persuader, and if you want to display it in a 
presentation, consider using a build, or successive overlay. First, 
show the trend in one line chart. When viewers have grasped it, su­
perimpose the second chart, so everybody clearly sees the nature of 
the graph. 

Many chart programs offer multiple scale charts. If yours 
doesn't, you can create one by merging two different charts in a 
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Figure 7·18. Double· Y Chart 
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paint program. You may have to detach one vertical axis and move 
it to the right. 

Labeling. In general, you don't need to label individual data 
points on a line chart, since it doesn't stress them. You may, how­
ever, wish to cover the chart with a grid, if it's important to trace 
back from the line to the scale. For the lines themselves, you can 
either place the label nearby or use a legend. 

Correlallon: The Scatter Chart 
A line chart always shows a one-to-one correlation between figures 
on the vertical and horizontal axis. For instance, a stock closing is 
one and only one number for each day. 

However, not all matchups are one-to-~ne. If you're investigat­
ing, say, the relationship between the IQ of parents and of their 
offspring, the matter is definitely hazier. Parents with an average 
IQ of 120 can produce a child with almost any IQ, but the chil­
dren's ratings tend to fall into a certain range. To express this rela­
tionship, you can plot a set of points on a chart. One axis shows 
the averaged IQ of mother and father, the other the IQ of the child. 
Each point indicates a single matchup, and the overall pattern 
shows the correlation. 

Such a chart is called a scatter chart (or dot chart or X-Y chart). 
Scatter charts reveal the extent of correlation by the narrow­

ness of the band of dots. P~rfect positive correlation is a straight 
line sloping up 45 degrees from lower left to upper right. Perfect 
negative correlation is a line sloping at the same angle in the oppo­
site direction. A relatively narrow band indicates good correlation, 
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while a larger and more diffuse one shows medium correlation. A 
circle or random pattern indicates no correlation at all. 

A scatter chart displays not just the pattern of correlation but 
also exceptions, and these may be important, too. For instance, a 
chart matching the color of stars against their luminosity has 
proved quite revealing (see Figure 7-19). 

Figure 7·19. Scatter Chart 
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This star scatter chart yields a broad swath from upper left to lower 
right, showing that white stars .are generally very bright, blue ones 
less so, yellow about average, and red the dimmest of all. Most 
stars fall into this band which astronomers call the Main Sequence, 
but there are two exceptions. In the lower left is a cloud of dim 
white stars, now known as white dwarfs. In the upper right is a 
band of extremely bright red stars, the red giants and supergiants. 
The famous star Betelgeuse is a red giant. 

The scatter chart can also compare two or more patterns of 
correlation. You simply use different symbols to represent the 
points in each pattern. For instance, the first might be an open cir­
cle, the second a cross. 

For at-a-glance comprehensibility, the ideal comparison yields 
two nonoverlapping patterns. More often, of course, there is over­
lap. For instance, Item A might form a disk and Item Ba lens-like 
shape within it. If you aren't sure the audience can distinguish the 
two, you should resort to a build and display first one, then the 
other. 
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A scatter chart may call for a trend line, a line sloping through 
the dots to indicate their gist. Essentially, the trend.line seeks to re­
duce the unruly scatter chart to the simplicity of a line chart. The 
trend line is especially vital where that trend is not imme~ately 
noticeable, though you can use it for emphasis too. It can also de­
pict an expected trend, which is useful if the real data is different. 

Don't hesitate to label certain dots, particularly if they're well 
known. In fact, if the chart has just a few dots you may want to la­
bel all of them. Such tags are welcome to the reader, since they an­
chor the chart in reality and provide useful contextual information. 

One interesting kind of scatter chart is the bubble chart, the 
range chart of this field. It replaces dots with circles or ovals of var­
ious size, to show the spread of sets of values. These charts are 
commonly used to show ratios. 

Geographic Distribution: The Polar Chart 
Polar charts are actually a crude kind of map, lacking all detail ex­
cept the location of certain physical objects or events around a sin­
gle point. They are circular with spokes radiating out from the hub. 
You plot individual points on them according to distance from the 
center and direction, normally north (0 degrees), east (90 degrees), 
south (180 degrees), and west (270 degrees). 

The most familiar polar chart is the radar map on ships, which 
displays other craft as blips. The chart is also often used to show 
the relationship of an earthquake's epicenter to local towns, or the 
distribution of stores in a chain. 

A Recapitulation 
Now that you've seen the range of charts, let's go back and sum up 
the situations calling for them: 

Information to be displayed 
Percentages 
Compared percentages 

Absolute numbers 

Positive-negative numbers 
Two parts of a whole 
Range 
Periods of time 
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Chart to use 
Pie, step-bar chart (weak). 
100-percent bar chart, 100-percent band 
chart, pie (weak). 
Bar chart, column chart, line chart, area 
chart. 
Bilateral bar, line, and area charts. 
Paired bar chart. 
Range bar and line charts. 
Progressive bar chart. 



Workplan 
Breakdowns 
Group comparisons 
Trend 
Correlation 
Geographic distribution 

Advanced Chart Graphics 

Charts 

Gantt chart 
Stacked bar and line charts, band chart. 
Group bar and line charts 
Line chart, area chart, staircase chart 
Scatter chart 
Polar chart 

As you've seen, a chart is generally a tool. It has a function, which 
it usually performs best when simplest. However, charts can also 
ascend into the realm of art. Such techniques as three dimensional­
ity and drop shadows enhance the appeal of charts, and there are 
further methods for making them look attractive and striking. 

Plctorlal Charts 
You can construct most of the graphs above with a decent business 
graphics program. There is another kind of chart, however, that 
tends to elude such software, but creates a very vivid effect: It's the 
pictorial chart (or pictograph). 

Pictorial charts show quantity through symbols-either a string 
of them or a single one varying in size. They're marvelous for driv­
ing home a point, because they make the link between numbers 
and the real world immediate and unmistakable. They also provide 
welcome diversion from the typical bar and line charts. 

Pictorial charts aren't always called for, however, and you 
should avoid them unless your information is fairly basic. They're 
often a good substitute for simple bar charts and occasionally for 
pie charts, but pictorial charts can rarely take the place of line or 
sea tter charts. 

You need a convenient symbol for the units. A coin conjures 
up earnings; a silhouette, people; and a barrel, oil production. Each 
symbol, of course, represents many of itself. A person normally 
stands for, say, a thousand people or a million. Hence, you must 
provide a key so the reader can decode the image. 

The symbol should be uncomplicated and immediately recog­
nizable. A detailed symbol, even if instantly obvious, may call so 
much attention to itself as to detract from the chart. You can mix 
symbols-supplying, for instance, a cartoon man, woman, and 
child for different bars in a chart-but if their differences rest on 
fine distinctions, the reader may miss them and assume they're 
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identical. Finally, you should make the symbols of similar size or 
the chart looks ungainly. 

Where do you find the symbol? Clip art abounds with simple 
images suited to this purpose. You could also try creating them 
yourself, particularly if you have a model before you. Since these 
figures must be kept small and rudimentary, the task is manage­
able, especially with the aid of FatBits or LaserBits. 

HyperCard lets you create basic coin charts in its Plots stack. 
You simply type in numbers in the column on the left, issue the 
Coin chart command, and the chart appears before you. However, 
it's not a very sophisticated item. The coins look rather like Go 
stones and you must export the file to a paint program to add 
labels. 

However, since most graphics programs don't offer pictorial 
charts, you may need to create them. It takes more time, but it's 
not too difficult. You devise the comparable bar chart on a chart 
program, move it into paint, and erase all of each bar except the 
very tip. Then you introduce the symbol and multiply it with the 
lasso. Replace each former bar with symbols until you reach the 
end. If the final image exceeds the tip of the bar, chop part of it off. 

Image Underlays 
The line chart tends to look abstract; it's mostly white space with a 
few lines across it, and it simply lacks the panache of, say, a three­
dimensional bar. But you can bring flair to a line chart very quickly 
with an image underlay. 

An image underlay is just a picture beneath the chart. For in­
stance, if you're tracing the decline of forestland in Nepal you 
might superimpose the graph over a stand of timber. If you're 
charting the population of Brazil, you might slip a map under it. 
Figures 7-20, 7-21, and 7-22 show example~ of image underlays. 

The image underlay is outstanding at linking chart with subject 
matter. It adds a sense of depth or, with a map, of great aerial 
height. It also permits you to grace the chart with professional 
quality graphics, since you can bring in images from anywhere. 

The key fact about image underlays is that they must not over­
shadow the chart. They should linger ghostlike in the background, 
and hence are often line drawings in gray or light colors. It may 
seem a limitation, but it also gives the image underlay a sense of 
understatement and thus confers a note of class. 

Many chart programs don't permit image underlays, but you 
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can create them easily enough yourself. You either draw a picture, 
digitize it, or copy it from clip art. Then you edit it, if necessary, 
and move the chart atop it. 

Figure 7·20. Image Underlay Example 1 
WATER SAVINGS (As or Nov. 18, compared to 1987) 

~ 9 ~ 
. . 

=-soo;. =- so% =-so% 
=- ao =- ao =-ao 
=-10 =- 10 =-10 
=-ao =-ao =-ao 
=-so =- so =-so 
=-40 =-40 =-40 

Souro.:S... F1ancitcoWMttf~ 

Courtesy of Lance Jackson, Syntax Design Associates, and the San Francisco 
Examiner 

figure 7 • 21. Image Underlay Example 2 

Kings River 

Use 
(feet per scoond) 

Courtesy of Lance Jackson, Syntax Design Associates, and the San Francisco 
Examiner 
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Figure 7-22. Image Underlay Example 3 

Applefs cash on hand 
seo~,,_..;;;...:;_------~--------. 

Examinet' graplic:a 

Courtesy of Lance Jackson, Syntax Design Associates, and the San Francisco 
Examiner 

Coda: Lying with Charts 
Like photographs, statistics look deceptively truthful. In fact, both 
can be highly misleading. Most ethical problems with charts arise 
in the gray zone between adjustment for emphasis and outright 
misrepresen ta ti on. 

It's always tempting to shape the facts to our particular argu­
ments, but the penalties can be harsh. If you use a misleading chart 
and someone calls you on it, you must make a credible case for 
yourself or your presentation is doomed and you may be suspect in 
future presentations. 

There are two basic tricks: 

•Amputating the axis 
• Altering the scale 

Trick number 1: Amputating the axis. Serious statisticians get 
quite excited over this one. Suppose sales have climbed slowly but 
steadily over the past year. Each month your company notches a 
slight increase, but compared to total sales, growth is negligible. If 
you create a chart with the axis for total sales starting at zero, your 
audience sees little difference across the graph and concludes that 
sales have remained flat. 

You can heighten the impression of growth by lopping off the 
bottom of the vertical sales axis. If the chart begins near the lowest 
figure-at, say, $500,000 instead of $0-the increase looks much 
more dramatic. Suddenly monthly growth is a far greater percent­
age of the total scale, and the firm seems to be growing faster as 
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well. You are distorting the chart. Of course, some observers would 
notice the labels on the scale to the right, but the impression re­
mains misleading. 

Yet often it's important to see the gradient of improvement, 
however slight. If it's otherwise undetectable, or if small increments 
have great impact, you have no choice but to elide part of the 
chart. 

The safe, candid, and preferred method is to cut a jagged white 
zone out of the chart's middle (refer back to Figure 7-16). The graph 
looks as though you've ripped out the center and discarded it, and 
numbers on the scale above the break are much higher than those 
below it. Such a chart both warns the viewer and preserves the 
basic scale. 

Most chart programs lack this feature. You can devise it your­
self with the following steps: 

•Create an area chart with amputated axes that highlights the vari­
ations. (You can generate it by subtracting the same large amount 
from each number before you enter it into the data table and later 
altering the numbers on the scale.) 

•Create a second area chart from a data table with the same num­
ber of entries, but only enter the highest number from the first 
chart in each one. This chart should look rectangular. 

•Save each as PICT, open with paint, and save as paint documents. 
• Erase the bottom part of the first area chart and the top of the 

second one, creating sharp, flinty contours. 
• Bring them into alignment, positioning the first chart above the 

second one. 
• Link the vertical axes and adjust the numbers in the top part of 
· the scale upwards. 

A more dubious specimen is the chart with an uneven edge at 
the bottom. Often the edge just wavers slightly, coyly evading at­
tention. Even if people notice the rough baseline, they might think 
it's a technical error and not grasp its feeble signal. 

In some cases, you can omit the zero baseline with impunity, 
usually where zero is an arbitrary value rather than "nothing." For 
instance, a time axis with years-1988, 1989, 1990, and so on­
need not go back to the birth of Christ. Likewise, an axis of tem­
perature need not start from zero, since it's another arbitrary value. 
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(It doesn't need to start from absolute zero either, since we're ac­
customed to Fahrenheit or Celsius.) 

Trick number 2: Altering the Scale. In the sales example 
above, you could further enhance the impression of achievement 
by condensing the horizontal time axis. Shorten it, and the ascent 
of the sales figure steepens; stretch it, and the rise flattens out. You 
can also steepen the sales line by expanding the dollar axis, by let­
ting each centimeter represent $1,000 instead of $100,000. Sudden­
ly the line flies up into space. 

To some extent, again, this tactic is justifiable and even neces­
sary. It helps emphasize your point and involves no attempt to mis­
lead the reader. Moreover, there is no standard size which all axes 
must be. This ploy only goes from emphasis to misrepresentation 
when the scale is drastically shortened or lengthened. 

Charts are adroit persuaders, and as such, key elements in pre­
sentations. But there is much more to a presentation than charts. 
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Presentations 
Persuasion is among the most useful of arts. It allows us to unfold 
our visions before others, to make them see and share our enthusi­
asms, to enlist them in our glowing cause. Great orators like De­
mosthenes and Daniel Webster gained almost magical sway over 
listeners and rose to power and eminence. Few of us are so gifted, 
yet we can use the tool of presentation graphics to communicate to 
the best of our ability. 

Presentations are illustrated speeches. A slide show of last 
summer's vacation is a presentation, as is a training session with an 
overhead projector. Most often, though, presentations seek to con­
vince people to take a serious course of action, and an adroit touch 
here can pleasantly spur the career and enhance well-being. 

Four fundamental elements go into a computer-based 
presentation: 

•The script, the main track of the argument 
• Visuals, the graphics which clarify and highlight.key points 
•The presentation program itself, which links the graphics together 
• The medium of presentation. 

The Script 
The script is the verbal thread of the presentation, the cord from 
which the graphics hang. If that cord sags or twists back on itself, 
graphics lose their force and cannot save the presentation. Hence, 
the script is by far the most important consideration and deserves 
great care. 

Where do you begin? The classic script promotes a course of 
action, such as "We should buy Company Z." Most such proposals 
trigger a string of questions automatically: 

•Why do it? 
• Can we reasonably do it? 
•What are the hazards? 
• How soon must we act? 
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Once you prevail on these issues-benefits, feasibility, risks, 
and time constraints-the road to action usually stands clear. 

Moreover, they form a convenient order in which to proceed, 
though the particular demands of your presentation may force you 
to alter it. However, a pure four-part organization is a little bald, 
and you can profitably elaborate on it. Let's look first at a better 
developed order and then examine the four main elements more 
closely: 

• Introduction. You may wish to highlight some need the proposal 
fulfills. 
•Brief statement of proposal. 
• Benefits. This section answers the question "Why do it?" and also 

the question "Why are we listening to this?" It whets the appetite 
for the rest of the presentation. 

• Feasibility, Part I. The details of the plan. 
• Risks or drawbacks, and how the plan treats them. 
• Feasibility, Part II. The budget and the source of initial expenses. 
• Time constraints, if any. 
• Conclusion, restating the benefits. 

Though all issues are important, benefits matter most. You 
want to conjure up a great gleaming nugget, one plainly worth a 
little pick and shovel work. If the goal doesn't seems rewarding, the 
rest of the presentation crawls. 

Feasibility is the second part: Can we do it? If your company is 
near-bankrupt, say, it may have to forgo the plan no matter how 
appealing it is. Generally, you prove feasibility by outlining a plan, 
and its sheer details often answer this question: the steps of action, 
the personnel, the budget, the availability of funding, and other 
major factors in the scheme. 

Third, you must anticipate and provide for the risks. Every 
plan has pitfalls, and you must show you've considered them. You 
want to minimize risk, provide for contingencies, and even occa­
sionally offer safety nets. This part can be the hinge of the presen­
tation, for if you evoke alluring benefits and then allay doubts, you 
vaporize most objections. However, your description of the risks 
demands a certain delicacy. If you harp on hazards, the audience 
may pick up your defensive attitude and feel the enterprise is 
ringed with peril, even if it plainly isn't. The outline above sub­
sumes risk into the overall plan, thus de-emphasizing it and plac-
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ing it in a context of control. Such a structure also shows the 
forethought that has gone into the plan. 

In general, do not simplify a risk or objection into a 0 straw 
man." The temptation may be strong because the feeling is so 
pleasant: You exaggerate a position, attack the exaggeration, and 
vanquish it with delightful ease.- But this approach ignores the issue 
and disturbs a sophisticated audience. It also undercuts your credi­
bility. Listeners worry that you've not scrutinized other real dangers 
and that your plan harbors secret weaknesses. You should convey 
the opposite impression-that you've identified and forestalled 
even more problems than you mention. 

Finally, most proposals have certain deadlines. Action must oc­
cur within a certain period of time. You should indicate the window 
of opportunity to the audience, as both a matter of information 
and, if necessary, a prod to decision. 

It makes sense to conclude with a reminder of the benefits, not 
a parroting of the original line, but a refurbishing in new verbal rai­
ment. At this point, with hazards minimized and feasibility proved, 
the benefits acquire even greater luster. The finale of a presentation 
also tends to linger in the mind. 

Sometimes the success of a presentation hangs on one major 
aspect, such as benefits. In such cases, you may have to marshal a 
string of arguments and their order becomes critical. You should 
make your strongest point first rather than working up to a climax. 
The audience begins formulating its decision from the outset, and 
you want to create a good first impression and gain momentum. If 
you lead with a weak argument, audience members may dismiss it 
outright. Present a weak argument after one or two stronger ones, 
and the audience tends to add it to the previous ones. The differ­
ence may be enough to put you over the top. 

Finally, there are certain more or less mechanical rules that go 
into a persuasive script. They are: 

Make It Brief. Studies show the average audience attention span is 
between 8 and 12 minutes. Presentations must often be much 
longer, but shorter ones benefit everyone. 

Make It Simple and Direct. You only run through the presentation 
once, so you communicate instantly or not at all. An intricate 
script with eloquent Proustian clauses spreads out into fog. And 
don't rely on handouts; they can be helpful, but only the presen­
tation gives you a chance for impact. 
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Use Active Verbs. The passive voice is the Uriah Heep of prose. It 
was done by them sinks to the floor next to They did it. (The only 
real use of the passive is to obscure communication. For instance, 
a criminal attorney would rather say "The house was robbed" 
than "My client robbed the house.") 

Avoid the Subjunctive. The subjunctive conveys hesitation; there­
fore avoid saying things like, "If it were so ... " or "We should in­
sist the zoning ordinance be changed." Also substitute will for 
would and can for could. Avoid I think and I believe. These tags 
not only add verbiage and complicate the message, but drive the 
audience to contemplate your own credibility. 

Make It Conversational. After all, you're going to have to say it. If 
it's wooden, audience members drift away into their own com­
fortable, private thoughts. You want them to feel you're address­
ing them directly, and your script should follow whatever speech 
patterns are natural to you. 

Visuals 
As photos spruce up a magazine article, graphics deepen a presen­
tation. They flesh out the string of words and enrich the total expe­
rience. They can also be very persuasive in themselves. 

Visuals are not necessarily pictures. They can be-and most 
often are-mere words flung on the screen for visual impact. What­
ever their nature, they have several virtues: 

Clarity. They bring order to complex matters. Even a list of main 
points helps structure a presentation, while a chart can instantly 
sum up a set of numbers and a cutaway drawing of a car conveys 
its makeup at once. 

Brevity. They save time. They communicate facts far more rapidly, 
leading to shorter meetings and, in the long run, greater 
productivity. 

Emphasis. Flashing a slide is like underlining a sentence in text-it 
burns the contents into the mind. You should reserve a visual for 
every major point and avoid them for subordinate points, which 
you can explain yourself. 

Engagement. A straight speech engages the ears but gives the eyes 
little to do, so they may wander. Presentation graphics occupy 
both eyes, the ears, and help hold the audience's attention. 
They're particularly important in today's world, where TV has 
habituated us to receiving information optically. 
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All visuals have one main caveat: The moment you display 
one, the audience shifts its attention _away from you for as long as 
assimilation takes. You should pause after flashing a visual and 
make your comments either beforehand, to introduce the slide, or 
later, to sum it up. 

There are five basic visuals: 

• Text ·charts 
•Tables 
•Number charts 
•Diagrams 
• Illustrations 

They constitute a gradient from all text to all pictures, and each 
has its singular virtues. These visuals are not types of frames but 
rather building blocks, to be shown eith.er alone or mixed together. 

Text Charts 
Text charts are simple lists of words or phrases. They are by far the 
most common visual, the easiest to devise, and the most generally 
useful. For instance, an introductory list of key points can fix them 
in the audience's mind and give a framework for your talk. 

As basic as they seem, text charts have their snares. For in­
stance, their very ease of use sometimes leads to overuse. You 
should deploy them only for important points and let the screen lie 
dark in between. Above all, do not put most of the script onto text 
charts, or your presentation shrivels. The audience then feels it's 
reading a report, and your own presence, repeating words on the 
screen, seems slightly ridiculous. 

Keep the list simple. Use no more than five or six lines total, 
and five or six words per line. The word-per-line restriction forces 
you to pare your prose, an exercise which often has happy effects, 
though you should avoid a telegraphic style if possible. Each point 
can have two lines, but more than that starts to look like a para­
graph (see Figure 8-1). 

You should cleanly separate each item in the list. There are 
two principal ways to do so: 

• By placing bullets to the left of each item, either numbers to indi­
cate priority or devices like black circles or dashes. 

•By providing physical breaks between the items, such as lines or 
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Figure B· 1. Text Chan 

The Five Basic Visuals 

ti' Text Charts 

ti' Tables 

ti' Number Charts 

ti' Diagrams 

ti' Illustrations 

centered bullets-black circles, stars, squares. Zapf Dingbats has a 
panoply of decorative bullets. 

Often you want to subordinate some points to others. Normal­
ly you indent the minor points and use one of two kinds of bullets, 
depending on the need for priority: 

•Numbers for main points and lowercase letters for minor ones 
• Black circles for major points and dashes for lesser ones 

You must also make sure text is readable to individuals who 
may be seated at some distance. As a general rule, avoid type sizes 
below 18 point. Select a dear, sans serif headline font, such as 
Futura or Franklin. You can use body text fonts such as Times if 
you like, but their special virtues are largely lost. Don't mix more 
than two fonts. 

Finally, you may wish to underline highly significant words or 
phrases in these charts to make sure they register on the viewer. 
Once again, use restraint-over emphasis is no emphasis. 

Tables 
Tables are data arrayed in columns, and they can go far to focus 
the presentation. They come in two kinds: text and number. 
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Text tables. Text tables are simply text charts with more than 
one column. Most often they contain two columns, but they may 
have three or even more. 

The archetypal text table consists of a pair of columns compar­
ing two categories. For instance, the heading of the left column 
might read Company A and the right, Company B. Below, each line 
matches the firms on a single criterion. For instance, one line might 
read No Youth Market and Growing Youth Market. 

Of course, a two-column table need not compare; it can list a 
set of items on the left and comment on them at the right. For in­
stance, if you labeled one column Risk and the other Response, the 
righthand column essentially offers a reaction to each entry in the 
left list. 

Many of the strictures that hold for text charts apply here as 
well, for obvious reasons. However, the verbiage should be even 
briefer, and you should supply ample space around the words so 
the eye can easily distinguish them (see Figure 8-2). 

Figura 8·2. Text Table 

Asian Capitals 

China Beijing 

Laos Vientiane 

South Korea Seoul 

Burma Rangoon 

India New Delhi 

Japan Tokyo 

Text tables can veer surprisingly close to number tables. For in­
stance, suppose we employ three columns, the lefthand one listing 
a set of features and the other two headed by the names of promi­
nent presentation programs. The center and right columns could 
show presence of each feature with an x: a text table. If the feature 
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involved quantities instead, such as minimum RAM, you would in­
sert numbers: a number table. 

Number tables. Number tables are familiar to everyone. Most 
. list one variable across the top and a second down the left. For in­
stance, the years 1985 through 1987 might extend across the top, 
and Companies A, B, C, and D down the side. The result is a grid, 
where figures such as total revenue appear at each intersection. 

Number tables can get more complex. For instance, if you 
place a percentage figure in parentheses after each number, you es­
sentially set up two strings of numbers within each column, fusing 
two tables into one. Obviously, such tables are much more difficult 
to grasp quickly. 

In presentations, number tables are mainly useful for showing 
exact numbers. Graphic charts usually sacrifice precision for overall 
relationship; number tables remedy this deficit. At the same time, 
tables are harder to absorb. If you do show a table, you may want 
to precede it with a chart. Once the audience grasps the lay of the 
land, it can progress to the exact figures involved. 

In reports, number tables are more important. They can lay 
forth a great mass of data which cannot be neatly summarized any 
other way, and which the reader can study at leisure. Such tables 
can be magnificent repositories of data, but they overwhelm 
presentations. 

In general, be wary of numerical tables in presentations. They 
threaten information overload. If you have a complex but signifi­
cant table, you may want to distribute it as a printed handout, for 
viewers to peruse later. 

Number Charts 
You've seen the variety and usefulness of number charts in the pre­
vious chapter. They have this trick: They turn complex sets of num­
bers into simple spatial patterns. You can scan a graph and grasp 
the major relationships in an instant. A good chart crystallizes di­
verse aspects into a single gleaming unit. 

As with other visuals, you should use these charts whenever 
they drive home a vital point. Save them for key issues. Even the 
most basic chart engages the mind in some decipherment in order 
to imprint it on the memory. Moreover, a number chart often 
stands out among the text and other graphics of a presentation. 
That's just the way you want it. If you overdo it, you may lose the 
critical charts amid the casual ones. 
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Diagrams 
Diagrams show abstract but nonnumerical relationships, usually of 
structure or process. Like charts, diagrams convey the gist of com­
plex matters. They not only communicate quickly and effectively, 
saving you verbal toil, but they also drive home points. (Unfortu­
nately, diagrams are often called charts. The nomenclature is loose, 
and perhaps the less we think about it, the better.) The most com­
mon diagrams are tree charts, movement diagrams, and flowcharts. 

Tree charts. Tree charts show hierarchies. Their arms branch 
like trees, with one line forking into others, which split into others 
still. Most often tree charts show the flow of authority in organiza­
tions, though they can also depict genealogies, match-ups in tour­
naments, and other pyramidal concepts. 

These charts have certain generally understood rules. Names 
of individual or position appear along the lines and the endpoints, 
and boxes often enclose them. The higher the box, the loftier the 
post. Relation lines indicate who reports to whom, and hence a box 
can have several others immediately beneath it, but is usually di­
rectly connected to only one box above. 

Boxes in the same tier don't necessarily have similar impor­
tance. For instance, if too many persons report to one individual­
say, the CEO-lack of space may force you to move some below 
others of equal rank and attach them to the CEO box with a longer 
line. Conversely, even if there is plenty of room, you may not want 
to indicate relative significance; you would simply place all who re­
port to the CEO on the same level. 

However, if you do want to show tiers of importance, you sim­
ply shift boxes up and down until they rest at the proper echelon. 
If four people report to the CEO, but three matter more than the 
fourth, that trio would occupy the second echelon and the fourth 
would sink below, opening up white space. 

In tree charts, you normally link boxes with relation lines at 90 
degrees to each other. A single line drops from the upper box to a . 
perpendicular, which extends horizontally across the lower boxes. 
Lines then descend from the perpendicular to the subordinate box­
es. Why use this structure? The alternative is a set of lines converg­
ing on the upper box, and these look cramped and may cause an 
unwanted perspective effect. 

Relation lines need not be solid. They can be broken, to show 
a transient or weaker relation. F~r instance, you could integrate a 
subcontractor into an organization diagram by placing a box to one 
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side and connecting it with a dotted line to the individual to whom 
he or she reports. 

Trees allow several means of emphasis. For example, you can 
highlight the boxes 

•Subtly, by thickening their outline 
• Noticeably, by dropping shadows behind them 
•Conspicuously, by filling them with shade, pattern, or color 

You can also expand box size. In fact, you may occasionally 
wish to place a vastly enlarged parent box at top, setting forth 
information about the head of the firm or the company itself. 

In some tree charts, box size reflects the number of employees 
in each unit, its revenues for the past year, or some similar factor. 
Such a diagram smacks of the area chart, and can be an instant 
portrait of an organization. 

The tree can also take a cue from the step-bar chart and show 
unit size in percentages. Here, the top box becomes a bar across the 
entire diagram, and boxes in the first tier are shorter bars covering 
their share of the total. Boxes in the second tier extend across their 
percentage of the one above, and so on. Here, too, the resulting 
graphic provides a vivid picture of the company, as bars at each 
level replicate their portion of the whole. The main problem here is 
that the box/bars on the lower levels can become rather slender. 

Particularly in large tree charts you may want to highlight 
whole portions of the organization, to emphasize them or clarify 
the overall structure. You can surround a group of boxes with a 
thick line, but you gain more visual interest by placing a light 
shade in the background (see Figure 8-3). To handle overlappirtg 
parts of the organization, either use different kinds of lines-for in­
stance, solid and broken-or differing background patterns, shades, 
or colors. 

Now and then a tree chart depicts compound relations. For in­
stance, if one person owns two companies, you can place one box 
at the top and hang two separate structures from it. Since the eye 
might fuse them together on casual glance, you should do one of 
the following: divide the top box into two shades, give each box a 
distinct company shade, provide two different backgrounds, or use 
a blend of these approaches. 

HyperCard has a tree chart. It's located in the Stack Ideas stack, 
titled Org Chart. So far, automatic tree charts are not available on 
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Figura 8·3. Emphaslzl~g Tree Chart 

President 

Senior VP Senior VP 

Junior VP i\s.sistant 

many Mac programs, but you can devise them fairly easily with 
draw programs or presentation software such as PowerPoint, which 
works like a draw program. 

The duplicate function makes tree charts easy to concoct, espe­
cially where boxes are all the same size. You follow this procedure: 

•Create one rectangle as a basic template. 
•Duplicate it and place the original to one side. It's used for the 

endpoint boxes at top and bottom. 
• Create a short vertical line and duplicate it. 
• Attach the lines to the midpoint of the second box's top and bot­

tom. Group the three objects together, and you have the main 
building block of a tree chart, which you can duplicate repeatedly 
and attach to endpoint boxes and horizontal relation lines. 

• Array the boxes and supply the horizontal lines. 
• Add emphasis. 

Movement diagrams. Another common diagram shows move­
ment or progression. This graphic usually tracks the course of 
physical matter, such as gasoline in a motor, blood in the circula­
tory system, current in an electro.nic circuit, light beams from a mir­
ror, or people in a transit system (see Figure 8-4). 

Such systems normally have a one-way flow, using arrows to 
show the direction. (In tree charts, the relationship goes both 
ways-subordinates answer to superiors, superiors control subordi-
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Figure 8·4. Movement Diagram: One Way 

6 . Runaway cable car 
comes to rest in 
crosswalk, 1 08 feet 
from collision point 

Cable car's 
runaway ride 

down Hyde St. 

Courtesy of Lance Jackson, Syntax Design Associates, and the San Francisco 
Examiner 
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nates-and straight lines suffice.) In the less-common case of two­
way movement, these diagrams use either double arrqws or a 
single one with two arrowheads. 

Movement diagrams, too, can partly replicate area charts, 
usually by varying the size of the arrow. For instance, a common 
world-trade diagram shows a map of the earth with arrows running 
from one region to another. Their thickness shows the volume of 
trade, often of a single commodity such as petroleum. 

These graphics can be quite abstract, with mere boxes linked 
by arrows. For example, instead of the map above, an oil trade dia­
gram could consist of arrows linking a series of squares with labels 
like Middle East, Europe, and United States. 

If the arrows return to the starting point, the diagram depicts a 
cycle (see Figure 8-5). For instance, a box labeled Landwater might 
send an arrow right to one labeled Oceans, which might loft one up 
to an apex box reading Clouds, which might drop a third down to 
Landwater again: the hydrological cycle. The three boxes form a tri­
angle, but since we think of endless processes as circles, you can 
render it better with curved arrows, easily created on a program 
like MacDraw II. 

Figure 8·5. Movement Diagram: cvcle 

The Hydrological Cycle 

Clouds 

El--Run-off ..... )I• EJ 
Flow charts. The flow chart is a highly developed and special­

ized form of movement chart. It displays the steps in certain pro­
cesses, notably those involving decisions. Programmers use flow 
charts to map out the logic of the software they're writing, but they 
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can also represent almost any procedural sequence, such as steps 
needed to gain a grant or identify a mineral. 

Flowchart symbols have different shapes depending on their 
nature. For instance, a rectangle is usually an instruction such as 
Add one to the counter. A diamond is an IF branch (a question with 
a yes/no answer); two arrows emerge from it labeled Yes and No. 
Such points can create loops. For instance, if the instruction says, 
Does the counter exceed 50?, the No arrow would return you to a 
previous point in the logic. This structure essentially says, Do not 
pass this point until you have carried out the loop operation 50 times. 

You can create flow charts with draw programs in much the 
same way as you do tree charts. Again, if you wish to emphasize 
certain steps, you can shade, pattern, or color them, or thicken their 
lines. You can also vary the connecting lines, making them thick, 
thin, broken, or dotted. 

lllustratlons 
Sometimes only a picture does it. Illustrations are particularly vital 
for spatial relations, which notoriously evade the lasso of words. 
They can show appearance, composition, and relative size. You can 
also use illustrations for simple adornment, to make the presenta­
tion look more beguiling. 

Appearance is, of course, an obvious use for illustrations. The 
outward aspect of real-world items such as projected buildings is 
often crucial, and sketches and photos can play an important role 
in a presentation. 

But illustrations can also reveal detail in large objects. Com­
monly, you highlight a small part of the item, perhaps by sur­
rounding it with a small circle, and extend conical lines to an 
enlargement of it. The viewer sees both the initial size, the location 
of the area, and the pattern as if through a magnifying lens. This 
method is intuitively clear and highly effective. 

Internal composition is another key arena for illustrations. If 
you're explaining the mechanism of an automobile, for instance, 
you could find a simple sketch of its innards invaluable. Instead of 
simply babbling about engine, brake system, drive train, and other 
salient parts, you could point to them. Such drawings come in a 
wide variety: 

Cutaway. Here you remove part of the exterior, so the viewer sees 
both the inside and its relation to the remaining hull. 
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Transparent shell. The transparent shell is simply omitted, as if it 
never existed. 

Exploded structure. For a fuller look at the parts, you can pull 
them away, much as in the exploded pie chart. This approach de­
picts each major element and shows its place in the structure 
through radial lines. It sacrifices the vision of the parts assem­
bled, which often appears after the cutaway or transparent shell. 

Cross section. You can show the object as if you had sliced 
through it and thrown half of it away. Cross sections are espe­
cially useful where several planes lie atop each other, as in geo­
logical strata or stories of a building. 

Semisection. You can display the item as if you had cut .into it two 
or more times and pulled out a chunk. With a model of the 
earth, for instance, you could make three cuts, pull out a quarter 
of the sphere, and display the structure within. The semisection 
preserves a view of the outside, which is effective here. 

Segment. You can show the part removed rather than the part 
remaining. 

Schematics. You can reduce the parts to abstract figures. Some 
items simply resist accurate depiction. For instance, if you're dis­
cussing DNA an actual picture of genes doesn't help you much, 
so a schematic sequence of them is essential. 

Relative size is also prime material for illustrations. For in­
stance, astronomers typically use a string of spheres to show the 
relative sizes of the sun and planets. Schematic illustrations in 
atlases depict the longest rivers in the world, the highest moun­
tains, the largest countries. All these diagrams smack strongly of 
area charts. 

Finally, you may wish to add illustrations to other visuals, 
either as sidelights or overlays. Either can perk up a text chart, say, 
but you must be careful the illustration does not dominate. An 
overlay in particular must be ghostly and discreet. If everyone is 
admiring the picture, the point may go begging. 

Presentation Programs 
Presentation programs let you create the actual series of frames for 
presentation. Of course, you can create them on other software, 
such as chart programs, and often that's best, but presentation pro­
grams bring it all together. They also let you create a repeating mo-
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tif for frames and change it throughout much more quickly than 
other methods. 

These programs generally contain word processors for text 
charts and draw features for diagrams and other simple charts. The 
extent of these features varies from program to program, and new 
versions are constantly filling gaps and adding new features, so you 
should consult reviews in computer magazines to see which best 
satisfies your needs. 

To ease the labor even further, many presentation programs 
come with templates so you need do little to set the frames up. 
Templates generally require little time to learn and use; they can 
also be simple to customize. If you want to spruce one up with a 
company logo, for instance, you can scan one in, autotrace it, dean 
it up, and move it over to the template. 

Means of Presentation 
You can display visuals for a presentation in a variety of ways: 

• Overhead transparencies 
•Slides 
•Computer screen images 

We discuss the process of making transparencies and slides in 
the final chapter, but for now the question is "Which do you 
choose?" 

Overhead Transparencies 
Overhead transparencies are best for low-cost, informal presenta­
tions where there's much interaction with the audience. Yoti can 
display overheads in partly darkened rooms, indicate parts of the 
visuals with a pointer, and generally discuss the frames much more 
openly. They're fast, easy, and inexpensive to make on the laser 
printer. If you have access to a color printer, you can make them 
chromatic. However, overhead transparencies sacrifice some detail, 
and they're not suitable for important presentations to sophisticated 
audiences. They may also be impossible to use in large halls. 

Transparencies afford many advantages, such as the capacity to 
point to parts of them directly. You can do this in several ways: You 
can use a pen or pencil to point to a specific part of the transparen­
cy. You can also write on it with a marking pen or, if you're wor­
ried about smudging the ink, on a clear transparency atop it. You 
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can also place a sheet of paper on the transparency and pull it 
down to reveal one point after another. Finally, this approach easily 
lets you overlay one transparency with another. 

Slldes 
Slides yield topnotch quality, especially for detailed images, and 
may be necessary for presentations on which much depends, such 
as sales presentations. They're almost essential for large audiences 
of any type. However, they require fully darkened rooms, reducing 
audience participation and leading to more formal proceedings. It's 
also harder to point to slides. You can use light pointers, flashlights 
that project arrows onto the screen, but these arrows are usually 
quite small, and if the image is large the audience may need time 
to find it. Slides are also more expensive and take more time to de­
velop. Film services are an inexpensive and easy-to-use way to 
make slides. However, film recorders are dropping in price, and 
they let you develop your own film, which may matter if security is 
an issue. 

Computer Screen Images 
The Macintosh screen is the third major way to display a presenta­
tion. It copes easily with last-minute changes,provides an effective 
way to move from one frame to the next, requires no printout at 
all, and saves time and labor. Computer slide shows can also be 
self-presenting. You can save them to disk with the script on disk 
or printed, and send them out to others who can move through the 
presentation themselves. 

The Mac screen offers other special benefits. First, you can cre­
ate special animation-like effects with a sequence of slides. For in­
stance, instead of merely displaying an exploded pie chart, you 
could show first a normal chart and then one with the piece pulled 
out. If you have several frames, you can click rapidly and the piece 
appears to move in and out. 

The main disadvantage of the Macintosh screen is its size. 
Viewers must sit very close to the Mac to see it clearly, and even so 
you may need a large screen for visibility. For presentations to 
groups of over 20, you may even require a projection TV. 

Handouts 
One of the main drawbacks of any presentation is its temporal na­
ture: When it ends, it ends. Hence handouts can be an important , 
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adjunct to help make sure the audience leaves with some of your 
points firmly in grasp. Handouts can be as simple as the basic out­
line of major points, or they can contain complex but essential 
information that may have eluded presentation on the screen. In 
any case, the handout should generally be a supplement to the pre­
sentation, not a substitute. 
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In Ireland, the greatest art treasure is not an oil, a fresco, or a 
sculpture. It's the Book of Kells, an illuminated manuscript from 
the ninth century. Though a Bible, its true subject is the alphabet. 
Its makers drew letter after letter from a background of blue or 
gold and spun them out into ornate, delightful webs on the page. 

In fact, as a graphics element the alphabet is remarkably flexi­
ble, varied, and expressive. It's not really too surprising, for letters 
began as pictures. The Chinese character for sun, for instance, was 
originally an open circle with a dot inside. Over time, burnished by 
endless use, these pictograms grew stylized and hard to recognize, 
but in China, at least, they retain their roots. 

In the West, they evolved into a small set of designs, each rep­
resenting a single sound. We're so familiar with the alphabet we 
tend to ignore its graphic aspect, but in fact it affects us all, every 
day. A font can be more or less readable, or can look rubbery, mar­
moreal, boxy, scriptlike, wooden, floral, and on and on and on. 

What accounts for this diversity? A character is not a rigid 
shape but a loose formula of lines. The lowercase t, for instance, is 
at heart just a vertical line with a short crossbar near the top. Look 
at the curved tail on it. It's completely unnecessary, but we still 
recognize the letter at once. In fact, you can stretch the basic for­
mula very far indeed without confusion. (That's why we can read 
other people's handwriting.) Hence, we can poke and prod charac­
ters to enhance esthetics, legibility, noticeability, and whatever trait 
we want. We can make the shape of letters expressive beyond their 
meanings. 

A font is any such design applied to the whole alphabet. (His­
torically, it is one complete set of characters of a specific style and 
size. For instance, 12-point Garamond is a different font from 14-
point Garamond, and both differ from 12-point Garamond Italic. 
Thus, a printer buying one font would expect to receive so many 
characters of a very specific contour. In the computer world, when 
you buy a font you get a spectrum of styles and sizes, so the term 
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has grown to embrace the design itself.) A font can be spare or in­
comprehensibly ornate, light or heavy, sober or frivolous. The 
study of type design is called typography. 

Bodv Text and Display Text 
Fonts have two main uses: for body text and display text. They are 
as different as a judge and a circus barker. 

Body text is a long tract of prose. It's meant to be read through 
and, if you're lucky, thought about. Hence a body font must not 
call attention to itself. If it does draw attention to itself, it detracts 
from the writing; used discreetly, it imparts a distinctive air to the 
text. In this regard, typography is a realm of smiling secrets, of sub­
tle tricks to influence readers without their even recognizing it. This 
is body text. 

Display text is brief, grabber verbiage, as in headings and ad­
vertisements. It's meant to attract the eye, to call attention to itself 
and, often, to direct the reader into subsequent prose. Novelty is a 
plus here. Thus, while body fonts come in relatively few, proven 
vehicles, display fonts are endless. They need not be readable in 
large blocks, and most aren't. Indeed, they can be almost unintelli­
gible, as when they bulge out into each other or when they arc in 
silhouetted human shapes to form b's and p's. The heading above, 
Body Text and Display Text, is display text. 

The exotic appeal of display fonts causes the basic beginners' 
error: using them for body text. When MacWrite first appeared and 
writers suddenly had access to fonts like Venice and San Francisco, 
they reacted like youngsters in a deserted candy store, printing out 
long paragraphs in strange and wonderful lettering. Glut set in fast. 
Almost all quickly realized it didn't work. Display fonts are not 
meant to be read-they're meant to be noticed. 

Anatomv of a Font 
Typography, like most specialties, has its own jargon. Hence, we 
must begin by defining the parts of letters so we can discuss them 
(see Figure 9-1). They are: 

x-height. As its name implies, x-height is the height of an x. More 
generally, it refers to a font's midsection, that is, the area occu­
pied by such letters as x, e, and m, and the bowls of b and p. In 
general, the greater the x-height, the more legible the character 
and the larger the typeface looks. 
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Figure 9·1. Anatomy of a Font 
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Bowl. This is the rounded form in such letters as o, b, and q. 
Stem. This is the vertical stroke of a letter, like the stalk of k. 
Ascender. This is the part of the stem above the x-height. The let-

ters b, d, f, h, k, l, and t have ascenders. 
Descender. This is the part of a character below the x-height. The 

letters g, j, p, q, and y have descenders. 
Baseline. This imaginary line runs along the bottom of the x­

height. It's analogous to the parallel blue lines on binder paper 
and provides a place for each letter to rest. Without it, text would 
undulate like a snake. 

Serifs. These are the tiny projections at the ends of lines, such as 
the ledge atop a d. They are not decoration. They link the letters 
of a word, particularly at the baseline, and so give words greater 
coherence. More importantly, they notify the eye of the end of 
an ascender, descender, or other part of a letter, and make a font 
more legible. 

Measuring Type 
Typographers have special units to measure type and other parts of 
the page, such as the space between lines. The main two units of 
measurement are points and picas, and if you plan to work serious­
ly with type, you should know them as instinctively as feet and 
yards. 

Points 
A point is 1/72 inch. Since there are 72 pixels per inch on the 
Macintosh, a point is one pixel. 

Points are the universal measure of typefaces. The middle 
sizes, from 9 to 14 point, are generally used for body text and are 
called text faces. Sizes larger than 14 point are called display faces. 
Traditional point sizes were integers, but computers make it possi­
ble to create any size in between. 

You may be surprised to find that fonts of the same point size 
are not the same actual size (see Figure 9-2). For instance, 12-point 
Times looks much shorter than 12-point New York. Why? Originally, 
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Figure 9·2. Various Fonts, All 12 Point 
Avant Garde 
Bookman 
Calligraphy 
Chicago 
Courier 
Helvetica 
New Century Schoolbook 
New York 
Palatino 
Times 
Ven.tee 
Zapf Clianary 

typefaces were set in lead and came as small blocks. Since often 
the face itself had no clear zenith or nadir, printers used points to 
measure the height of the metal, from below the deepest letter to 
above the tallest. This distance may bear scant resemblance to let­
ter size, so you must simply learn the sizes of various fonts, one by 
one. It's crazy. 

Picas 
A pica is 1/6 inch. It is also, therefore, 12 points long. Picas are 
not as important as points with computers, partly since the ma­
chine makes it as easy to work in one as the other. Given the 
choice, you might as well pick points. They give more finesse. 

Describing Fonts 
A font is an individual design, with its own air about it. It necessar­
ily makes a subjective impression, and adjectives for fonts occa­
sionally approach the comic subtlety of those for wine. But many 
terms have specific meanings, and we need them too: 

Style. Style refers to fundamental variations on· a font. Roman is 
the norm, the familiar look of print. Italic and oblique are slanted 
versions of it. (Technically, oblique is mere slant and italic is a 
different design, denser and more delicate, with such distinguish­
ing traits as a fully-rounded a rather than a barred one. In the 
computer world, this distinction is blurring.) Outline and shadow 
are other styles. 
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Width. Characters can be narrowly compressed, as in Helvetica 
Condensed, or broadly drawn out, as in Futura Extended. 

Weight. The thickness of line in characters is referred to as weight. 
Font weights are usually either light, medium, or heavy. A nor­
mal font may be thickened for special purposes. Such type is 
called boldface, as in Times Roman Bold. 

Contrast. The variation in weight within individual characters is 
contrast. Some fonts have no contrast and are the same weight 
everywhere. Others, like Bodoni, have high contrast and use 
hairlines at the bottom of the 0 or where the arch of the h meets 
the stem. Such a font is often striking in headlines, but an entire 
page of it can convey an impression of glare and be somewhat 
hard to read. Medium contrast yields the most legible fonts. 

From Gutenberg to the Modern Era 
History lives in fonts, especially text faces. Not only do we still use 
historical terms to describe them and historical names to denote 
them, but their development reveals much about their nature and 
proper use. 

Body fonts have passed through three main stages: 

•Old 
•Transitional 
•Modem 

In the first, or old, stage, fonts mimicked handwriting and 
sought clarity and legibility. In the brief transitional stage, begin­
ning in the Enlightenment, they broke away somewhat from these 
bonds. And in the modem era, which commenced in the early 
nineteenth century, a stark and compelling new style emerged. At 
the same time, display fonts proliferated, and printing moved into a 
brave new world. · · 

Old Style 
Johannes Gutenberg printed his famous Bible in Mainz, Germany, 
in 1456. Six years later, Adolf of Nassau led an army into Mainz 
and sacked it, demolishing its economic base. Gutenberg remained, 
old and penniless, but most the younger printers departed, fanning 
out to the leading cities of the continent. 

They soon ran up against a serious typographical problem. Gu­
tenberg had created a thick, angled typeface modeled on Teutonic 
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lettering, but it was hard to read and unpopular elsewhere. Jn Re­
naissance Italy, where scholars prided themselves on their graceful 
script, wags dubbed it Gothic and printers scrambled to find new 
fonts. 

The new technology found a particularly eager welcome in 
Venice, then a busy hub of world trade. Its first printer, Johannes 
de Spira, a Mainz goldsmith, created one of the initial Roman 
fonts, a design which would evolve lighter and lighter contours 
over the centuries and become familiar to readers everywhere in 
the West. De Spira also issued the first book with printed page 
numbers. 

The noted scholar Aldus Manutius opened his Aldine Press in 
Venice in 1495, intending to promulgate the work of geniuses from 
antiquity. His brilliant assistant Francesco Griffo da Bologna greatly 
improved on de Spira, and Bembo, a twentieth century adaptation 
of Griffo' s font, remains widely popular. Among other things, he 
heightened contrast and leveled the crossbar of thee. He also in­
vented italics, which he modeled, legend tells us, after the hand­
writing of Petrarch. The name proudly declared its non-Gothic 
origin, and the typeface itself economized, since it filled les.s space. 
Italics, however, proved almost as hard to read in body text as 
Gothic, and it survives mainly as an emphatic device. Griffo disap­
peared from history in 1515, after clubbing his son-in-law to death. 

The French also contributed to the old style. In Paris around 
1510, the scholar-poet-printer Geoffroy Tory introduced the apos­
trophe, the accent mark, and the cedilla into the French language. 
His protege, Claude Garamond, developed the famous font bearing 
his name, which dominated typography for 200 years and remains 
common today. Indeed, Apple employs it in much of its literature. 
Garamond also first cast italics as a variant of Roman. 

By the 18th century, the English had taken the lead in typog­
raphy. William Caslon designed the pleasing and extremely legible 
Caslon font in 1722, and for the next 60 years it enjoyed hearty 
vogue. Benjamin Franklin brought the font to the United States, 
where it was used to print the Declaration of Independence. It was 
one of the last fonts to appear in the old style period, though old 
style fonts like Times are still devised today. 

Transitional 
Caslon's contemporary John Baskerville helped inaugurate the tran­
sitional style. He had made a fortune in japanned ware, and 
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around 1750 he turned to a boyhood love: type design. His Basker­
ville font was noted for its elegance, lightness, and readability. His 
countrymen spurned it, partly because it departed somewhat from 
the sacred model of script, but it had much influence in Europe, 
and Baskerville is a famous name in fonts today. 

Modern 
In 1791, Giambattista Bodoni created one of the first modem fonts. 
Son of an impoverished printer in northern Italy, Bodoni enter­
tained notions of working for Baskerville but soon rose to become 
court printer to the Duke of Parma. He lived in the Enlightenment, 
imbibed its notions of rationality, and applied them to type. His 
Bodoni font was clean, even sparkling, but had a bit too much con­
trast for easy reading. It also had hairline serifs at right angles to 
stems rather than tapering gently into them. It didn't look like 
handwriting at all. 

Bodoni ushered in another innovation. He used identical 
shapes for similar parts of different letters. For instance, he made 
the ascender of a b the same as for an l or an h. Hence, the eye 
could concentrate on the parts of letters that differentiated them 
rather than lingering on similar parts rendered differently. This 
made it very easy to read. 

Bodv Text 
The Macintosh has two kinds of body fonts: bitmapped and laser. 
Bitmapped fonts are useful for screen display and the ImageWriter 
but cannot fully exploit the laser printer. Fortunately, most of them 
are named after towns, such as Chicago and Stuttgart, so they're 
readily detectable. 

For serious printout, you'll most often work with fonts that use 
the PostScript page description language. They embrace the range 
from old style to modem, but each has its own personality. If you 
understand it, you can greatly enhance your work. 

Note: A font can be copyrighted and owned. Yet if you make 
fairly slight alterations in one, you can create a legal original and 
obtain rights to it yourself. If you then giv~ this near-clone a name 
that suggests the source, like Nouveau Times, buyers nod and un­
derstand. Hence, many popular fonts come in a fog of similar 
names, all referring more or less to the same design. 

There are five main PostScript fonts for body text: 
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•Bookman 
• Schoolbook 
•Times 
• Palatino 
•Courier 

Bookman. Bookman originated in the Ludlow foundry in 1925. 
It has a major distinguishing feature: exceptional roundness. Its o is 
almost an exact circle. As a result, it occupies much space on the 
page, probably too much, for it tends to make the eye impatient. 
We can read faster than Bookman lets us, and the font thus smacks 
of the grammar school (see Figure 9-3). 

Figure 9-3 

Bookman 
However, Bookman is a soft, comfortable face, not to be un­

derestimated. It's based on Garamond and offers some of its vir­
tues. For instance, it has bracketed serifs, that is, serifs that curve 
into the stem as though on supports or brackets. Its fat bowls also 
convey softness, as does its lack of hairlines. 

Bookman radiates a Mom-and-Pop air, and hence works well 
for publications without pretense or formality. Similar venerable 
fonts you may find in forms downloadable to laser printers are 
Garamond and Goudy. 

Schoolbook. Schoolbook is a transitional style, like Baskerville. 
It derives from Century, a face designed by Lynn Boyd Benton and 
Theodore DeVinne for the magazine Century in 1895. The publica­
tion had two columns, and designers sought to fit more type into 
less space. 

Schoolbook differs so plainly from Bookman that most people 
can tell the difference at once, though few can explain it. 

In fact, there are several differences. First, Schoolbook 
squeezes the bowls in letters like b and p more tightly, so they sit 
upright (see Figure 9-4). As a result, it permits more characters per 
inch and keeps pace with reading speed. 

Figure 9-4 

Schoolbook 
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Schoolbook also has the sharp serifs of Bodoni. At the same 
time, it provides large circular drops called finials at the end of the 
c, f, j, r, and y. These knobs contrast with the serifs and give the 
font a livelier tone. Schoolbook's capital letters are also the same 
height as its ascenders, unlike Bookman's, whose capitals are low­
er. This feature further enhances readability. 

Since Schoolbook is more compact, it's considered somewhat 
dark. It's also warm rather than elegant, and highly legible. Some 
feel Schoolbook is the most neutral of all body fonts, ideal for text­
books, hence its name. 

The LaserWriter offers New Century Schoolbook, and other 
versions include Century Schoolbook, Schoolbook, Century Text, 
and Century Textbook. Baskerville is also available as a 
downloadable font. 

Times. Stanley Morison designed Times New Roman in 1931, 
seeking to pack type into an even smaller space for the Times of 
London. The serifs of this font were tiny but sharp, and its ascend­
ers and descenders were both short. It proved very clear and read­
able, and transformed the appearance of the paper to the general 
approbation. (Note: By including Roman within the name of the 
font, Morison made possible the interesting oxymoron Times Roman 
Italic.) 

The laser font Times is modern-style, like Bodoni, and it close­
ly resembles Times New Roman. It's even denser than Schoolbook, 
and it achieves this feat with two basic tricks: short serifs and thin 
horizontal strokes (see Figure 9-5). It simply uses less ink per char­
acter, and the savings in space is dramatic. Largely because of this, 
Times is the most popular body font in use today. 

Figure 9·5 

Times 
However, popular in this case means widespread, not well-liked. 

Times is rather cold and harsh, without the comfort and appeal of 
Bookman and even Schoolbook. Nonetheless, it does lack the hair­
lines and extreme contrast of Bodoni. Bodoni is also available as a 
downloadable font, but it's horizontal strokes are broader, and it 
doesn't achieve the remarkable compression of Times. 

Copied widely, Times is also known as London Roman and 
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English. The New York font on MacWrite is an offshoot of Times 
New Roman. 

Palatino. The famed German designer Hermann Zapf invented 
this font in 1950 and named it after Giambattista Palatino, an Ital­
ian calligrapher of the 1500s. 

Palatino answers the problem of font "personality." If you feel 
Bookman, Schoolbook, and Times are workmanlike fonts without 
special charm, you may find Palatino ideal. It is pleasant to read 
and distinctive, and almost goes so far as to call attention to itself, 
yet never quite does. 

Some say the font is old style, others transitional, but Palatino 
doesn't quite fall into any of the three categories. It has bracketed 
serifs and moderate contrast, but also occasional distinctive touches 
like the capital Y with its "serifs" that merely swell the arms, and 
the capital 0 with its racy tilt. These bestow a note of the unex­
pected on the font and enhance its appeal (see Figure 9-6). 

Figure 9-6 

The Palatino Y 
Palatino is perfect for prose that seeks to ingratiate itself, such 

as personal messages and reports that seek to persuade. It's a little 
too pleasant for prose that must look formal, such as stock offer­
ings, or even for textbooks and other plainly informational work. 
However, it's otherwise quite socially negotiable, and you should 
not be afraid to use it in novel circumstances. A technical work, for 
instance, might profit from this engaging font, which could lighten 
an otherwise dry discussion. Nearly all COMPUTE! Books are set 
in a typeface that is a variation on Palatino. 

Courier. Typewriter characters became so familiar during the 
heyday of this machine that the typeface lingers on, despite its 
grave limitations. The best known of these fonts is Courier, which 
derives from the Courier element in the IBM Selectric. 

Unlike all the faces discussed so far, Courier is monospaced. 
That is, each character occupies the same area on the page, wheth­
er it's an M or an i. To prevent gulfs of white space between char­
acters, the font grafts giant serifs onto narrow letters like l and i. 
Courier also completely lacks contrast. Its serifs are the same 
weight as its ascenders (see Figure 9-7). 
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Figure 9·7 

Courier 
A similar but more sophisticated face is ITC American Type­

writer, available as a downloadable font. This font has propor­
tional spacing and hence needs shorter serifs and far less room 
than Courier. 

Courier rarely appears in quality publications except for special 
effect. For instance, it works with "late-breaking news" sections of 
magazines, suggesting information too fresh to be set in type. Cou­
rier also lacks pretension without appearing elementary, like Book­
man, and hence may suffice for newsletters that want to look 
casual but still reasonably professional. 

Display Fonts 
Display fonts more or less began with lithography, invented by the 
frustrated Bavarian dramatist Aloys Senefelder in the 1790s. Lith­
ography enabled artists to draw directly onto the plate that was lat­
er used for printing. Hence it made posters cheaper and sparked 
demand for bold, eye-catching typefaces. But as long as fonts were 
cast from lead, there were relatively few display fonts. For the 
number of times each would be used, they just cost too much time 
and money. 

The computer has completely changed that. Now anyone can 
design a font, and since design occurs on the computer, it's tanta­
mount to casting the font. Giambattista Bodoni had to forge metal, 
but you can play with pixels on a screen. There are now over 1500 
fonts for the Macintosh alone, and display fonts have undergone a 
pyrotechnic explosion. 

What kinds are available? The variety is astonishing. Typogra­
phers have long sought to devise systems to classify display fonts, 
but it's a vexing task, given the breadth of the field and the relative 
lack of natural demarcations. The taxonomy below seems reason­
ably sane and common, but, as you'll see, it ends with a helpless 
shrug. 

Sans serif. Sans-serif fonts lack serifs. The best known Post­
Script example is Helvetica, created in 195 7 by the Swiss designer 
Max Miedinger. Helvetica is a light sans-serif font now owned by 
Mergenthaler. The Macintosh version was first called Geneva, but 
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newer systems offer both it and Helvetica, so you can inspect them 
side by side and see just how similar they are. Other versions are 
Helios, Vega, Megaron, Newton, and Claro. Another PostScript 
sans serif is Avant Garde (see Figure 9-8). 

Figure 9·8. Avant Garde, a Sans Serif Font 

Sans Serif 
Please don't use sans serif for body text-it's like staring into a 

light bulb-but don't ignore it either. It can be highly effective 
when set against Roman body fonts, as in headings, initial capitals, 
and other brief prose. In these cases it does indeed confer a crisp 
modernity, and the contrast with body text is likewise appealing. 

Black letter. Black letter (sometimes confusingly called text) 
harks back to the Gothic typeface of Gutenberg. These fonts are at­
tractive but complex, with their odd angles and decorative wisps. 
Despite its ancestry, black letter is dying out. It remains most prev­
alent in the Old English mastheads of papers like the New York 
Times and also appears on diplomas, and sometimes in church 
documents. Handle it with care. It conveys a hallowed grandeur 
that quickly turns pretentious in the wrong spot. Used shrewdly, 
however, as for comic pretentiousness, it can have singular effect. 

Square serif. Square serif fonts have blunt, slablike serifs. The 
first square serif appeared in 1815 and lacked contrast, but a later 
version called Clarendon had a little and has become quite popular. 
Perhaps because of a fancied resemblance to Egyptian architecture, 
these fonts are sometimes called Egyptian. They convey a stout so­
lidity and excel on posters. Other examples are Lubalin Graph and 
Glypha. 

Cursive. Cursive (or script) fonts frankly seek to emulate 
handwriting. They usually slope to the right and often connect, or 
try to. Before phototypesetters, these fonts were very difficult to 
cast, because of the slanting overlap and linkups. Hence almost no 
cursives were invented before 1930. 

Today, the world abounds in them. They come in myriad 
forms, from the elegant to the brushlike to the calligraphic. Indeed, 
their variety seems limited only by the variety of handwriting itself. 
English Round-Hand cursives are suitable for wedding invitations 
and other announcements that fuse the formal and the personal. 
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Cursives also commonly grace logos, not just of Kellogg's, Ford, 
and Johnson & Johnson, but also beauty parlors, florist shops, jew­
elry stores, and other businesses all across the nation. The bit­
mapped Venice is a cursive, as is the PostScript Zapf Chancery (see 
Figure 9-9). 

Figure 9·9 

Cursive 
Special. Here lie the stunners: the fat fonts, the three­

dimensionals, the stencils, the outlines, the carved stones, the ivy­
trellises, the balloon-stems, the flute-pillars (see Figure 9-10). 
Novelty sells fonts, and any font that otherwise defies classification 
winds up here, in the grab-bag. 

Figure 9·1 o. Speclal Font 

... ~-~ 
Fat Fonts. Fat fonts boasted grossly enlarged aspects. The earliest, 

designed by the Englishman Robert Thorne around 1803, had 
swollen stems and, sometimes, fat serifs too. For instance, a 
small n was two wide vertical plates linked by a hairline curve. 
The capital N was two delicate uprights crossed by a broad diag­
onal slab. 

Three-Dimensional Fonts. From a distance, the hairlines in fat 
fonts tended to vanish, making the face unreadable. Hence, 
three-dimensional fonts appeared in 1815. They resembled the 
Macintosh shadow style and not only increased legibility, but 
added interest and a sense of solidity. 

Decorative. Decorative fonts are the other extreme, a potpourri 
where typography can merge with art in beautiful, ornate de­
signs. Sarcastic printers call them the hell box after the bin for 
broken type in the corner of the printshop, yet they can be rela­
tively subdued and discreet. They can also have wood grain on 
their stems, calligraphic brush strokes, CARE-package type sten­
cils, cartoonish bulges, and any other feature you can imagine. 
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Like cursives, special fonts tend to appear in logos. For in­
stance, a wood-grain typeface would suit a dude ranch sign, a 
masthead for an Old West newspaper, or a laundromat in a Colora­
do town seeking the tourist trade. It could even work for the logo 
of a software firm if it's seeking an unusual, friendly, memorable 
image. The bitmapped and apparently moribund San Francisco­
kidnapper font-falls in this category. 

One Macintosh program specifically lets you manipulate dis­
play fonts to create unusual effects. LetraStudio from LetraSet per­
mits point sizes up to 999 points, lets you flip type, slant it, change 
its height, vary the weight of strokes, insert colors into a font or 
shadow, use Pantone colors, and attach text to the inside or outside 
of a polygon or a Bezier curve. 

Conclusion 
Knowledge of typography is useful everywhere in graphics: in 
charts, in drawings, in page design. But it is paramount in logos 
and letterheads, and to these we tum in the next chapter. 
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Symbols of Yourself 
In the First Crusade, knights rode off to the Levant encased in ar­
mor from head to toe. These carapaces protected them from medi­
eval weaponry, but they also had drawbacks. Ironclad warriors 
grew hot, moved about awkwardly, and endured immense weight. 
Frederick Barbarossa actually drowned when he fell from his horse 
into a trickling stream and couldn't get to his feet again. 

Armor caused one further difficulty. It made knights look near­
identical, a source of deadly confusion in battle. But this problem 
was tractable. The Crusaders borrowed a trick from their Islamic 
foes and applied special emblems to themselves: coats of arms. 

Intriguingly, coats of arms did not disappear with the Cru­
sades. Instead, they evolved into symbols of lineage and proliferat­
ed, appearing on castles, coaches, pennons, garments, plates, and 
wineglasses. Esoteric terms like gules for the heraldric color red 
emerged to describe them, and heraldry commenced. 

Why? Emblems have intrinsic power. They spotlight the indi­
viduality of a person, group, or thing, and thus proclaim its impor­
tance. Governments have recognized this effect for centuries, as 
witness the fleur-de-lis in France, the Hapsburg eagle in Austria­
Hungary, and the imperial chrysanthemum in Japan. 

Symbols also reduce a group to its essence, shrink its history, 
traits, and implications into a single image. Thus, much as distill­
ing a liquid intensifies its color, so emblems can focus all one's 
feelings about a group, and hence flags often bear highly emo­
tional connotations. 

Not just governments but such diverse organizations as the 
United Nations, the Red Cross, local transit authorities, and 
Greenpeace have embraced emblems. But we most often see them 
in connection with companies. 

Trademarks 
Trademarks and logos are symbols of a corporation or product. 
Like coats of ~rms, they are ubiquitous, appearing on almost every 
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document issued in connection with a firm: ads, letterheads, in­
voices. Hence they deserve careful attention. 

Technically, trademarks differ slightly from logos. A logo is a 
pictorial symbol, while a trademark can be either a name or picture. 
For this reason, the mark™ appears after some brand names, de­
claring they are taken. (If a name is too successful and comes to 
denote a whole class of products-as Scotch tape, Vaseline, and Xe­
rox threaten to do-the company loses the right to it. Hence, in 
ads, apparently normal people will say, "I'll have some of that 
Scotch brand tape.") We aren't dealing with brand names here, so 
this book uses logo and trademark interchangeably. 

Trademarks are ancient and may have begun as stamps of au­
thenticity. Archaeologists at Ur have found cylindrical seals made 
of precious metal or stone, apparently guarantees of origin. In the 
Middle Ages, guilds impressed their products with hallmarks (after 
the guild hall) or trademarks as certifications of quality. 

In modern business, a logo can serve similar ends. The very fa­
miliarity of a trademark imparts a message about quality: The com­
pany's products have earned a certain prosperity and the firm will 
probably not fold its tent tomorrow. Thus, a recognizable trade­
mark reassures buyers and is a valuable commodity. 

It can also set a product apart. Logos establish instant visual 
communication, and in stores they can register quickly on the eye. 
This fact matters even for giants of commerce like Coca-Cola, but 
it's particularly vital for new and upcoming firms seeking that first 
link of name recognition. 

Fin.ally, logos can be powerfully descriptive. They can convey 
pleasant or impressive associations, subtle or direct statements. In­
deed, a stylish logo can elevate a company instantly above its ri­
vals. At the same time, in a world without logos, every company 
would state its name in the same way as every other. Logos let 
companies express themselves. 

How to Design a Logo 
Of all the graphics in this book, logos demand the most thought 
per pixel. A company reproduces it endlessly throughout its life­
time, yet the logo itself is usually small and may be fairly simple. It 
behooves you to spend time on it and get it right. Inspiration 
counts, and perspiration may matter also. 

There are no absolute rules. But, in consultation with the firm, 
you would likely ponder these questions: 
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•How do I gain a striking image? 
•How do I differentiate the company? 
•Should the logo embody the firm's name or initials? 
• Should it describe the firm's business? 

Symbols of Yourself 

• Should it convey a special message about the company? 

Attracting the Eve 
Mercedes-Benz has one of the best-known logos in the world: a 
three-pronged star within a circle, the hood ornament on these 
cars. What does it mean? Gottlieb Daimler, an early motorcar pio­
neer, designed it and said it represented the three realms in which 
his engines ran: land, sea, and air. Few would decipher this her­
metic message. 

So a successful trademark need not communicate anything ex­
plicit. This particular logo succeeds for other reasons: It has style, 
it's simple yet compelling, and it conveys a restrained flair ideal for 
these vehicles. 

Hence, before all else, a logo should have certain visual quali­
ties. It should attract the eye, through diagonal lines, white space, 
gestalt, or other techniques. 

Diagonals. Why are asterisks such effective footnote markers? 
Their slanting lines attract the eye. We simply notice oblique lines 
more quickly, perhaps because they seem out of kilter (Figure 10-
1). Diagonals are the secret of the Mercedes-Benz logo. They also 
lie at the heart of Exxon's, whose crossed X's are both visually 
striking and verbally singular. 

Figure 10· 1. The Dlagonal DIHerence 

TM ~ 
In fact, diagonals abound in good trademarks. For instance, the 

logo of the Beach Street Baking Company in San Francisco shows a 
plump baker in reverse silhouette, holding a steaming plate of muf­
fins. But the designer has cleverly included a long-handled imple­
ment which angles straight across the image, plainly increasing its 
impact. When you come across an effective logo, check to see if it 
has diagonals. You'll find them everywhere. 

White space. White space is also an optical magnet, as we see 
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later in the chapters on page layout. It looks especially good silhou­
etted against dark colors. For instance, the logo in Figure 10-2 is a 
fish in white against a black rectangle. But the fish almost totally 
occupies the black background, and the expanse of white makes it 
stand out. In the logo of the Beach Street Baking Company, the 
baker is also white, and his very corpulence draws the eye. 

Figure 10·2. White Space 

You need not surround white space to gain the effect. You can 
partly mark it off. For instance, in the logo of the Marin Swim 
School, a pair of steel rails arc down toward an unseen pool. Not 
only do the curved diagonals attract the eye, but they embrace 
much white space, and the impact is obvious. 

Gestalt. The classic gestalt figure is the near-circle with a gap 
at the top. Experimental subjects report seeing a full circle, because 
the mind subconsciously completes the image. It's a major trick of 
perception. The brain is always at work interpreting the world. 
Thus, if you omit whole segments of an image but suggest its con­
tours, the mind moves in. Because such an image requires subcon­
scious intervention, it attracts the eye far more than one that 
doesn't. It's as though the brain keeps coming back to it, trying to 
decide what the image really is. In contrast, if you supply every de­
tail, the mind remains content and distant. 

This phenomenon is highly useful in logos. For instance, the 
original IBM trademark was three solid letters. The current one is 
the same letters broken by bars of white. The brain does a little 
work on this image, derives the initials IBM, and we feel-without 
quite knowing why-more drawn by the trademark. In fact, it al­
most seems to shimmer. The AT & T logo uses this trick, as do a 
growing number of others. 

You can use gestalt to fill out almost any familiar shape. The 
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mind derives the outline of cup~, cars, landmarks, trophies, ani­
mals, flowers, nations and continents on a map, and many other 
figures (See Figure 10-3). 

Figure 10·3. Gestalt 

~ .. -• -- • 
~ .. 
~ 

Moreover, it works with lines as well as shapes. For instance, 
the logo of Desiree Goyette is simply the name Desiree, but the de­
signer has removed most of the stems and cut back the lower loop 
of the S. The mind confronts a modest perceptual puzzle and feels 
the lure. 

Color. Primates have color vision, and it helps them spot fruit 
in the trees. Bright color also attracts the human eye, especially 
against a subdued background, and a spectrum of hues can really 
set an image apart. The NBC peacock was a forerunner in the area, 
but the example most familiar to Mac owners may be the Apple 
logo itself. Its array of colors not only highlights the trademark but 
pleases the eye, an oasis of splendor in a monochrome world. 

Second-level meaning. In general, a logo should appear 
dean-crisp, small, and manageable-since it goes everywhere. 
But just because it may look simple doesn't mean it is. Some of the 
best trademarks yield little secrets on inspection, such as the ab­
stract design that resolves into initials or a stylized object. Such 
trademarks are almost optical illusions. They convey not only sub­
surface energy but an extra layer of subtlety, desirable in a symbol 
meant to be pervasive. They can also create a pleasant tension, 
since the mind senses more to the emblem but must concentrate to 
grasp it. Finally, such logos suggest sophistication in the firm, a ca­
pacity to see deeper meanings and thus unite it with viewers who 
can do the same. 

Slnuularltv 
Like a coat of arms, the logo should distinguish the firm from other 
companies. Ideally, people can see the logo a few times and quick­
ly recognize it on later appearances. It may even be memorable. 

You can make a logo distinct in numerous ways, some already 
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mentioned. For instance, a striking image may lodge in the mind. 
Bright colors tend to be unusual in ti:ademarks, partly because they 
must be reproduced in so many media. A logo with hidden mean­
ing involves you actively as you decode it, and thus is often memo­
rable. Moreover, it reinforces itself on later viewings, since you 
may deliberately seek out the underlayer. 

Puns can be distinctive. For instance, a proprietor named Riv­
ers might work a ·river into the logo. The image would engage the 
mind for a moment, as it makes the connection between logo and 
name. 

Unexpected images can also set a firm apart. A logo that seems 
a little puzzling tends to remain in the mind. For instance, the soft­
ware dealers Beagle Bros. employ antique, country-store trappings 
in a high-tech business, and the approach stands out. The brain 
automatically seeks some connection, and the fact that none exists 
here makes it labor even more. The image works. 

Lettering 
Should the logo have the firm's name or initials? It depends. Let­
tering can link name and logo indissolubly, but there are so many 
successful trademarks with no characters at all that plainly they're 
not essential. 

In terms of lettering, logos come in three kinds: 

•Pure image 
• Part image, part lettering 
• Pure lettering 

Examples abound of all three. 
Pure image. Pure-image logos appear either alone or with the 

company name lurking discreetly nearby. 
If the image is the name, it can stand in solitary grandeur. No­

table examples include Apple's apple, Greyhound's greyhound, and 
Shell's shell. These are also highly promoted logos, however, and if 
your firm lacks a high profile, you might discreetly append its 
name. 

If the image is not the name, you normally place the name 
nearby unless the logo is exceptionally well known. For instance, 
the CBS eye needs no explanation. 

Part image, part lettering. Some of the strongest logos fuse a 
simple picture with a name, such as those for Del Monte, Kodak, 
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and Pepsi-Cola. Often, they simply superimpose the name atop the 
image for ready identification. 

Gray zones are the bane of the taxonomist, and a big broad 
swath of one separates this category from the first. For instance, 
logos tend to migrate from part lettering to none at all. Take the 
CBS trademark. Invented by William Golden in 1951, it began as a 
stylized eye blazoned across a sky of drifting clouds, with CBS Tele­
vision Network on the pupil. The image conjured up video signals 
crossing thin air, but was a bit complex. As it grew more familiar, it 
shed baggage. First the sky disappeared, and the legend within the 
pupil shrank to CBS. Then the initials vanished altogether. Because 
of the well-established link between CBS and its logo, it remains 
instantly identifiable and highly effective. 

The Shell trademark has repeatedly jumped back and forth. It 
began in 1900, as an ordinary banded shell, loaf-like and mundane. 
By 1904 the more interesting scallop had replaced it, and this de­
vice evolved into further versions, with and without the name 
Shell. By 1961, there was a single general logo, with Shell and a 
schematic scallop. Today, the image is even cleaner, and the name 
is generally omitted. 

Trademarks in this category can also move in the other direc­
tion, toward pure lettering. For instance, you can place name or ini­
tials on a three-dimensional object, like a sphere. For instance, the 
logo· for NeXT, Inc. appears on a cube. The three dimensional as­
pect of such a trademark confers depth and draws the eye. 

Letters can also emerge from a diagram or drawing through se­
lective darkening. For instance, a video company might fill certain 
pixels in a grid to form the corporate name, or a music company 
might thicken the lines in sheet music. 

Finally, you can shape name or initials into an image, and the 
more abstract the image, the closer you approach all-letter logos. 
To take a borderline example, First Federal Savings and Loan in 
California begins with two monoweight F's, turns one upside 
down, and fits them together like matchboards. Then it surrounds 
the whole with a rounded square and, to create diagonals, tilts the 
logo so it stands on one corner. At first glance, the image looks ab­
stract, almost like an ideogram, but scrutiny reveals the hidden ini­
tials within. 

Pure lettering. Many logos have nothing but type, such as 
those for 7-Up~ DuPont, and RCA. This kind of logo is the most 
common and has a number of virtues: It's simple, easily appre-
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hended, and durable. It offers less chance of straying into the 
wrong image. It permits evolution, since you can alter the contours 
of the type if they begin to seem dated. On the other hand, pure 
lettering narrows the range of expressiveness and may even fail to 
make the logo distinctive. These trademarks can be highly recog­
nizable, but if you pick a font that looks too common you may face 
trouble. 

The basic dichotomy here is between the cursive and the 
noncursive. 

Cursive trademarks generally seek to show the hand of the 
founder or communicate a personal touch, often both. For instance, 
the Ford logo, modeled after Henry Ford's signature, has proved 
durable and effective. Coca-Cola, whose flowing, ribbonlike script 
leans right and is partly underscored by an extension from the first 
C, is another famous example. 

The Kellogg's logo appears as a script rising up to the right, 
and suggests friendliness, lack of pretension, a sunrise optimism. 
We recognize a name in the Kellogg's style as Kellogg's, no matter 
what the word actually says. 

Noncursive fonts are far more common, perhaps because of 
their sheer variety. One such logo is that of IBM. Paul Rand, its de­
signer, began in the late 1950s with a square-serif font called City 
Medium. This typeface actually took square-serif one better, squar­
ing the spaces within the loops of letters like B, C, D, and 0. Over­
all, the font had a solid look to it, and in IBM the internal comers 
of the B contrasted intriguingly with the angles in the M. Rand re­
alized at the time that this design was basic and stable enough to 
evolve, and so it has. It first appeared in stripes in the 1970s. 

One common approach to this kind of logo is simply to dis­
play the letters or acronym of the company in a novel way. For in­
stance, you can fuse initials into a larger entity. The initials can be 
twisted around each other, streamlined, or superimposed atop each 
other. 

For instance, the Huntley Hotel uses nothing but its initials, 
yet its logo seems at first like a three-dimensional object. The tips 
of the stems in one H drift toward those in the other, the eye fol­
lows, and the mind leans toward a gestalt whole. 

You can also warp existing fonts to shape a very individual 
trademark name. An image processor like Digital Darkroom per­
fom).s warping, and a program like LetraStudio lets you manipulate 
fonts directly, allowing for even greater variations. 
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Nature of the Business 
Trademarks commonly show the nature of the business, to define 
the firm and set up a mental link to buyer demand. It's a venerable 
approach, and at some point you must decide whether to use it. 
Don't be cowed by its widespread use, especially if the enterprise 
may branch out into new fields. You don't want a logo that an­
chors you to the past. 

If you decide to indicate the firm's nature, you can take at least 
two tacks. One is schematization of a significant image. For in­
stance, if you're designing the logo of a lumber company you 
might reasonably deploy a tree. But you wouldn't draw an individ­
ual tree, with its own shape, location, and background-you want 
to express the general, not the particular. Hence you would reduce 
it to its basic lines, schematize it, and it would become all trees. 
Schematization turns individuals into symbols. 

Apple illustrates this principle. When first formed, the compa­
ny issued a logo of Isaac Newton under a tree with a glowing ap­
ple on it, apparently ready to drop on his head. Soon after, the 
company hired a professional public relations firm that junked the 
image for several reasons. First it was far too detailed and specific. 
It showed a real tree rather than a schematic one. The logo had 
other problems, too: 1) It emphasized Newton more than the apple. 
2) It was cliched. 3) Its message misfired, since Newton harks back 
to the past and computers are rarely sources of inspiration. The 
new trademark solved all ~hose problems. It was spare and sym­
bolic. It stressed the apple, and was novel, small, and apt. 

A second technique is to highlight part of the basic object. 
With a timber company, for instance, you could depict a bough or 
a pine cone or even a leaf. The Marin Swim School uses a pool 
ladder, which suggests the whole pool. A charter boat service 
might use schematized sail or steering wheel. 

Third, you can depict an item associated with the object. A 
charter boat service could display stylized waves. A winery might 
use a cluster of grapes, a goblet, a wine press. A publisher could 
use an inkwell. All of these images conjure up the business and yet 
lend a particular, romantic cast to it, and thus verge on special 
messages. 
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Special Message 
The logo offers an outstanding opportunity for an organization to 
purvey a particular message about its service, to characterize itself 
in a nutshell. 

For instance, a logo can convey a purpose. The logo of the 
United Nations shows a polar map of the world cradled by two ol­
ive branches, suggesting its mission of unifying the world in peace. 
The image is slightly complex, but its radial lines and interstitial 
white space make it striking, and its distinctiveness makes it very 
effective. 

Logos can also convey the particular thrust of a company. For 
instance, the trademark of the Marin Swim School in Califomia­
two stylized rails-communicates an instant message: "We're like 
these rails. We help your child safely into the water." 

And, of course, logos can have a commercial message. Again, 
Apple's logo is revealing. Before personal computers, high-tech 
companies typically chose modernistic images that connoted ad­
vanced engineering. Apple's trademark, the chromatic apple with 
missing bite, is not high-tech at all but it was wildly successful. 
Why? It's not only vivid and distinctive, it has a message: "We 
aren't aiming these computers at specialists in dust-free rooms, but 
at you, the consumer. Our product invites you to take a bite (byte?) 
out of it. It's an everyday product, like the fruit you might buy at 
the grocery store." The logo helps fight computerphobia. 

What Not to Do 
Plainly there is latitude in devising trademarks. But there are also 
two specific pitfalls to avoid: 

•Going out of date. Entrepreneurs generally intend their firms for 
long life, and the trademark should not lag behind, huffing and 
puffing. Hence, it should avoid fashions, which fade, and explicit 
depictions of technology, which can change. One firm used a logo 
of a secretary at a typewriter. That logo is lost today, in a world of 
word processors. It's not always easy to determine when an image 
is based on trends or transient technology, but if you have doubts, 
you might search further. 
• Restricting the audience. If the logo makes sense only to a cer­

tain class of individuals, it may face trouble if the business ever 
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expands. For instance, if the firm is or hopes to serve a polyglot 
clientele or become international, the logo should be comprehen­
sible to speakers of any language. 

A clever logo can do great things for an enterprise, and it may 
appear most often on the correspondence it sends out:. the 
letterhead. 

Letterheads 
A letterhead marks mail as deriving officially from the company. It 
can have great significance, especially where only few people have 
access to it, as in a law firm. In any case, it conveys an immediate 
message about your business, and merits close attention. 

Most letterhead contains the name, address, phone number, 
and sometimes telex number of the company. It may also display 
the logo, names of officers, special graphics, and other items. 

The formal letterhead is the easiest to devise, since it follows 
simple, rigid rules. You center name, address, and remaining infor­
mation at the top of the page, in a small and restrained font. This 
symmetrical layout is de rigueur in some professions, such as law, 
and in other situations may prove useful and effective. 

If the letterhead is less formal, the possibilities fan out. For in­
stance, you can place the logo and address together in top left or 
right comer. Either breaks the symmetry and lends interest to the 
page. If you normally place the date in the upper right, you might 
put the logo and name in upper left-or vice versa-to achieve a 
bit of balance. 

If you wish to add extra information, such as the names of cor­
porate officers, you can trail it down the left or right margin, be­
neath the logo. The combination frames one comer of the page. 
Alternatively, you can place these names in the opposite comer, for 
balance. 

On much stationery, the logo and address appear at the top, 
but they don't have to. You can center them at the bottom of the 
page. This letterhead conveys an effect of restraint-"we don't · 
have to shout" -and can work well in some situations, though you 
should probably avoid it if your logo is large or it unpleasantly 
weights the page toward the bottom. 

There is no reason why you need to set the logo beside the ad­
dress; you can break them up. For instance, you can place the logo 
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top center and the address bottom center, or upper left and lower 
left, though unless both logo and address are fairly long, the latter 
may look off balance. Again, these letterheads suggest restraint. 

You can also put logo in upper left and address in upper right, 
in a two-headed arrangement. However, if you take this path, try to 
avoid symmetry, and retain some central white space. If the -logo is 
dark or colored, symmetry may not matter, as the logo then out­
weighs the address. However, if logo and address creep toward 
each other in the middle, the letterhead looks cramped. 

You can also add numerous graphic elements to letterhead. A 
straight rule or wavy ribbon across the top or bottom can help 
unite the page, which is especially important if you place the major 
elements plainly on one side or another. 

At the extreme, letterhead can become almost baroque, with 
intricate designs completely framing the writing area and cutting it 
down to pad size. By this point, however, we're venturing into a 
much more varied realm: page layout. 
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The Foundation of Page 
Design 
A good publicist calls attention to the client while remaining invisi­
ble himself. Likewise, a good page design enhances the·material on 
the page without itself dancing about in the klieg lights. 

Page design is the art of arraying graphic elements-type, 
white space, pictures, rules, and many other items-on the printed 
page. It's normally camouflaged by content, hence unnoticed by 
the reader.You simply don't pick up a publication to scrutinize its 
layout. You read the prose, look at the photos, and are utterly un­
aware of the structure behind it. 

Yet page design has a deep subconscious impact. It conveys 
the tone of the publication, unites the page, directs the eye, creates 
a sense of crowding or elbow room, and affects us in many other 
ways. Indeed, a well-designed report or newsletter can afford us 
much pleasure without our quite knowing why. 

Page design has the gleam of dark magic about it. Yet many 
beginners approach it with grinning confidence, perhaps thinking it 
resembles typing, with its innocent demands of linespacing and 
margin size. Unfortunately, a typed page is not laid out at all. It's 
all raw data and, except for the prose, contributes nothing to page 
design. Layout requires high finesse, and without some awareness 
of it your efforts may be coarse and gasping. 

Like most art, page design presents you with subtler and sub­
tler decisions the deeper you go. You confront apparently negligi­
ble points that you cannot ignore, for people sense the overall 
impression of the page and details are its only building blocks. If 
you, say, leave too little space between columns, readers realize it, 
even if they can't articulate the problem. You don't have to know 
music to tell the difference between Tchaikovsky and Little 
Richard. 

Actually, part of the pleasure of page design lies in working 
just beneath the reader's level of perception. Almost all page de-
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sign involves sleight of hand, and the more care you devote to it, 
the more the audience appreciates it. 

The sheer number of details in page design can be a bit over­
whelming. Hence, let's begin with the groundwork, the basic 
guidelines which have held true over time and which enable you to 
marshal the details to your purpose. They are: 

• Format Follows Function. 
• Keep It Simple. 
•Use Variety. 

Basic Principia Number One: Format Follows Function 
Every publications has a specific nature, and page design should 
reflect it. A market analysis of the latest developments in CD­
ROMs should look spruce and dignified, while the newsletter of a 
homebrew club can appear casual and even gaudy. 

This principle has a corollary: The rules of page design are fine 
as long as they serve your ends; otherwise, they're just obstacles. 
We're not dealing here with Newton's three Laws of motion or the 
Napoleonic Code, but with guides to good results. Though specific 
rules may sound carved in granite and addressed to the witnesses 
of eternity, they're all flexible and you should bend them to your 
purpose. 

How do you identify the nature of your publication? For the 
purposes of page design, it's mainly a matter of formality level. All 
documents fall somewhere on a spectrum between the highly for­
mal and the loudly flamboyant. To determine formality, look to 
your subject matter, your audience, and what your audience wants. 

Formal Lavouts 
A formal layout assumes both preexisting interest in the topic and a 
sophisticated readership, such as one of scientists, executives, or 
lawyers. Formal layouts stress the contents of the prose. They don't 
go hallooing for attention, since they don't have to take this tack. 
Their readers are busy, text-oriented individuals who want a clean, 
attractive layout with the highpoints suitably underscored. 

You can achieve a formal look through 

• Large blocks of text 
•Fewer graphics 
• Fewer typographic tricks like callouts 
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• Justified columns 
• Fewer fonts 
• Less space between lines and in margins 

You need not use all these elements, but together they create 
an impression of dignity. 

Informal Layouts 
Informal layouts presuppose a need to engage the reader and are 
appropriate for a variety of readerships. A reluctant audience, such 
as one for ads, demands a bold effort to seize and hold the reader's 
eye. An ad layout must therefore convey the message fast, spot­
lighting its major elements. Children have mercurial attention 
spans and low text tolerance, and hence require far more graph~cs. 
Even newspapers and magazines must tempt the reader. Though 
the reader's very perusal shows some involvement, it doesn't indi­
cate interest in every single article. Most editors want the reader to 
linger over the publication as long as possible. 

You can achieve informality through 

•Smaller bloc~s of text with greater variety in size 
•More illustrations 
• More subheads, callouts, and sidebars 
•Ragged-right columns 
• Greater font diversity 
• More headings 
• More space between lines and in margins 
• More white space 

In general, you can also play around much more and employ 
the wealth of layout programs more exuberantly. 

Of course, the nature of a publication is not solely a matter of 
formality. You may seek a fairly specific tone, such as fireside 
warmth or chatty authority. To achieve these, you must often tran­
scend pure layout and seek out particular fonts, mastheads, and 
pictures. But the key point is that a cracker-barrel tone would 
sound pretty strange in a document that looks like an investment 
newsletter. 
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Basic Principle Number Two: Keep II Simple 
Layout software offers great luxuriance. You can easily succumb to 
the temptation to try all its features out at once, creating pages that 
look like ads for Ringling Brothers. It's a natural reaction to the 
sudden power, and perhaps the best approach is to get it out of 
your system with a few rococo efforts before you settle down to 
real business. 

Good page design doesn't normally bedazzle the eye. Too 
many attention-getting features wind up competing with each other 
and create an impression of clash. Instead, design should make the 
page easy to grasp and pleasant to scan. It should be discreet, a 
matter of background. 

Of course, some kinds of page design cry out for attention. But 
the layout that attracts attention is very different from the layout 
that attracts attention to many parts of itself at once. The first is 
doing its job; the second is carving itself up. 

A good layout is not just free of clutter but well-ordered. Arti­
cles occupy well-defined areas, separated cleanly from each other 
so the reader doesn't confuse them. Photos and graphics relate 
clearly to their article.s, as do headlines. Two headings do not abut 
each other since they would tend to fuse into one, even if they're 
of different fonts and sizes. 

But the key to simplicity is the central focus. 
The eye approaches a page looking for a peg to latch onto, 

around which it can order all else. If the page has more than one 
major focus, the reader hesitates and must consciously decide 
where to proceed. If the page has a single focus, the eye moves to 
it automatically, and the page attains unity. It's a subtle but power­
ful phenomenon, and the good page designer takes it into account. 

There are a number of ways to achieve a dominant visual fo­
cus. The best known is the major headline. For instance, the front 
page of newspapers commonly gives one story paramount empha­
sis, whether it deserves it or not. The layout is ·simply more pleas­
ing. To see the alternative, look at the front page of the New York 
Times. The Times generally emphasizes stories in proportion to 
merit, and often a gaggle of headlines compete for the reader's first 
glance. This approach evinces greater integrity but also makes 
weaker design. 

A large, well-placed picture can also act as the central focus. 
For best effect, it should lead into an important story on the page. 
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If the graphic is an island unto itself it confers only a superficial 
unity, since once you assimilate it you must sort out the remainder 
of the page. 

Where should you place the central focus? 
With a single-page layout, you can exploit the predictable 

course of the eye known as the Z pattern. The eye first moves to 
the optical center of the page, that is, slightly above and left of the 
geometric center. Hence, you can set a single major element, like a 
heading or picture, near the optical center and be sure of central 
focus. 

From the optical center, the eye moves right, then diagonally 
down toward the bottom left, then across to the lower right, form­
ing a rough Z. The end-point is significant also, for here you often 
find the table of contents in newspapers, and order forms or dog­
ear tags in ads; it's the natural place for them. 

Principle Number Three: Use Variety 
The simplest layout is the one-column block, like the prose that 
rolls out of the typewriter, but that's not page design-it's actually 
too simple. Like most virtues, excessive simplicity is unpleas_ant. 
You might do better to emulate Thoreau, who said, "Simplify, sim­
plify," and went out to Walden to spin forth a complex philosophy. 
In page design, simplicity is important, but don't take it too far. 
Readers like variety. 

In fact, simplicity and variety complement each other. Simplic­
ity makes the page clean and comprehensible, while variety lends 
it interest and emphasis. 

Symmetrical layouts show the importance of variety. They just 
look dead. Though appropriate for highly formal documents like 
wedding announcements, they otherwise convey a sense of page 
design by the Coneheads. Asymmetry, on the other hand, sparks 
visual interest. A certain imbalance suffuses the page with pleasant 
tension, and makes it more lively. Hence, most good layouts place 
the central focus somewhat off-kilter, the way newspapers tend to 
shift the lead headline to the upper right. Once again, don't take 
asymmetry too far. A central focus on the edge of the page ceases 
to be a central focus. . 

Don't be afraid to vary your layout within the document ac­
cording to its sections. For instance, if the whole report is two­
column and you have a preface by an important individual, you 
can emphasize it by using a single column with one wide margin. 
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Footnote and bibliography sections seldom receive as much atten­
tion as the text, so you can place lines closer together. 

You can gain variety in numerous other ways. To see some of 
them, we need only look at the layout of an article in an average 
slick magazine. It normally shows at least two elements: opening 
and body. 

Opening 
Editors realize they have to coax readers into an article. It's a little 
tricky, like inducing a plunge into water of unknown temperature. 
Hence, major articles commence with an assortment of lures, on up 
to three different levels. 

First, the story must attract the reader's attention. Thus an arti­
cle may open with lush, imaginative graphics that beckon the read­
er into the world beyond. Likewise, the first letter may be a huge 
florid capital, swathed in vines and almost unreadable. 

Once the attention has alighted ever so briskly on the article, 
the next trick is to engage the understanding. The basic tactic is to 
feed the reader the nub of the piece as fast as possible, before he or 
she is quite aware of it. The reader with some notion of a story's 
direction is more likely to pursue it, especially if it seems tantaliz­
ing. The heading is the most familiar device here, of course, but it 
has many offshoots. For instance, often a lesser heading called a 
kicker sits just above it and provides larger context. In addition, a 
lead-in (a full sentence summing up the article) may lie below. As 
these all appear in large and conspicuous type, the reader assimi­
lates them simply by scanning them (see Figure 11-1). 

Third, you must lead the reader down into the depths of the 
text itself. The method is to make the start of the story more acces­
sible. For instance, the first few words of the article may appear in 
all capitals and boldface. In addition, the first paragraph or two 
may stand out in larger type, and form one column instead of two. 
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Figure 11 • 1. The Opening 

Technology the key -- Kicker 

Behind the Japanese 
/ Heading 

Economic Miracle /Lead-in 
Technology, not hard work or low wages, played the major role 
In creating the Japanese economic boom. And the Japanese 

fostered It with skillful handling of trade bafflers, nationwide 
cooperation, low-Interest loans, and other strategies, as our 

reporter found. 

Bodv 
Once readers venture into the story, a major problem has ended 
and the expensive graphics tend to diminish. Yet readers can still 
bail out, and the layout can help keep them reading. Four common 
tools in this regard are the subhead, drop cap, callout, and sidebar. 

Subheads. Subheads break up the prose and thus provide breath­
ing room, rather like chapters in a book. Like chapters, too, they 
serve other ends. They can clarify the organization, abetting the 
reader's understanding and interest. They can also tease the 
reader on, by dangling foretastes of the prose to come. At its 
worst, the subhead is merely an alluring quote unrelated to the 
brunt of the piece. This trick can indeed spur the reader on be­
yond the decision to dismount, but it also tends to forfeit credi­
bility and lower the class of the publication. 

Drop caps. Drop caps are enlarged capital letters at the start of a 
new section. They supply the breathing room of subheads with­
out specifically announcing a new part, and they can also break 
up a gray field of text. 

Callouts. Callouts (or pull quotes, decks, or readouts) are phrases 
lifted from the text and reprinted in much larger type, often 
within a box. Callouts break up text, as do subheads, but they 
typically stress an important or provocative point made by the 
author. Like subheads, they can tend toward sensationalism. 
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Sidebars. Sidebars are substories related to the main article but de­
tached from it, and they're often boxed or even shaded. Again, 
they serve several purposes. A sidebar can be a repository of 
dense, reference-type information that's otherwise quicksand to 
the reader. For instance, a list of manufacturers or a detailed 
technical explanation properly belongs in a sidebar, where only 
those interested need read it. A sidebar can also perform the op­
posite service and showcase an intriguing aspect of the story. In 
addition, it can solve organizational problems. Suppose you're 
writing an article on music synthesizers and also wish to high­
light the life of Robert Moog. The story would have two separate 
thrusts and flop around unpleasantly. But by detaching the Moog 
profile and shunting it into a sidebar, you attain unity again, or, 
rather, two distinct unities. Finally, sidebars that chase tangents, 
like the Moog piece, vary the content of an article and often 
prove more satisfying to readers. 

These three basic principles form a general guide to laying out 
pages, but they don't address other broad, important matters. There 
are two more in particular that require mention: control of the eye 
and white space. 

Control or the Eve 
Here's a nice piece of legerdemain. It not only gives pages unity, 
but it also makes for highly effective emphasis and is almost inyisi­
ble. It involves directing the reader's eye, and it's done through 
pictures. 

Most pictures point the eye naturally in one direction or anoth­
er. For instance, a photo of an individual staring left causes the eye 
to drift left and focus attention on whatever lies there. So if you 
place a left-facing picture on the left edge of the page, the eye 
wanders off into space, and the layout seem awkward and disjoint­
ed. But if you place a left-facing graphic on the right side, to the 
immediate right of a story you want to emphasize, the reader's eye 
gravitates to that story at once. If you consistently place left-facing 
pictures on the right and right-facing pictures on the left, your 
layouts have a harmony that readers appreciate without quite 
understanding. 

The first step to recognizing a picture's direction is becoming 
alert to the phenomenon. If you look carefully at pictures in news-
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papers and magazines, you'll see exactly how they move the eye. 
Pay special attention to: 

•The direction of gaze. If you're walking down the sidewalk and 
see someone staring up at the sky, you11 probably glance up, ·too. 
Likewise, if a person in a picture is looking left, you look also. It's 
a reflex. Maybe something' s happening there. 

• The direction of lines. Most of us are familiar with the effect of 
perspective lines; they pull the eye toward the vanishing point. 
Hence, a photo of a tilled field with the furrows leading to infin­
ity causes us to gaze at the horizon, and beyond to the prose 
above. Likewise, a picture of half a corridor with the hallway dis­
appearing to the right moves the eye toward the right. The effect 
of lines is not solely a matter of perspective. The eye simply shifts 
to follow lines, and if your graphic has several leading in a partic­
ular direction, the reader tends to notice the prose beyond. 

• The direction of motion. A train moving left takes the eye with 
it. A baseball player leaping to make a catch lifts the eye upward. 
A photo can freeze an action, but the mind seems to follow it 
through. 

Not all pictures have direction. For instance, a full-face portrait 
doesn't shift the eye at all, and you can place it anywhere on the 
page. 

While Space 
Consider this layout: The entire page is blank, except for three or 
four words in the center extolling a product. The designer has sim­
ply disdained the bulk of the page. Yet the splendid white expanse 
frames the tiny message and calls attention to it magnificently. 
There is also drama in the apparent profligacy of the display. More­
over, it conveys a sense of ease and kindles a pleasurable response 
in the reader. 

White space is the great delphic element in page layout, and it 
behooves you to contemplate it. Though utterly blank, it has pow­
erful and mysterious effects. Not only does it emphasize, but it 
lends an air of generosity and grace to the page. 

Contempt for white space is the mark of the absolute novice, 
yet it's understandable. The temptation is to view white space as 
wasted space, since there's nothing there. This perception gains 
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thoughtless urgency with the realization that you or someone else 
almost certainly must pay for it. Hence, even individuals who 
know better must sometimes resist the tendency to trim that "emp­
ty" space back. White space is an active graphic element, a block, 
not a leftover, and it almost always improves a page. 

But not quite always. Its use depends on several factors. One is 
the nature of the publication. A newspaper, for instance, does not 
generally benefit from white space among the stories, for several 
reasons. It's not the custom. Readers expect papers to provide max­
imum news. Display ads and photos generally prevent the gray un­
pleasantness of unbroken text. 

Certain newsletters, too, are chary of white space. If subscrib­
ers are hungry for facts and analysis, and if you wish to convey a 
serious, businesslike image, you will likely minimize white space. 
However, you should still use it, and in no event should you as­
sume that a sardine-can layout conveys a businesslike image. 
Businesspeople like a crisp, clear presentation with a minimum of 
excess. They don't like layouts straight from the compactor. 

In display ads, white space is often essential. The eye happily 
skips a packed rectangle but feels the lure of one with white space. 
An airy look is also more appealing and may go well with pictures 
of people such as models. 

You can abuse white space. For instance, be careful to avoid 
the impression that your white space is inadvertent. A three­
column page with a few lines at the top of the third column and 
nothing but white space below just looks clumsy. The reader 
cringes, keenly aware that a modest problem has defeated the ca­
pacity of the layout artist. You can convey a fine sense of largesse 
and style by making it clear that white space is intentional. 

Finally, white space really has two roles: block and matrix. As a 
block, it's vital to page structure. But it also forms the backdrop for 
prose, and hence, under the guise of linespacing and letterspacing, 
is crucial for legibility. 

White space is thus the most pervasive factor among the many 
elements of layout. 
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Elements of Layout 
Consider this layout: Tiny type is crammed into a block stretched 
out to the limits of the page. The designer has filled every bit of 
space, and perhaps reduced the number of pages in the document 
and saved a little money. However, the tradeoff is disaster. Words 
swim before the eyes and reading them becomes a chore. The mind 
seeks an exit, as though in some layout Black Hole of Calcutta, and 
wafting over all is the affront of parsimony and insensitivity on the 
part of the publication. 

The ultimate tragedy in page design is a well-written docu­
ment that repels readers because of its layout. It can happen very 
easily, through such a simple decision as choice of typeface. If the 
page is unreadable, not much else about it matters. 

Of course, page layout can do much more than enhance legi­
bility. It can make the reading experience itself a delight. Also, if 
you have a sense of composition, the act of page design can be 
pleasurable, particularly if you approach it one step at a time. 

First Step: The Dummv 
As authors compile outlines before sitting down to write, so page 
designers sketch out dummies. A dummy is just a rough draft of the 
layout, but it has an array of benefits: 

Easy Visualization. A dummy gives you a feel for the ultimate ap­
pearance of the page. It reduces the components to a skeleton so 
you can more readily visualize the impact of the layout on the 
reader. Dummies are particularly useful if you lack a full-page 
screen. 

Speedy Restarts. You can sketch in a dummy very quickly. Hence, 
you can easily chuck it and start over again. If you make a com­
plete page design on a layout program and then decide you 
don~t like it, rearrangement is harder, even in the best software. 
As a result, you've wasted time and effort. 

Reduced Computer Time. A dummy also speeds your work once 
you get on the layout program itself. There, you can concentrate 
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on the details of design without the trouble of launching a layout 
from scratch. 

You work fastest if you sketch the dummy on a piece of paper. 
You can indicate columns by boxes with wavy lines down them 
and picture blocks by large X's. If you do many dummies, you may 
want to draw up a basic page form, proportional to the page you 
use, with, say, eight column lines drawn in. You can then make 
numerous copies of the form and use them freely. 

Okay. You're poised above the dummy, pen in hand. What now? 

The Basic Text Page 
Pages in text documents come in two kinds: basic and special. Basic 
text pages are the ordinary ones that form the bulk of the docu­
ment. Special pages include the cover, the first page, the first page 
of each section, and those in such parts such as preface, acknowl­
edgments, footnotes, and bibliography, which you may want to 
cast in a different layout. 

Let's start with the basic text pages, the core of the document, 
and return to the others later. 

Here, the dummy should consist of two pages to show the 
spread, or the look of the opened publication. The left is almost al­
ways even-numbered and the right, odd-numbered. Readers per­
ceive both pages as a unit, and if you don't treat them as such, you 
can encounter problems, as we see below. 

A single dummy normally suffices for all the basic text pages. 
Though each may differ-some may have charts, pictures, or read­
outs-the dummy provides the fundamental, repeating format. 
Though you should have some idea where sidebars, photos, and 
similar items go, you can usually insert them later by breaking up 
text blocks. The main goal of the dummy is a basic structure for all 
text pages. 

The building blocks of that structure are columns and margins. 
They form a yin-yang of the page, complementing each other and 
often creating balance and tension. 

Columns 
Columns are the backbone of your layout, and one of your first de­
cisions is how many to use per page. The rules here seem at first 
pretty straightforward. The most legible columns have between 20 
and 60 characters per line (with the optimum around 39). If the 
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line is any narrower, you may gain weird effects with line breaks 
and spacing, and the eye has to swing up and down the columns of 
a prose colonnade. If it's much wider, the mind may stray. This 
dictum translates into either two or three columns for a page 81/2 
inches wide (see Figure 12-1). 

Figure 12· 1. Two- and Three-Column Layouts 

------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

Now, that's the rule. In practice, columns are often wider, es­
pecially in books. In his Graphic Arts Encyclopedia, George A. Ste­
venson announced that columns should as broad as an alphabet­
and-a-half, or about 39 characters. He uttered this edict in columns 
over 60 characters wide. 

Moreover, the rule itself is not always right. In page design, 
nothing occurs in isolation, and you must always contemplate the 
overall interaction. Here, optimal column width expands with the 
space between the lines. That is, the more space, the easier each 
line is to read, and the wider you can make columns. 

Don't be afraid to vary the number of columns from one page 
to the next. For instance, if the first page of a newsletter contains 
the most important information in a story, you might display it in 
two columns. Subsequent pages with less important information 
might have three columns. You can also mix columns of different 
width on the same page, spreading, say, one column across two­
thirds of the page and a second across the remainder. The more 
you play with column width, however, the less formal your publi­
cation appears. 
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Margins 
In school, you may have learned certain rules about margins for 
term papers, such as leaving a larger margin at the top than the 
bottom and allowing about one inch on either side. Forget about 
them. In the world of page design, margins are a powerful tool, 
and you don't want to be restrained by a manual-of-style mentality. 

Margins ~ct as frames for the page. Hence, you should favor 
large ones, if you have the latitude. Narrow margins are actually 
more hazardous. You can easily err by making them too slender, 
destroying the frame and creating a noisome, cramped feeling. It's 
much harder to ruin a layout with wide margins. In fact, some say 
they should constitute at least 50 percent of the page. Of course, 
you don't have to go that far, and it's a rare novel indeed that 
frames the prose so luxuriantly, yet there's no question such mar­
gins make the page look more attractive. 

Margins and columns interact closely with one another, and 
you cannot really consider one without the other. 

Let's take a look at some of the options: 
Progressive margins. These are the conventional margins for a 

bound work. The inside margins nearest the -binding are the small­
est. The top margin is larger, the outer one larger still, and the bot­
tom largest of all. They're called progressive because their size 
grows in this manner. In fact, the inequality is deliberate and lends 
interest. If they were all the same, the hush of monotony would 
spread across the page. 

Progressive margins feature a large block of text in the middle. 
You can make it all one-column-you probably will if the docu­
ment falls into a traditional single-column category, like most 
books-or you can use two, three, four, or even more columns. 

One wide margin. A wide margin on one side of the page and 
a normal margin on the other can be a highly effective layout. It 
adds white space and an attractive asymmetry, and also lends itself 
to variations based on the spread. 

For instance, suppose you use a one-page dummy and make 
each page identical, with a wide margin on the left side. It may 
look pleasing and asymmetric, but in fact you're now in something 
of a pickle. On the lefthand even-numbered pages, the prose lies 
near the stitching, while on the righthand odd-numbered pages, it's 
out by the edge. Hence, this layout forces the eye to jockey from 
center to edge to center to edge, disorienting the reading process 
and calling attention to the page design itself (see Figure 12-2). 
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Figure 12-2. Asvmmelrlc Spread 

A far better layout exploits the spread as a single entity. If you 
place the wide margin on the left of the left page and the right of 
the right page, you wind up with white space on the outer edges of 
both pages. It frames the prose and creates a pleasant sense of 
space. Though it's symmetrical, you can tilt the balance by placing 
readouts and graphics here and there in the margins. It's hard to go 
wrong with this layout (see Figure 12-3). 

Figure 12-3. Wide Outer Margins 

Finally, you can place wide margins on the inside of each 
page, bringing the prose out to the edge and cutting a large white 
groove down the middle of the spread. This layout is rather 
splayed, but it may work in special circumstances, particularly if 
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you can unite the prose blocks through pictures or other devices 
(see Figure 12-4). 

Figure 12·4. Wide Inner Margins 

In most cases, a wide margin works well with a single column. 
It is thus well-suited for reports on 81/2 X 11 inch paper, where you 
might otherwise have to use two columns. 

Saning Up the Software 
Once you have the rough page design, you're ready to open the 
layout program and go to work. As you do, you can experiment 
mixing different features like chemicals in a retort, seeing how 
blends of, say, line spacing and type size affect readability and 
appearance. 

Layout programs differ, but most have two basic items you 
confront at once: master pages and grid. 

Master Pages 
Master pages do two things. First, master pages let you create differ­
ent formats for odd and even pages. As you've seen, this capacity 
is important for reports and other documents which will be bound 
and printed on both sides of the page. 

More important, master pages let you set up a format for 
successive pages, so you don't have to stoop and place the grid on 
every single page. The master page acts as a template for all 
successive pages, so sometimes you must be careful. For instance, if 
you wish a page rule to appear on all pages but the first, you must 
generally lay out the first page in a different document. 
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Grid 
The grid lets you place items on the page more accurately. It pro­
vides visual orientation and snap-to, an option which automatically 
aligns blocks with the comers o( the grid boxes. The grid is usually 
expressed as one number times another, so 2 X 2 yields four large 
blocks, 5 X 5 yields 25, and 8 X 8, 64. You can normally define 
your own grid, and the denser you make it, the greater control you 
have over the page. 

The grid doesn't define anything-it's a convenience. Hence, 
the area outside the grid is not at all the same thing as the margin, 
though at first glance they look similar. 

Readability 
Text layout is a futile exercise if the reader winds up struggling 
with the prose. Readability is the most important single goal of text 
layout, next to which appearance is just a pleasant sidekick. 

Prose on the page should register quickly and easily on the 
eye. You want to pamper the reader, removing every mental effort 
to divine the letters on the page. The task of deciphering characters 
has a cumulative effect like jogging, and while your readers may 
easily read a paragraph or two of badly laid out prose, eventually 
they become fatigued, lay the publication down, and seek m~re 
congenial activity. 

A readable layout has three components, all of which are 
critical: 

Letters. Characters should be easily recognizable and clearly distin­
guishable from nearby letters. That is, they should appear in a 
pleasing and legible. typeface. 

Words. Make your words distinct and apparent, not lost in exces­
sively long lines or odd formats. They should stand out promi­
nently in the column. 

Lines. Separate lines plainly, not pressing them together plywood­
style. There should be enough linespacing so the eye doesn't 
stray from one line up to another. 

The Clarltv of Letters 
Anyone can master the use of legible PostScript fonts; it just calls 
for a little study and a touch of discretion. The precepts include: 
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.Select Readable Fonts. As we have seen in Chapter 11, the best 
fonts for body text are the old, transitional, and modem styles 
developed solely for this purpose. Sans serif and most other 
styles work best in headings or readouts. Pay attention also to 
the personality of your font. Bookman, Schoolbook, Times, and 
Palatino have markedly different darkness and style. Bookman 
looks somewhat round and elementary, Schoolbook pleasant 
and neutral, Times a bit sharp and dark, and Palatino warm 
and ingratiating. With downloadable fonts, you need not exam­
ine the details of every letter. For sheer readability, just take a 
look at several fonts in block type and see which feels easiest on 
the eye. 

Use 8- to 14-Point Type for Body Text. Smaller sizes are hard to 
read and smack of the classifieds. Bigger ones devour space, sug­
gest reading glasses, and make the reader impatient. Of course, 
you may want to begin an article with larger type or use it for 
special purposes. 

Avoid All Caps. Most capital letters look rather bricklike and the 
eye needs greater effort to distinguish them. Hence prose written 
solely in caps strains the retina, and even headlines have the 
same effect. Don't shun all caps entirely, but use them with 
discretion. 

Avoid All Italics, Boldface, and Reverse Type. These devices all 
work fine for emphasis, but in long stretches they tax the read­
er's mind. It's like shouting everything. 

Use Fonts Discreetly. Avoid using more than three fonts in one 
publication. Too many font changes alert the reader to their exis­
tence and weaken their impact. 

The Clarltv of Words 
The width of columns is the prime factor affecting the clarity of 
words, and we've dealt with it above. However, there's a second, 
post-dummy aspect to consider if you have two or more columns. 
It's intercolumn space. · 

Here you face a balancing act. You must provide enough room 
between columns to clearly separate them, yet not so much as to 
let them float autonomously. Generally two picas (14 points) is 
standard, and one pica (7 points) is the minimum. To let more air 
in and lighten the tone,. you can increase this amount a little (see 
Figure 12-5). 
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Figure 12·5. Improper lntarcolumn Spacing 

If you must have narrow spaces between columns, you may 
wish to use a hairline rule to separate them. This usage tends to 
make the page look more blocklike but it's hardly fatal, and if.you 
must squeeze columns together, you probably don't care. 

The Clarlty of Lines 
Here's a topic that seems simple and innocent enough, but has 
enough barbed wire underfoot to snarl anyone who ignores it. In 
essence, you keep lines clear and distinct with linespacing, para­
graph spacing, indention, and the avoidance of widows and 
orphans. 

Linespacing. The art of linespacing (or leading, from the days 
when it was created with thin strips of lead) also involves a certain 
balance. You can't press lines of prose too closely together or the 
reader starts searching for a way out. Even moderately tight 
linespacing can cause the eye to flip from one line to another and 
mix the thread. On the other hand, too much leading makes the 
lines appear to drift apart. The lines must cohere, must ultimately 
form a block. 

The rule of thumb is to insert linespacing equal to about 20 
percent of the size of the type. Hence, if you have 10-point type, 
you want 2 points of linespacing; if 14-point, 3. Most layout pro­
grams have an Auto Leading feature that automatically spaces lines 
by 20 percent. 

Don't accept this gift too quickly. Linespacing is more complex 
than that and interacts with a series of page elements. 
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First, as you've seen in Chapter 11, type size is an approxima­
tion. It measures not the actual height of a font but the height of 
metal blocks on which fonts came in days of yore. Hence, if your 
typeface is especially small, you may need less leading. If it's rela­
tively large, you may need more. 

There are other factors: 

x-height. A font with a small x-height has proportionately longer 
ascenders and descenders. These force open extra white space. 
Hence, a small x-height normally calls for less linespacing, a 
large x-height, more. 

San Serif. Sans serif fonts don't cap off the ends of ascenders or 
descenders, and consequently they lead the eye further above or 
below the line of text. If linespacing is particularly tight, ascend­
ers can almost fuse with descenders above. These fonts require 
more linespacing. 

Very Small Type. Minute type, around 6-point, requires more than 
20-percent linespacing. At that size, type challenges comprehen­
sion unless you open it up a bit. 

Column Width. The wider the column, the more effort the reader 
requires to cross it. Hence, the more linespacing it needs. One 
observer recommends amounts as high as the following on stand­
ard 81/2 X 11 inch paper: 

·Columns Leading 

1 7 points 
2 5 points 
3 4 points 
4 2 points 

Formality Level. A smidgen of extra leading makes prose both 
more readable and less formal. 

Paragraph Spacing 
Paragraphs often call for extra leading, as they're distinct segments 
of the prose, and a good layout program provides it automatically. 

The space between paragraphs partly depends on the kind of 
indention you're using: 

Normal Indent. A normal indent usually requires no extra spacing 
at all, since the indent itself marks the paragraph off. 
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No Indent. With no indent, you need a little more spacing. to show 
the break. This approach also lets air into the document and 
makes the contents leap out. (Some say you should never indent 
after a heading or subhead, though this stricture may be more a 
matter of fashion than imperative.) See Figure 12-6. 

Figure 12-6. No Indent Cleft) and Negative Indent 

Negative Indent. A negative indent (or hanging indent or outdent) 
is the· reverse of a normal indent. The first line begins at the left 
margin and all subsequent lines are pushed in. Why use it? It 
highlights the first few words in a paragraph and is extremely 
helpful when the reader's searching for footnotes, bibliography, 
lists, and other prose. This section is set in negative indent. Neg­
ative indents are unusual in body text, as they tend to create a 
clumpy effect, but with short items like, say, paragraphs in a list, 
they can compel attention. Their striking impression derives not 
only from their unconventionality, but also from the extra white 
space they mete out. 

Widows and Orphans 
Here is the sob story of page layout, the single line bereft of its 
paragraph. A widow is the first line of a paragraph at the bottom of 
a page or column. An orphan is the last line of a paragraph strand­
ed at the top. You can help keep them straight by thinking of the. 
paragraph as the ufamily." The widow engenders it and comes 
first. The orphan is the offspring and comes last (see Figure 12-7). 
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Figure 12·7. Widow (lop) and Orphan 

people who had leaped off the boat and were swimming 
to shore as fast as they could. 

The widow refused to jump into the water even 

orphaned. 
He had managed to hide this secret from every 

Avoid them both. They break the flow. A widow commences a 
paragraph and often holds its topic sentence, yet its distance from 
the paragraph can have the reader flipping pages back and forth. 
Orphans are worse; they leave the reader hanging. A thought may 
be almost finished, yet the reader must hold all in suspense till the 
top of the next column. The reader may even supply the end of the 
paragraph, only to turn the page and see something different. The 
one-word orphan looks particularly dismal, as it may not even cov­
er the paragraph indention below it. 

Some programs automatically prevent widows and orphans. 
Others give you the power to keep selected blocks of text together. 
Sometimes you can also eliminate these isolates by editing, by al­
tering the justification or letterspacing, or by other techniques, In 
the latter cases, you must simply be on the lookout for widows and 
orphans, and act to reunite them with their paragraphs. 

Alignment 
Like philosophers, page designers have many disagreements. One 
of the best-known arguments addresses how to line up text on the 
right. Some favor a flush-left/ragged-right look-ragged right for 
short-where text ends more or less where it happens to end, as 
on a typewriter. Others think text should align vertically on both 
sides, as in most newspapers. This flush-left/flush-right arrange­
ment is called justified. 

Note that both have a straight left edge. A straight left edge 
looks good and, more .importantly, it provides a dependable start­
ing point for the eye as it seeks each new line. 
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Ragged Rlaht 
Ragged-right columns have certain plain advantages. They place 
uniform spacing between words. They provide a consistent color 
across the page, hence forestalling the rivers-of-white phenomenon: 
bands of empty space that wind down the page like large, fluid 
cracks. Ragged-right columns involve fewer technical challenges. 
Some people believe these factors make ragged right easier to read, 
though proponents of justified prose claim it compensates through 
its pleasingly straight sides. 

In any case, ragged right is normally preferable where you 
have: 

Narrow Columns. The concern here is an excessive numbers of 
hyphens. A justified column needs more hyphens than a ragged­
right column, and as it narrows it demands more and more. 
Hence, the hyphens can stack up on the right like a string of 
high-rise balconies. Ragged right greatly cuts the need for hy­
phens, though it still requires some to prevent long blank caves 
in the prose. Ragged right also enhances the esthetic appeal, 
through its irregular line and extra white space between columns. 

Less Formal Documents. Ragged right simply looks less formal, 
more like typed than typeset prose. 

Desktop publishers with inexperience or limited software 
should also consider ragged right, to avoid the pitfalls of 
justification. 

Justified 
Readers have favored justified text for centuries. Its clean verticals 
on left and right are formal, yet appealing. Also, for many people 
justification contains a touch of magic: Just how do they line that 
right side up, anyway? 

It's done by: 

• Wordspacing 
• Hyphenating 
• Letterspacing 

Wordspadng. Many word processing programs use only the 
first method of justification. Inserting spaces between words alone 
does indeed justify prose, but it can create lines with large spaces 
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between words. With several such lines in a row, some wordspaces 
inevitably match or almost match, and the eye fuses them into a 
wriggling whole, like snakes crawling up the page. White space, as 
we've said, is a very real graphic element. 

Hyphenation. Most Macintosh layout programs, as well as the 
better word prpcessors, have automatic hyphenation to help miti­
gate this problem. Hyphens break up the long words that often cre­
ate this distress in the first place. 

There are two fundamental way a computer can hyphenate: al­
gorithmic and dictionary. 

Algo.rithmic hyphenation (after algorithm, a step-by-step for­
mulaic procedure for solving a problem) works by applying the 
laws of hyphenation to words. For instance, one rule states that 
you hyphenate between two adjoining consonants bookended by 
vowels, as in mar-ket or pub-lish. The program seeks out such letter 
combinations and breaks words there. Unfortunately, the laws of 
hyphenation are full of loopholes. For instance, if you rely on the 
principle above, you get bet-ray for be-tray, ret-read for re-tread, 
and, indeed, hyp-hen for hy-phen. 

Dictionary hyphenation, in which the program checks the 
word against the contents of its dictionary, is more accurate. How­
ever, it also takes more tiine. 

The most practical hyphenation features integrate both, using 
algorithms for speed and also consulting a list of exceptions to the 
rules. It takes slightly longer than pure algorithmic hyphenation 
and lacks the accuracy of dictionary hyphenation, but benefits from 
both. And you can always add hyphens yourself-preferably soft 
hyphens that disappear if the word wraps around. · 

Hyphenation prevents the worst-case scenario: the line with a 
smattering of words separated by great gobs of white. But even hy­
phenation cannot create the impression of regular spacing between 
words that go on to meet perfectly at the right. For that, you need 
the true hero of this feat: letterspacing. 

Letterspacing. Letterspacing is fairly simple. It lets you insert 
tiny spaces between letters, thereby swelling out words and nar­
rowing the patches between. Many programs let you set letter­
spacing to a minimum and maximum number of points, and with 
this feature, you can almost always maintain well-spaced words. 

Does justified text look good? Most people think so, but ulti­
mately it's up to you. Even if you like it, you should note that it in-
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creases the word count per page and hence darkens the look, since 
it reduces white space. 

Other Margin Alignments 
There are three other kinds of alignment: ragged left, centered, and 
runaround. 

Ragged left. For display text you may occasionally want to use 
ragged left and flush right. Its novelty attracts attention and its wa­
vering left line gives it visual interest. Like ragged right, it also pro­
vides uniform wordspacing. However, you should confine this con­
figuration to short bursts of text. Long tracts of prose arrayed in 
this way are exhausting to read. 

Centered. Likewise, you may now and then wish to center 
each line as if it were a title. Centered text can yield nice special ef­
f~cts, but if you center more than two or three lines, pay attention 
to the shape you're creating. It should be pleas~ntly irregular, nei­
ther too symmetrical nor too erratic. Again, centered text is for dis­
play. A whole magazine article laid out this way would quickly 
cause the eyes to twitch. 

Runaround. A fifth kind of alignment arises only briefly in 
special situations. It's the runaround, in which type follows their­
regular contour of a graphic. Some page layout programs make 
much of this feature, as it is technically advanced, but you may not 
actually use it very often. If you do, avoid placing the text too close 
to the graphic. You don't want to crowd it. If you give it a little 
white frame, you highlight it. 

Others. Of course, this survey does not deplete the field. There 
are numerous odd kinds of alignment, such as parallelogram, where 
the left and right sides slope parallel to each other; or text arrayed 
as a picture, like the rat's tail in Alice in Wonderland. 

Special Sections 
When you have the basic pages sketched in, you're ready to look at 
the special pages. The easiest to handle are those in discrete sec­
tions, such as the bibliography. · 

In general, it's a good idea to vary the layout in such sections. 
It provides relief for the reader and can greatly enhance the look. It 
also gives subtle notice that one is in a different section, where 
new rules apply. 

Such variations can serve important purposes as well: 
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Footnotes and Bibliography. Here, the reader is often hunting 
through long, formal columns for a specific entry, usually denot­
ed by the first few characters or words. Hence you should high­
light footnote numbers and authors' names with negative indents. 
You may also want to condense the linespacing and reduce the 
type size. Both of these sections typically have one column, but 
you can render them in two. 

Index. An index is a set of references to topics in the document by 
page number. The entries are usually a word or two, occasionally 
with subentries. Hence they're much too brief for negative 
indents and look very strange indeed unless they're in multiple 
columns. You should set the index in smaller type, since not 
everyone consults it and only the proofreader reads it consecu­
tively like normal prose. 

Prefatory Remarks. The preface and foreword face a slightly dif­
ferent problem. To the chagrin of authors, some people skip 
them. You can subtly draw attention to them by using a different 
number of columns or negative indents or both. If it really mat­
ters, you can step over the line and add full-fledged pictures. 

Table of Contents. In many tables of contents, items nest within 
each other, somewhat like negative indents. Avoid more than 
one or two levels of nesting, however, or the table looks ama­
teurish. You may also want to string dots out from entry to page 
number. It's attractive and it aids the reader. 

lnltlal Pages 
Initial pages, like the first page and the first page of a section, have 
very special functions. They show a break in the flow, introduce 
the upcoming material to come, and often seek to lure the reader on. 

Breaking the flow is important. It gives the reader breathing 
room and adds variety to the otherwise gray expanse of text. It also 
helps organization, since often a heading or lead-in sums up the 
section it presides over. 

The heading. Everyone looks at the heading. That's what it's 
there for, and you should approach it as carefully as if you were 
painting your house. 

First, consider the font. You can use the same typeface you use 
for body text, but the heading often looks better with an alterna­
tive, especially a sans serif. For instance, Palatino is set off well by 
Avant Garde. 
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Some people warn against all caps for headings, since it's less 
readable. However, if the headings are brief and infrequent, this 
drawback ebbs and you can fully exploit the attention-get.ting 
prowess of all caps. All caps can also help set off major headings 
from lesser ones. A newsletter with many heads, however, would 
look terrible if each were all caps. 

You can align headings in several ways. Centered headings 
look good at the top of sections in reports or where headings are 

. relatively uncommon. Flush-left headings work best where several 
of them compete for attention. Flush right may even work too, but 
avoid justifying heads. It's a strain, it destroys white space, and it 
may require hyphens. Never hyphenate a heading if you can help it. 

Since the heading breaks up the flow of text, you should 
warmly invite white space into this neighborhood. A block of white 
beside a heading calls attention to it, enhances the layout, and pro­
vides a clear break. Such white space is sometimes called a sink. 

Kerning. The opposite of letterspacing, kerning is the reduction 
of space between letters rather than its expansion. Why use it? It 
helps fit certain letters more snugly together, thus compressing 
slight but detectable gaps between them. For instance, in the 
unkerned word 

WASH 

you could draw a vertical line between the W and A that would 
cleanly separate them. Hence, there is a slanting gap between the 
letters. They look better if you fit them together, so the W overlaps 
the A. Kerning gives you that little tuck: 

WASH 

Kerning is particula~ly important with headings, where the 
gaps are more noticeable. A good layout program lets you perform 
this feat, though few as yet can match the range and sophistication 
of a typesetting program. 

Other heading devices. As you've seen in the last chapter, the 
heading comes marching in with two clever assistants, the kicker 
and the lead-in, and they can be invaluable. 
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The kicker. The kicker sits above the heading and adds depth 
to it. It should be set in smaller type that contrasts with the head­
ing, such as bold, italic, or even reverse type (white on black). The 
kicker can be an excellent way to entrance the reader with perspec­
tive on the article. 

The lead-in. The lead-in is a brief explanation of the story, ap­
pearing just below the heading and in smaller, different type, often 
italics. For readers, it often performs the function of the toe-in-the­
water before diving into the pool. It helps answer the question: Do 
I really want to spend time on this piece? Hence, it should be brisk 
and tantalizing, and you should give it much thought. 

Teasers. A final device to plunge the reader into the document 
is the front-page teaser. It can be as simple and dignified as a table 
of contents, which both helps the reader locate articles and high­
lights the offerings within. It can also be a provocative quote, or a 
mention of a topic or author followed by the page number. In 
either case, the teaser should be set off by a box, and you may 
want to shade its contents. It can also be a small triangle at the top 
corner of the page, often with type at an angle. 

While Space: A Summation 
Before we go on to some of the special features you can use to 
spruce up your layout, let's pause for a moment and again contem­
plate white space. (It's possible page designers would not go on at 
such lengths about white space if others understood it better, but 
given the general inexperience with the device and its inscrutable 
nature, one can hardly overstate its importance.) 

White space gives a page contrast and tension, frames text, and 
provides a place for the eye to rest. We've seen plenty of examples 
of its use, and here's a list of some of them: 

Margins. The white space in margins frames the prose and makes 
it look more appealing. 

Between Columns. White space opens up the layout here and pre­
vents the reader from gliding from one column to another. In 
general, the wider the, column, the more white space you need. 

At the End of Ragged Right. Ragged-right alignment adds extra 
white space, and may thus be valuable in multicolumn layouts. 

Linespacing. The area between lines on a page is white space, and 
a generous amount of it enhances readability, making the prose 
jump out at you. 
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Indents. Normal indents open up enough white space to distin­
guish between paragraphs. Negative indents create much more 
on the left, interrupted occasionally by the first lines of 
paragraphs. 

Paragraph Spacing. White space between paragraphs can greatly 
enhance the look of a document. 

Beside Headings. White space near a heading can emphasize it 
better than increasing the type size. It also helps break the 
document. 

Speclal Features 
Text layout abounds in little tricks to make the page livelier. Some 
of the most effective are mere lines, such as rules and boxes. Other 
are typographic, like lists, subheads, callouts, and drop caps, or 
semipictorial (like dingbats and decorative borders). Finally, of 
course, there are the blocklike screens, charts, and pictures 
themselves. 

Rules 
Rules are among the subtlest, commonest, and most powerful de­
sign tools you have. They're strikingly simple, yet they can achieve 
graceful effects. They are simply lines, either horizontal or, less 
often, vertical. 

Yet, as we've seen in the previous chapter, lines are potent 
graphic devices. They can lead the eye in a certain direction and 
also mark off separate zones, compartmentalizing the page. Hence 
rules are key tools for controlling page layout. 

Their width can vary substantially, from hairline to thick black 
bars. They also come in certain styles, such as Oxford. Oxford rules 
have parallel thick and thin lines and can come with the thick line 
above or below the thin. Rules may also be thin parallel lines of 
the same size or dotted lines. 

How do you choose? In general, the rule should jibe with the 
material nearby. If you have thin line art, a hairline rule might 
work. If the rule sets off sans serif, you should use single-line rules 
about the same size as the width of the type. If the rule adjoins Ro­
man type with a fair amount of contrast, you might favor an Ox­
ford rule, to resonate with the contrast in the type. 

Dotted lines, however, have the effect of letting air through 
them, of reducing the set-off effect. They are thus useful for situa-
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tions where you want to separate parts of the page, but not t~o 
drastically. 

Rules are typically used in these situations: 

Page rules. These are commonly laid horizontally across the 
page, at the top or bottom. Why? It instantly gives unity to a page 
and can add a pleasant tension. 

For instance, if a page has two columns, a page rule goes far 
toward joining them into a conceptual whole. 

The page rule is almost essential if you have wide outside mar­
gins. Why? The answer involves the page number. You can't really 
place it above or below the text, since it would look awkward and 
suggest inadvertence. White space would stretch bare and uninter­
rupted from the prose all the way to the edge, as though someone 
had printed on the wrong size of paper. On the other hand, if you 
place the page number far away from the text, alone in a distant 
corner of the page, you strand it in a sea of white. 

The solution is fast and elegant: run a rule from the castaway 
page number across the entire page. The transformation is remark­
able. Suddenly the layout has both coherence and a pleasing ten­
sion. The white space seems deliberate, a generous overflow. You 
not only bring the page number into the design but the white space 
as well. 

Callouts. Generally, you place a rule the width of the column 
above and below the readout and indent it on both sides. The rule 
effectively separates the quote from the material above and below, 
allowing the reader to skip it easily. At the same time, it calls atten­
tion to the quote. 

For callouts, you can, of course, simply deploy single rules 
above and below, but Oxford rules are often more effective. If you 
use them, place the heavy bar farther away from the quote, that is, 
on top above and on the bottom below. This arrangement leads the 
eye into the quote between. 

Column separators. Vertical rules can also separate columns, 
so the eye doesn't pass across from one to the other. Usually these 
rules are hairlines, but you can make them larger if they're light 
gray or if they serve some special purpose. In general, however, 
you want to be delicate here and avoid breaking the page into ver­
tical blocks. 

Sections. Rules can also separate discrete sections of the page, 
and thereby help organize it. For instance, rules inserted halfway 
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across the column between certain crucial points can both empha­
size and separate them. Dotted rules may work especially well 
here, if you don't want the separation to be too disjunctive. 

Chapter headings. Rules also work well beneath chapter num­
bers and titles, and, in general, to set display text off from body 
text. 

Lead-ins. Rules effectively mark off a lead-in from the heading 
above and text below. 

Other uses. Rules are versatile elements, and in general you 
should feel free to use them where they can unite diverse element~ 
of a page and make it look cleaner and tighter. 

Rules are lines. Link several lines at 90-degree angles, how­
ever, and you get another useful entity: the border. 

Borders 
Borders come in two broad categories: boxes and decorative bor­
ders. Of the two, boxes are more common by far. 

Boxes. A box is a rectangle pulled out by your software, nor­
mally to surround and set off special material. It almost always acts 
to separate this material, but it has other functions as well. It em­
phasizes it, calling it to the attention of the eye, as if to say, "Here! 
Look at this!" It also livens up the page, by providing variety and 
reducing the page to more immediately comprehensible blocks. 

Boxes are very useful for surrounding tables, charts, sidebars, 
photos, and line art. They add zest both to the page and the items 
they enclose, which in themselves may be rather dreary. However, 
beware of them where you really don't want the isolation they con­
fer. They're not appropriate, for instance, around callouts, since 
callouts relate directly to prose on the page. 

Boxes come in many varieties. In general, as with rules, you 
should deploy the kind that best mirrors your content. Hence, a 
box with rounded comers tends to go with rounder fonts like Book­
man and Avant Garde, or pie charts, or pictures with curves like 
portraits. Square comers more often accompany angular fonts like 
Times, bar charts, or rectilinear pictures like those of cityscapes. 

Note: Follow this dictum only if the result appeals to you. If 
you have a table or bar chart or sidebar in Times and you think a 
rounded box looks good, use it. Goblins won't descend. 

You may also find "boxes" shaped like circles or ovoids. These 
are mainly used to achieve special effects with pictures. For in-
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stance, an ovoid around a portrait creates a cameo effect. In gener­
al, avoid circles around text, tables, and charts. 

Most layout programs let you stylize boxes, and you can pretty 
much match style to the effect you want. For instance, a shadowed 
border gives depth to the enclosed area, adding a dark, detached 
layer behind it. As a result, it both emphasizes the material and re­
duces the formality. 

Decorative borders. Decorative borders are mainly available 
on clip art and should be reserved for special circumstances. 
They're often elaborate, even gaudy, and call attention to them­
selves much more than normal boxes. You can use these patterns 
for rules, boxes, or to surround an entire page, as if you want to 
create an impression of floral ornateness. 

Lists 
There are several purely typographic ways to break up a page, and 
of these, lists are among the most common. They convey infor­
mation quickly in summary form, and they may attract the eye 
before it actually travels down through the prose. 

You can mark off list items in two main ways, according to 
your purpose: 

Bullets. Bullets are: 

•Repeated graphic devices 
•Often solid black circles (option-8 on MacWrite) 

Bullets are particularly useful for strings of items of roughly 
equivalent value. They provide quiet emphasis for each one and 
can tolerate paragraph-length descriptions. If description goes on 
too long, the list loses its identity as a list and subheads should re­
place the bullets. 

Numbers. Numbers (or letters) perform two services: 

1. They show rank order. 
2. They tally items up. 

In the first capacity, they indicate priority-of importance, 
chronology, or some other factor. In the second, they stress the 
sheer number of items in the list. For instance, if you're arguing in 
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favor of sending men to Mars and wish to highlight the multiplicity 
of reasons for doing so, you would generally number them rather 
than bullet them. 

Note that when at lea$.t one item in a list forms a complete 
sentence, you should follow each list item with a period. If the 
items are all single words or incomplete sentences, no period 
should follow. 

A list can extend all the way across the page and otherwise 
look very much like normal prose. However, you can also call at­
tention to it with the layout. For instance, if you have one column 
of text, you can provide two columns for brief bullet items. Or you 
can place the list to the left and exploit the white space. Indepen­
dent lists also work well in ·boxes. 

Subheads 
Subheads pepper the text to break it up, to help organize it, and 
often to pique the curiosity and lead the reader on. They're usually 
set in type that differs from the body text, often boldface or sans 
serif. Most subheads are one line deep and use almost telegraphic 
prose. You can use more than one line, but if you do, try not to 
vary the number of lines too much. In general, subheads should be 
brief and evocative, not explanatory. 

Callouts 
Callouts (or readouts or pull quotes) are usually quotes from the text. 
They need not be, however. They can resemble epigraphs and cite 
thoughts of others to illuminate the work. 

Callouts can appear in several places. Usually they appear 
within a column, breaking it up, or nearby in a wide margin, lend­
ing asymmetry to the spread. If you're quoting the text, you should 
place the callout before its actual occurrence there to avoid anticli­
max, but you need not place it too far ahead. The reader usually 
scans the callout long before he or she actually reads down to it. 
You may have to add these tidbits last, so you know exactly where 
they are to go. 

Like good quotes, callouts should be pithy. Garrulous pull 
quotes disrupt the column and make the reader wonder what 
you're trying to say. 
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Drop Caps 
A drop cap is the enlarged first letter of a segment of prose. This 
item goes back to the scribes of the first century, who used it toil­
luminate manuscripts that may have taken many months to copy. 

Historically, drop caps have shown iaroque detail: vines and 
flowers twining about, cherubs peeking out from behind a letter­
form, Adam and Eve interviewing the serpent in the Tree of 
Knowledge. There's really no limit to specifics you can apply here, 
and the reason is that the letter does not have to be comprehensi­
ble. The reader can usually deduce it from the rest of the word. 

Most drop caps today are more subdued, but they are still a 
good way to announce the start of a section and spice up the page. 
They generally work best in a contrasting typeface, such as sans 
serif. However, there's only one basic rule: Always follow up with 
several words in normal size but capital letters; it eases transition. 
A drop cap followed by lower case letters creates a rather sudden 
break. 

There are several kinds of drop cap: 

Raised Initial. You can simply inflate the letter from the baseline. 
It rises above the prose and works simply and effectively (see 
Figure 12-8). You should make it at least twice the size of the 
prose, preferably more, though not so large that it opens up a 
great gulf of white space. This kind of drop cap is the easiest to 
make on Macintosh software. However, it can cause problems. 
For instance, a P or V may create a serious need for kerning 
which some programs are unable to handle. Be careful, too, that 
automatic linespacing doesn't shift to accommodate the giant 
letter. 

Basic Drop. You can also drop the capital into the text below. This 
approach and its variants are the most common, hence the name 
drop caps. It too can look attractive, but once again you must 
move the text to fit the shape of the letter (see Figure 12-9). 

Boxed Drop. You can sidestep the problem of fit by placing the 
capital letter in a box (see Figure 12-10). Once it's inside, you 
can play around with the box itself ~nd add border elements and 
patterns to the white space inside, creating a little object of art. 
You can go farther and wind vegetation around it or otherwise 
make it exceptional. 
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Figure 12·8. Raised Drop Cap 

IT WAS THE BEST of times, it was the worst of times, it was the 

Figure 12·9. Basic Drop Cap 

1r 
0 BE OR NOT TO BE, that is the question. Whether 
'tis nobler in the mind to suffer the slings and arrows 

of outrageous fortune, or to take arms against a sea of 
troubles, and by opposing, end them. To die, to sleep, 

to sleep perchance to dream. Aye, there's the rub! 

Figura 12·1 o. Boxed Drop Cap 

[ID 0 BE OR NOT TO BE, that is the question. Whether 
'tis nobler in the mind to suffer the slings and arrows 
of outrageous fortune, or to take arms against a sea of 
troubles, and by opposing, end them. To die, to sleep, 

to sleep perchance to dream. Aye, there's the rub! 

Elements of Layout 

Margin Drop. You can also place the drop cap in the margin, com­
pletely outside the text block. It doesn't look as good, but it may 
be simpler to execute. Avoid the margin drop if you have too 
many initial letters like A _and W that angle away from the text. 

If your software lacks a drop-caps feature, you may do best by 
~eating them as graphics. In the latter two cases, you can simply 
create blocks for graphics right on the page. "Vith the first two, you 
may be able to exploit wraparound. 

There are two final considerations regarding these devices. 
First, they are commonly used to start large sections like chapters, 
but they can also commence shorter segments. If you use them in 
the latter context, avoid placing them at the top of the page. The 
reader would think they introduce a new chapter. 

Second, watch out for regular patterns they may create. If you 
have several per page, they should appear scattere~ and random. 
Otherwise, again, the reader may notice the pattern, thwarting the 
subliminal purpose of the drop caps. 

Dingbats 
Dingbats are ~ittle pictorial devices-arrows, stars, pencils, pointing 
fingers, triangles, snowflakes, squares, and other symbols. You can 
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find them on clip art, but they also appear in Zapf Dingbats, which 
is a font and hence at your fingertips. 

The watchword here is simplicity. Dingbats come in such pro­
fusion and sometimes just seem so cute that it's hard to resist toss­
ing them in everywhere. In fact, you should use them discreetly or 
your layout will seem self-indulgent. In particular, don't use ding­
bats to fill up white space, since you could well be replacing a 
powerful graphic element with jingle bells. Dingbats should serve a 
purpose. 

But they do have many legitimate uses: 

Bullets. Bullets need not be tiny black circles. They can be squares, 
asterisks, or dashes, and dingbats expand the range dramatically, 
allowing arrows, circled numbers, stars, checks, and almost any­
thing else. Zapf Dingbats alone allows a remarkable range of 
bullets. 

Punctuation. You can achieve fancy effects with stylized exclama­
tion points or quotation marks. 

Numbers. Circled numbers, either white on black or vice versa, can 
add a touch of elegance to your work. 

Miscellaneous. Symbols like the club from a deck of cards, a Val­
entine's heart, a star of David, scissors, a telephone, and the nub 
of a pen can have an array of decorative uses. 

Dingbats are remarkably versatile and you should never forget 
them. At the same time, however, you should march into this terri­
tory carefully. Dingbats are fun, but they aren't always dignified. 

Screens 
A screen is a shape shaded gray. It can have any contours you like 
and serves as a powerful graphics element, uniting different areas 
of the page or emphasizing sections of it. For instance, you can fill 
a box with a light screen to emphasize its contents. This technique 
is common and effective with sidebars. You can also create a dark 
screen and place letters inside it in white, in reversed type. If you 
do so, be sure the letters are relatively. large and thick, or the screen 
overwhelms them. Sans serif is a good choice for reversed type, as 
the dark background tends to make serifs disappear anyway. 
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Pictures 
The pictorial layout is a somewhat different creature from the text 
layout. It's the sort of thing you usually find in display ads, and its 
purpose differs greatly from the text layout. 

A text layout usually centers on text, though it may have plen­
ty of graphics. Books are the extreme text layout, but most pam­
phlets, newsletters, reports, and so on, also involve text layout. 
They exist to impart fairly lengthy information. 

Pictorial layouts, however, are usually one-page or less. 
They're also butterflies, seeking to attract attention through beauty, 
special startling effects, or other devices. The considerations which 
apply to text layouts may be totally inappropriate for pictorial ones. 
For instance, ragged left, almost unheard of in text layouts, may 
work fine in pictorial. 

A striking photo or picture quickly draws the reader's eye, but 
you may wonder ·what makes a picture striking. Part of the secret, 
of course~ lies in the content of the photo, but you can often add 
drama to it by cropping. 

Cropping is to photos what editing is to text. You elide the sur­
plusage. Most layout programs have a cropping tool, but the art 
here lies in determining what's extraneous and what isn't. For in­
stance, photos almost always improve if you crop out excess mate­
rial lying all around the main feature of interest, since this act 
clarifies the focus. You should also cut anything that distracts the 
eye from the heart of the photo. However, you may want to keep 
apparently irrelevant material on the "directional" side of the pic­
ture. For instance, you can give real impact to a picture of an indi­
vidual gazing out over countryside by including a great deal of the 
countryside, far more than you need to convey the key idea. 

Be sure to give the picture in your layout a frame: It needs 
enough white space to set it off from the rest of the layout. This ca­
veat can be especially important with runaround type, where you 
make text follow the contours of the image. It's easy to get en­
tranced with this power and follow the graphic too closely. 

Captions 
Captions (or cutlines) are the brief pieces of prose that describe a 
photo or piece of artwork. Captions should be closer to the graphic 
than to the surrounding text, to avoid mixups. They often appear in 
italics, especially if there's danger of confusing them with body 
text. They can also work well in sans serif. 
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Captions normally lie beneath the graphic, where they either 
extend to its full length, as though justified, or line up to its left or 
right edge. Captions that poke beyond the graphic look clumsy. 

You can also place captions to one side of the picture, at its 
upper left or right, for more striking effect. If the graphic lies at the 
bottom of the page, you may also put the caption atop it. 
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The Final Product 
. An artist may make many sketches and versions of a painting 
before setting down to apply the final oils. In a sense, most of this 
book has likewise been pure design. With computers, you don't ap­
ply ink to paper until the final stage: output. 

It's a vital stage. Yet, for reasons noted, it has tended to lag be­
hind the rest of the technology. Printers still may not give you the 
output you want at the price you want. But the field is changing 
fast, and new breakthroughs could happen at any time. 

Let's begin with the printers commonly used with black-and­
white output. The main categories are the daisywheel, dot-matrix, 
thermal-transfer, inkjet, and laser. 

Dalsvwheel 
The daisywheel printer is like a computerized IBM Selectric. It 
works by driving a metal spoke with a bossed character against a 
ribbon, which in tum presses ink onto the page. As with the 
Selectric, the letters and numbers reside on a single piece of steel 
called an element. However, the element in the daisywheel resem­
bles, instead of a bumpy globe, a hub with flat spokes sticking 
out-a daisy. (This printer may also have a cup-like element, in 
which case it's called a thimble.) The daisywheel printer is some­
times called a letter quality printer because it yields clean, solid 
characters sufficient for the most important correspondence. It also 
lets you change the element to gain different fonts. 

But the daisywheel has major drawbacks: 

•It's extremely slow, the koala of computer printers. 
•The printer makes an urgent buzzsaw whine, since the bossed 

spokes are constantly striking the paper. 
• It yields wretched graphics or none at all, since its basic units are 

usually alphanumeric characters. 

The daisywheel printer really isn't a factor in Macintosh 
graphics. 
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Dot-Matrix 
The prince of the non-laser printers is the dot-matrix (or impact dot­
matrix) printer. This popular, versatile machine still drives a ribbon 
against the page, like the daisywheel, but instead of striking with 
preformed characters it uses pins. The pins make tiny black dots 
that the eye fuses into whole images. Since the dots can accumulate 
into any shape, the printer renders letters, fonts, styles, and graph­
ics with equal ease. 

A drawback to the early dot-matrix was quality. The first dot­
matrix printers came with printheads of 7 or 9 vertical pins. A 9-
pin printhead yields a resolution of 72 dpi. This was tolerable, but 
the dots were still visible and letters look porous. An improvement 
occurred when printers began making two passes over a line, one 
to the right and a second, slightly shifted, back to the left, filling in 
the gaps. Such 144-dpi printers are called near-letter quality print­
ers, and they heighten the caliber of text even as they slow the 
speed of printout. But the real advance came with the 24-pin head, 
which yields characters whose dots are indistinguishable except on 
close examination. These are called virtual-letter quality printers. 

Except in the matter of letter sharpness, the dot-matrix hum­
bles the daisywheel in every way. It's significantly cheaper and 
faster, and its versatility matches that of bitmapped computers. On 
the other hand, it makes the same irritating noise as the daisy­
wheel. The ImageWriter is an example of a dot-matrix printer. 

Thermal Transfer 
The ther1Jlal-transf er printer exploits the pointillist principle of the 
dot-matrix, but it creates the dots differently. Instead of driving 
pins into a ribbon, it briefly heats them. The heat is transferred to a 
special ribbon, with waxy ink that melts onto the page. These ma­
chines have several noteworthy virtues. One is silence. They make 
a slight whir as they print, but nothing like the banshee cry of the 
daisywheel and dot-matrix. Another is price, often surprisingly low. 
A third is the quality of its color, which almost glows. 

Unfortunately, the thermal-transfer is also a prodigal. It eats up 
$6 ribbons extremely fast, so you would be buying them constantly. 
A black-and-white ribbon might last for 75 pages of text, while a 
color ribbon used for graphics (which require more ink) might be 
gone after 8-15 pages. In addition, most thermal-transfers require a 
special smooth, shiny paper. 
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InkJet 
Inkjet printers work by firing bursts of ink at the page through tiny 
nozzles. They're swift, silent, and they render graphics very well. In 
addition, since they have· few moving parts, they tend to last long­
er. However, they generally cost more than dot-matrix printers, 
though the price of a few has dropped to $500. In addition, the ink 
can dry in the spouts and clog them if you don't use the machine 
for a period of time. 

Laser Printers 
The laser printer goes back to Stanford University in the late 1970s. 
Professor Donald Knuth had just written the typesetting program 
TEX, and people were trying to figure out uses for it. Some theoreti­
cians felt it could help develop inexpensive page proofs without re­
sorting to a phototypesetter, though of course it would need a 
special kind of printer. 

Then Canon announced an inexpensive print engine using la­
sers. It wasn't a complete printer, but several Stanford engineers 
believed they could build one around it and exploit TEX more fully .. 
By 1980, they had invented the first model, the forebear of all laser 
printers today. 

In January, 1985, Apple announced a high-grade model for the 
desktop: the LaserWriter. This machine came with plenty of ROM 
and RAM, increased speed, lower cost, and, perhaps most impor­
tant, the PostScript page description language in the printer's ROM. 
Since then, laser printers have proliferated. 

These devices can print up to one page per eight seconds. 
They do graphics as well as text, can be almost silent, and render 
fine detail: 300 dpi or more. Moreover, they can smooth out the 
steps in curves, rotate prose, perform gradient fills, and offer nu­
merous other qualities unthinkable on conventional printers. 

What accounts for this rich capacity? First, let's look at how the 
laser printer gets its keen resolution. Laser printers use an electro­
magnetic approach that exploits the principle that positively and 
negatively charged particles don't mix. 

Laser printers start with a print engine. This device works by 
shooting a laser beam at a rotating drum. A laser beam can be ex­
ceptionally thin and fine; as the beam creates the image, that fine­
ness makes for high resolution. 
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The laser beam has an interesting effect on the drum. The 
drum has a negative charge, and the beam neutralizes it wherever 
it strikes. These neutral areas quickly fill with an inky powder 
called toner, which also has a negative charge. The toner is repelled 
by the rest of the drum and driven into the neutral zones. At this 
point, there's an image of the page on the drum. 

The drum continues to rotate and soon touches a piece of pa­
per with a positive charge. Since positive and negative attract, the 
toner jumps from drum to paper. The paper slides between hot 
rollers, and the heat and pressure fuse the toner to the page. A mo­
ment or so later, the printed paper emerges from the machine, still 
a bit warm. 

Most Macintosh programs have drivers that support PostScript. 
PostScript is used in the LaserWriter and numerous other laser 
printers, as well as the phototypesetters. There are several non­
PostScript machines, and most of them are much cheaper than the 
LaserWriter. However, the latter machine not only works very well 
with the Macintosh but remains among the best around regardless 
of the computer driving it. 

When you first turn it on, the laser printer warms up like a 
copier, conducts a self-test, and emits a slip of paper showing the 
number of pages the machine has printed so far. It's important to 
keep track of this data, since you should change the cartridge about 
every 2,000 to 3 ,000 copies. 

When the Macintosh commences to print a file on the Laser­
Writer, it first resorts to two pieces of system software: Laser Prep 
and the LaserWriter Driver. 

The Macintosh downloads Laser Prep into the LaserWriter, 
where it blows reveille for the printer and tidies it up for work. La­
ser Prep augments PostScript, helping it mimic the QuickDraw 
routines found in the Mac's ROM. Since all Macintosh software is 
compatible with QuickDraw, Laser Prep makes it compatible with 
the LaserWriter as well. 

Laser Prep also contains a dictionary of shorthand PostScript 
commands. The LaserWriter Driver translates code and moves it to 
the LaserWriter, where the printer can look up the translation of 
the shorthand in the Laser Prep dictionary. This ·approach helps 
shrink the size of applications, since it lets them use the shorthand. 

As part of this service, Laser Prep sets up a scheme within the 
LaserWriter for naming PostScript fonts. The LaserWriter Driver 
thus sends the fonts to the machine, and if it recognizes them (that 
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is, if they're in the printer's ROM or if you've downloaded them 
into its RAM) it prints them out. 

If the machine doesn't recognize the fonts, the LaserWriter 
Driver performs a little trick of its own: It makes substitutions. For 
instance, if you try to send a document in New York, it turns, it into 
Times, which New York resembles. If the LaserWriter Driver can't 
make such a correspondence, it simply prints out the bitmapped 
information from the screen as if it were a plain graphic. 

You can easily hook the LaserWriter up with an AppleTalk 
cord to the printer or modem port. Thus, you can connect both a 
LaserWriter and an ImageWriter to the computer at once. When 
you're ready to print, you pick the one to use by selecting the 
Chooser desk accessory and clicking the proper icon. Then you se­
lect Print in the File menu and Font Substitution in the ensuing box. 
Font Substitution induces PostScript to replace those fonts on the 
display with its own. If you don't click Font Substitution, you wind 
up with characters as you see them on the Macintosh screen, at 72dpi. 

Of course, you aren't limited to the LaserWriter. There are nu­
merous other laser printers available, most of them less expensive. 
But few can match the LaserWriter, and all feel its cool, broad 
shadow. 

Phototvpesetters 
One of the many boons of PostScript is that it doesn't restrict you 
·to laser printers, but it lets you work on numerous other systems. 
Hence, you can take your files to phototypesetters like the 
Linotronic 200P or 300, for printing of high resolution and dazzling 
quality. 

The phototypesetter (or imagesetter) was developed in the 
1930s and first sold commercially in 1946. At first, it simply grafted. 
photo-technology onto the old hot-type model of the Linotype. 
Eventually, however, these machines became computerized. 
They've proved so quick and versatile at setting type that they've 
almost driven the old Linotype to extinction. 

Computer phototypesetters generate images on cathode ray 
tubes (also called CRTs or screens) and pass them from there direct­
ly to photosensitive paper by one of two means. In the first, the 
light passes from the CRT through a lens to a movable mirror; the 
mirror, always shifting, relays the image to its proper pla~e on the 
paper. In the second method, light passes to thousands of pieces of 
fiber optics material, which convey it to the paper. 
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These phototypesetters have great virtues. They work at up to 
1,500 characters per second-that's 90,000 characters per minute, a 
phenomenal speed. They can make 200 fonts or more available at 
any one time, and sizes can vary from 4 to 120 points. They print 
pictures as easily as type, producing high quality output of more 
than 1,600 lines per inch. These machines need less floorspace and 
require much less training than their predecessors, and they can 
take direct electronic input. 

The two phototypesetters you're most likely to use are the 
Linotronic 200P and 300. (You may also see the LlOO, an earlier 
1270-dpi model, which the faster 200P replaced.) Both use a heli­
um neon laser and a 68000 microprocessor, the central chip in the 
original Mac line. They're also compatible with PostScript. The 
200P prints at a resolution of up to 1,693 dpi on film or paper 
which can be 12 inches wide. The Linotronic 300 prints up to 2,540 
dpi. These devices cost from about $30,000 to $58,000, far too 
much for most individuals to buy. However, you can rent these ma­
chines at service bureaus, as you'll see below. You may also run 
into similar phototypesetters by Compugraphic, Varityper, and 
Monotype. 

Phototypesetters differ in several ways from laser printers. 
They don't use dry toner but rather create the final copy photo­
graphically. This process entails chemical development and simply 
takes a little longer. In addition, since they print far more dots, they 
need extra time to position them. Hence, an average page without 
bitmapped graphics can take from three to five minutes. 

Moreover, their output looks somewhat different from that of 
laser printers. It's more extreme: Phototypesetters print light grays 
lighter and dark ones darker. Hence, it's a good idea to avoid, say, 
90-percent screens on a phototypesetter, as they would print pure 
black. You want to hew much closer to 50 percent. What causes 
this difference? It's a visual illusion caused by the dot density. The 
machine prints dots in the same ratio as the laser printer does, that 
is, a 90-percent screen still has 90 percent black dots. But because 
they're tinier, they appear to fuse together more tightly. At the 
same time, dots in a IO-percent screen are sparser and vanish more 
readily. 

Another difference involves the hairline-the thinnest possible 
line you can demand. On the Macintosh screen, a hairline is 1/72-
inch wide, the width of a single pixel. On most laser printers, it be­
comes 1/300 inch, and on the Linotronic 200P, 1/1693 inch. The 
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latter is almost invisible, so if you want to do hairlines on a photo­
typesetter, you may want to make them a little thicker. 

The machines also print grayscale much, much better. Why? 
As we noted at the outset of this book, a grayscale monitor sug­
gests much sharper resolution than black-and-white, because for a 
monochrome monitor to achieve the same effect, it would require 
exceptional finesse. The phototypesetters actually provide such res­
olution in the realm of print. We can see more clearly how it all 
works by looking at. the halftone. 

Printing Photos: The Halftone 
To reproduce photos, you have two choices. You can scan them, 
place the digitized image in the document, and print. Or you can 
simply give the photo to the offset printer, who then creates half­
tones from them and strips them directly into the plate. What are 
halftones? 

Normal photographs show what printers call continuous-tone 
images. That is, they convey shades of light and dark by varying 
the amount of chemical reaction on the negative or print, showing 
a near-total range of grays. But early printing was an either/ or af­
fair. Printers inked a part of the page or they didn't, and they 
needed an either/ or technique to reproduce photographs as well. 
Hence, in the nineteenth century most graphics were rendered by 
photoengraving-essentially line art-which conveyed the essence 
of the picture but not the full-flesh life of it. 

The halftone was a major breakthrough in the printing of pic­
tures. Invented by Stephen H. Horgan, it debuted in the New York 
Daily Graphic on March 4, 1880. The paper printed a halftone of 
shacks atop some snowy rocks called "A Scene from Shantytown." 
It proved a sensation. 

The halftone is basically a photo of a photo, shot through a 
screen. The result is an illusion, in some ways like that of the Mac­
intosh screen. The halftone, too, employs a grid of evenly-spaced 
dots. However, instead of simply varying their number, it varies 
their size. In dark gray areas, the dots grow so large they overlap, 
crowding out almost all the white. In off-white areas, the dots 
shrink almost to pinpoints. 

Like computer screens, halftones differ in their sharpness, or 
resolution, and again the difference is a matter of dots per inch. The· 
denser the dot grid is, the finer the picture. With halftones, the 
fineness of the screen determines resolution. A screen with 85 lines 
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of dots per inch yields a resolution of 85 lines per inch, or lpi. Gust 
think of lpi as dpi, and you won't be confused.) 

Most newspaper photos use halftones with 65 or 85 lpi. You 
can see the dots easily, though you don't notice them at a casual 
glance. Newspapers emphasize fast delivery of news to readers and 
use a coarse wood-based paper that would make denser dots run 
together. Magazines, on the other hand, stress quality over speed 
and use better paper. As a result, they generally have screens with 
120, 133, or 150 lpi, or even more, and their pictures are much fin­
er. Top quality printing allows halftone images of up to 300 lines 
per inch, a resolution so fine the dots virtually disappear. 

For the highest quality reproduction of photos, it still makes 
sense to go to an offset printer, for halftones of the photograph, 
and then strip it into the rest of the page. It's also usually cheaper. 
Computer technology is advancing in this area, but it hasn't fully 
arrived. 

Of course, the difficulty with this approach is that you leave 
the desktop. For smaller runs and less formal documents, what do 
you do? 

You can resort to digital halftones. PostScript sends signals to 
the printer to create halftones, or rather halftone substitutes. Laser 
printers cannot render real halftones, because they can't vary the 
size of the dots-they can only aggregate dots in different numbers 
to mimic halftones. But phototypesetters can give you halftones. 
What's the difference? 

It's a matter of resolution. With laser printers, the resolution 
isn't high enough. Here's how the laser makes halftones: It first 
sets aside a series of squares made up of dots. If the square mea­
sures 4 X 4 dots, there are 16 places for dots, and 16 possible 
numbers of dots per square. Hence, you can get 16 levels of gray. If 
you now expand the square, you get a greater number of grays but 
less resolution. Why? The larger the square, the fewer squares on 
the page. A 4 X 4 cell yields 75 lpi, newspaper resolution, but only 
16 grays. A 6 X 6 square gives 50 lpi, which is noticeably grainy, 
but 36 grays. An 8 X 8 cell produces 37 lpi, an extremely coarse 
resolution, but 64 possible grays. 

In general, of course, you should choose the combination that 
best suits your purpose. But if the image has fine detail and little 
contrast in shade, it would probably look better with high resolu­
tion and a low number of grays. 
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Plainly, the key limitation here is the 300 dpi. As the dpi of 
the printer increases, digital halftones become more feasible. At the 
level of the phototypesetters, the problem almost vanishes. An 
LlOO with a dpi of 1,270 permits halftones of 133 lpi and 92 grays, 
good enough for a great many purposes though still slightly inferi­
or to traditional halftones. An L300 with 2,540 dpi allows 150 lpi 
and 256 grays. 

Printers are currently in the works to render grayscale directly 
by varying the size of dots. Moreover, some companies are at work 
on thermal-transfer printers that actually vary the intensity of gray 
of each dot. These machines remain on the cutting edge so far, but 
it could be that fairly soon they'll become one more tool on the 
workbench of the graphic artist. 

Color Printing 
Then there is color. Color printing is far more complex and difficult 
than black-and-white or even grayscale, which just involve the 
presence or absence of ink. Color entails at least three different 
kinds of ink added together. 

It's also impossible to get true color correspondence between 
the screen and printout. Why is there no WYSIWYG? For one 
thing, color printing involves a different color scheme than color 
monitors. As we noted at the outset, RGB monitors work by mixing 
red, green, and blue; but most printing works by mixing yellow, 
magenta, and cyan (and usually black). There are thus inherent 
problems in translation. 

Moreover, the image on the screen ultimately defies pinning 
down, so we're forever somewhat uncertain of the material from 
the start. For instance, you can easily increase the screen's bright­
ness but the image on paper is fixed, and hence some differences 
creep in no matter what happens. 

Finally, there's the problem of resolution. To match the 300 dpi 
of the black-and-white LaserWriter, say, a color printer must have 
far greater resolution because it uses dithering. It creates colors by 
placing varicolored dots next to each other and letting the eye fuse 
them together. Hence, one dot of color actually needs several dots 
to create it. (It's analogous, in some ways, to the dots each pixel on 
a computer screen needs to render color.) 

Currently, as with grayscale halftones, the more colors you 
wish to print, the more dots per color you need to create them, and 
hence the more resolution you lose. Thus, a 300-dpi color printer 
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does not give at all the same resolution in color as in black-and­
white. The film recorder offers one way out of this difficulty, but 
it's a fairly specialized machine. Let's look first at the printers. 

Dot-Matrix 
Impact dot matrix printers can render color by providing different 
bands of color on their ribbons and making several passes. For in­
stance, the ImageWriter II uses a color ribbon with blue, red, yel­
low, and black stripes. It can print only seven colors-a meager 
palette-and hence is none too accurate. For instance, where the 
color onscreen is, sa·y, magenta, the printer yields· a dark pink. It 
prints at 144 dpi and can extract color from the most basic Macin­
tosh model because the original QuickDraw provided for seven col­
ors (blue, cyan, green, magenta, yellow, red, and black), with the 
nonblack colors appearing as white onscreen. You can create other 
colors as well, with programs that do dithering such as MacDraw 
II. Color ribbons may not last long, since darker ink tends to rub 
off the pins onto the yellow stripe, and, if you don't use color 
much, you may use up the black band before the others. However, 
dot-matrix printers are relatively inexpensive, as is the ribbon price 
of about $15. The ImageWriter LQ renders up to 216 dpi, and its 
ribbons cost about $30. 

Dot-matrix color printers are most useful for adding one-color 
highlights to documents or printing in monochrome, such as all 
blue. The narrow range of colors and low resolution limit these 
machines's use for most other purposes, such as color proofs, and 
they don't print well on transparent film. 

Thermal Transfer 
Most of the color printers now used are thermal transfers. They 
generally have resolutions of 200-300 dpi and employ dithering to 
achieve their spectrum. They yield proofs of sufficient quality for 
slides from a film recorder, though dithering makes them inappro­
priate for camera-ready art. However, they require a special slick 
paper, which may make them unsuitable for some jobs. They can 
still be used for some low-volume publishing. They issue a page in 
about a minute, and cost around 50 cents per page. 

Some of these machines support· PostScript. The QMS Color­
Script 100 does, and since it yields. 300 dpi, it rivals the Laser Writer 
in black-and-white. It gives fairly good proofs for the phototypeset-
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ters, though because of dithering the colors still don't match. Un­
fortunately, this machine is very expensive, costing around $22,000. 

QuickDraw-based thermals are compatible with a much wider 
range of software, though that situation is changing. The 
QuickDraw machines are also much less expensive, selling for 
around $9 ,000 at the high end. 

InkJet 
Inkjet printers may be the wave of the future. They currently em­
brace a wide range of printers, some equivalent to the ImageWriter, 
others more expensive proofing devices. 

A low-end, color inkjet printer like Hewlett-Packard's HP 
Paint}et can print at 180 dpi, a bit higher than the 144-dpi of the 
ImageWriter II. In general, such machines lack the resolution and 
range of color for proofing or camera-ready art, though they render 
transparencies better than the dot-matrix. Their ink can bleed in 
newsprint, so they normally require a special paper. On the other 
hand, ink does not become contaminated as in dot-matrix ribbons. 
The cost of printing a page is similar to the ImageWriter, and the 
pace is about as slow. 

At the high end, these machines change their nature quite 
pleasantly. They can render color well enough for proofing, trans­
parencies, low-volume publishing, and moderate-quality camera­
ready art. The Iris 3024 from Iris Graphics can even change its dot 
size, a la halftone. It yields up to 300 dpi, and each dot can be one 
of 34 hues. The machine can print on almost anything, including 
cloth, and its output approaches that from high-quality, four-color 
process printing. Per page, it's also very inexpensive. Why hasn't it 
conquered the world? It costs around $ 75 ,000 and weighs 400 
pounds. 

Nonetheless, inkjets seem to offer the best capacity for evolv­
ing into reasonably priced, good-quality color printers, and they 
could be well worth watching. 

Fiim Recorders 
Film recorders offer one way around the bottleneck of color printers, 
since they work by actually photographing the Mac display. These 
shoebox-like machines produce 35mm slides and can yield up to 
4,000 X 2,700 lines on a single slide, a fantastic increase in resolu-
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tion over the Mac screen. Unlike most forms of color printing, film · 
recorders actually improve on the Mac image. 

However, they have drawbacks. It takes a few minutes to cre­
ate each frame, and even then you must process the slide before 
you can actually see it. Since processing may take 24 hours, there's 
a significant delay in feedback. The devices cost around $4,000, 
and slides themselves have limitations. Though you can turn slides 
into photos, the process itself is costly and time-consuming. 

At least one company, Presentation Technologies, has an­
nounced a color transparency camera to work with film recorders. 
This device, which sells for about $900, yields both instant color 
overheads and instant photos, and may well enhance the populari­
ty of film recorders in general. 

Color Separation 
The term color separation actually refers to two distinct processes: 
spot color and four-color process. The first is simpler and easier to 
understand but suffers some severe restrictions. The second is 
harder to understand and to effect, but it yields excellent quality. 

Spot Color 
Spot color separations (also called overlays and mechanical separa­
tions) usually involve the mere addition of one or two colors to the 
printed page. For instance, a red logo printed· in the upper right of 
a page of black-and-white text would constitute spot color. 

These are simple to carry out. To obtain the :red logo, for in­
stance, you would print out the page once (with a laser printer or 
phototypesetter) to show only the black text and a second time to 
show only the logo. Both printouts would be black and white. Then 
you'd pick the colors you wanted from a book of Pantone Matching 
System (PMS) colors, the standard in the field, and trot them down 
to a printing establishment. There, the firm would make two sepa­
rate plates and print out, pressing each sheet of paper first to one 
plate and then the other. 

Spot color is sometimes called custom color, because it works in 
the premixed ink of the color you select rather than creating colors 
by fusing four basic colors. Since the method is simpler, fewer 
things can go wrong with it and it's much less expensive. It does, 
however, restrict you to one or two colors in additon to black and 
white. 
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Four-Color Process 
Four-color process separations are the route to some of the best 
color available. The color photos in slick magazines are usually 
printed with this method, and it can yield virtually any color in ex­
istence, with the exception of a few, like silver, which require spe­
cial dyes. How does it work? 

Intriguingly, this process also relies on the halftone. In fact, it's 
the color equivalent of halftoning. You've seen that halftones can 
capture most of the grays between black and white. In four-color­
process separations, we use four halftones-cyan, magenta, yellow, 
and black (CMYK, with K for black)-and print from each onto the 
same sheet of paper. Why does this work? The halftone for cyan, 
say, can express almost any hue between white and very dark cyan. 
The other halftones can, too. Since each has remarkable range, you 
can mix them in any degree you want and gain almost any color. 

Printed, the colors appear as separate dots in clusters or ro­
settes near each other. The ranks of dots must be angled precisely 
to each other for the effect to work. Otherwise, you get the interfer­
ence patterns called moire, and the viewer senses something amiss. 
Moire appears most often in areas with a substantial amount of 
black (which makes the moire more apparent), in scanned images, 
and in areas of graduated color, such as fountains. 

As you saw earlier, fountains are zones of transitional color 
where one hue smoothly changes into another. The seamlessness 
of a fountain depends partly on the number of hues in the transi­
tion. With a few hues, bands are plainly visible; with enough, the 
change appears flawless. Hence, here you want to optimize the num­
bers of shades or colors you use. Since a low lpi, such as 120, enables 
a greater number of hues, you may want to use it in combination 
with a high resolution printer like the L300. You can also improve 
quality by shrinking the fountain's area, thus thinning the bands, 
and by reducing the range of transition from first color to last. 

Moire can also arise from the sheer inability of the output de­
vice to set the proper frequency. It's often highly difficult mathe­
matically, so the machine makes its own adjustments, which can 
cause the problem. Moire is more common in the lower resolution 
devices, because the higher the resolution, the more likely the ma­
chine can set the correct angles. However, even the L300 at 2,540 
dpi can substitute some angles for those you specify and hence 
raise difficulties. On the other hand, moire is also more common 
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with higher resolution halftones, since these make more demands 
on the machine. The lower lpi's, basically 120 or less, have less 
chance of showing moire. 

These color separations are difficult to do on the desktop. 
There's no desktop printer that renders top-quality four-color sepa­
rations. Those available tend to give you somewhat grainy, jagged 
images. Normally, you take a disk into the phototypesetter, get four 
different halftones (each looking black, but in different patterns), 
and take it to a printer who can do four-color process. 

Draw programs lend themselves best to color separations, be­
cause they specify colors by breaking them down at the outset. For 
instance, red is 40-percent yellow and 100-percent magenta. This 
approach is called a tint build by printers, and the information is 
obviously easy to use to create the separation. 

Tint builds are extremely useful. Among other things, they go 
far toward letting you check color correspondence in proofing. You 
can purchase a book with charts of process color combinations, se­
lect your color, then enter the percentages that yield it. The color 
onscreen will differ, but it's not the important one. 

Some paint programs can perform the same trick, though often 
the final result may look a little different from what you anticipat­
ed. They particularly have trouble separating color scans, and they 
may be prone to moire. As the field advances, the software is im­
proving in this area, but if you have qualms, check the manufactur­
er or software reviews in reputable magazines. 

With true color separation, you may also want to pay some at­
tention to black, especially if you're printing out a great swatch of 
it. Not all blacks look alike. A straight 100-percent black can look 
dull, and if it overlaps with other colors, particularly yellow, its 
color can change. For a richer, shinier black, add small amounts of 

. the other primary colors, about 20. to 30 percent. 
If you're printing with offset, you can specify too much color 

for the page. The result is disaster. When the presses apply excess 
ink to the paper, it can get too wet, dry incorrectly, and even be 
tom by the press. Moreover, the ink can shift from one cylinder to 
the next, and subsequent inks may not stick to the paper. For such 
reasons, if you ask for too much ink, the printer may simply re­
fuse it. 

The Specifications Web Offset Press Publications (SWOP), a 
printing industry group, recommends no more than a total of 300-
percent color anywhere (which results in black anyway), and that 
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only one color be printed solid, usually black. For newsprint, which 
absorbs ink much more readily, the numbers are far lower. In any 
case, you should try to stay as far away from 300-percent as is 
feasible. 

With paint programs, though, you may not even know you're 
exceeding it. There is a process called undercolor removal (UCR) 
which subtracts a particular portion from the three nonblack colors 
to prevent too much inking. The separation utilities program with 
PixelPaint Professional provides this useful capacity, as do a few 
other paint programs, but so far it remains uncommon. 

Shortcuts to Color 
Finally, there are a few shortcuts to color, even with the Mac SE 
and Plus. For instance, several graphics programs let you issue 
color commands for later printout. That is, you can tag shapes on 
the screen as certain colors, and though they still appear in black­
and-white, the program prints them out in color. It's an awkward 
way to work, since there's little feedback, but it's better than 
nothing. 

Kroy Color Plus allows you to apply color after the fact. It can 
color places on the paper where the laser printer or copier has ap­
plied toner. You place a color film sheet over those black areas you 
wish to color; run both through the Kroy processor, which applies 
heat and pressure; and remove. The color adheres to the black 
areas only. If you just wish to spot-color certain areas, you can use 
scissors to cut the film and self-stick notes to hold it against the 
paper. 

Perhaps the least effective method is to purchase toner of a 
different color for the laser printer. Such toner is available, but it 
costs more than black and, of course, still restricts you to mono­
chrome. Instead of black line art, for instance, you would get blue 
or green. 

Essentially, then, it remains difficult to print out high quality 
color graphics from the desktop. As in most parts of the computer 
field, the technology here will almost certainly develop and prices 
will descend, but for the moment they are stratospheric. The tech­
nology is in its infancy. 

Renting Printers 
The phototypesetters are PostScript machines, so they can link up 
directly to the Macintosh via AppleTalk. Thus you could buy one 
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and use it like a LaserWritet. You probably won't-they cost tens of 
thousands of dollars, so there isn't much point in it unless you're 
typesetting constantly. You may even find a laser printer too costly, 
especially if you don't often need its services. What can you do? 

The answer is that you can rent a printer, and very easily. A 
number of typesetting services, copy shops, and print shops are in­
stalling them and linking them to on-site Macs with AppleTalk. 

Despite the general convenience, problems can arise. For in­
stance, you may have to bring your application program along. If 
you own a Mac, you may have to take your system software down, 
too, as the version of the system can matter. In addition, sometimes 
difficulties occur when documents developed on Macs with the 
original 64K ROM are inserted into the firm's Mac Plus or en­
hanced 512K Mac with the newer 128K ROM. The earlier ROM 
uses whole pixel spacing, the newer one fractional, and this distinc­
tion can cause headaches. Be sure to call the firm in advance to 
find out exactly what it can do and what you need to bring. 

If you have a grayscale image, it can easily exceed lMB in size, 
and you may find it takes up too much room to put on a floppy 
disk for transport to the service bureau. If you have lmageStudio, 
you can solve the problem by saving it in a RIFF format, which 
compresses the file. There's also a shareware program called Stufflt 
that compacts files. Otherwise, you may have to split the image 
and carry it down on separate disks. 

A number of shops ask you to appear with PostScript files. You 
can generate PostScript code from Macintosh layout programs by 
pressing Command-F. Straight Postscript files sidestep many com­
patibility problems. 

There are a number of things to keep in mind when renting a 
phototypesetter. A paramount concern is saving time on the ma­
chine. A typical charge is $7 per page, plus a rate of $10 per hour. 
Hence, you don't want to set the device spinning for hours. You 
can use several tricks to minimize time. 

•Use draw programs instead of paint programs, if you can. The 
phototypesetters handle object-oriented graphics like those from 
MacDraw II and Illustrator 88 much faster than bitmapped graph­
ics from MacPaint. 

• Avoid stacked images. If your draw program has multiple, hidden 
layers, the phototypesetter prints only what's visible on top, but 
PostScript still describes all the layers beneath, to no purpose. 
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•Proof the document as carefully as possible first on a dot-matrix. 
Time spent proofing at the service bureau is costly. 

Finally, if you're using a phototypesetter for the first time, by 
all means avoid a deadline rush. Initially, it will be something of an 
experiment. It may take longer to finish than you imagined, and 
you may encounter odd glitches that sabotage the work. Give your­
self plenty of time, and you'll soon be feeling like a master printer. 

Telecommunlcatlons 
You don't necessarily have to take your document physically to the 
print shop to use a phototypesetter or a laser printer. A number of 
firms now provide laser printing and phototypesetting over the 
phone lines. You send the document in over the modem, and the 
firm at the other end prints it out and mails it back. You should 
contact the company in advance to determine rates and method of 
operation, as some documents require special code and formatting. 
The turnaround time in some cases is as short as 24 hours. 

Mass Print Runs 
Mass reproduction is the difference between printing and publica­
tion. The laser printer is, of course, a printer and readily clones 
your pages. But there are a number of reasons why you may not 
want it for your printing needs. 

One is inherent capacity. The laser printer works. fine with, say, 
a few copies of a letter. But it's not designed for mass print runs, 
which may wear the machine down before its time and will certain­
ly use up toner. Hence, if you must print, say, several hundred or 
more copies of your publication, you should tum elsewhere. 

The laser printer is also relatively slow compared to a rotary 
offset press, and if your publication is time-sensitive, you may want 
the heavy-duty approach. Moreover, the laser printer doesn't han­
dle 11 X 17 inch sheets of paper. In general, the laser printer gives 
good templates, but if you want mass runs of any scale at all, you 
should consider other methods. 

There are three main approaches to larger runs: photocopying, 
quick printing, and conventional offset printing. 

Photocopying is the simplest, and requires the fewest extra de­
cisions after you opt for it. It's also approaching the others in quali­
ty, and can prove highly satisfactory. Quick printing is a fast form 
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of the more conventional offset, and both require decisions about 
the kind of plate, paper, and paper feed to use. 

Photocopiers 
The days of the blurred and odorous image from the library copier 
are long past. You can now print documents with photocopiers that 
rival those from offset. It's a startling development, and you can't 
assess it from the everyday copying you may do. You have to in­
vestigate the high end, where some models, particularly Kodak's, 
really shine. 

Copiers have some significant advantages over offset. They are 
exceptionally fast. You can run off a few hundred 200-page books 
in two days, whereas on offset it might take 10 days or two weeks. 
They can automatically collate pages, whereas conventional print­
ers must do so by hand. They can automatically bind pages, either 
side-stitching with staples or creating a perfect binding. They ren­
der halftones almost as well as conventional printers. And the cost 
has dropped fast. For a print run of over 10,000 sheets-fifty 200-
page books-the per-page cost could hover around 2.5 cents, for a 
total of $250, or $5 per book. 

Photocopiers have some disadvantages. Once you print over 
20 ,000 sheets-one hundred 200-page books-they become much 
more costly than offset. They're still generally confined to the 
81/2 X 11 inch format, so they don't let you saddle-stitch 11 X 17 
inch pages. And, though the quality of their print and halftones is 
good, it still can't equal that of an offset press. 

Quick Printing 
Quick printing is a booming field. Quick print shops have sprung 
up like mushrooms in business districts and shopping centers all 
over the country. They're popular because they offer a fast, conven­
ient way to duplicate hard copies. 

Here's how it works, in a nutshell: You bring in an opaque 
original image, such as a flier, that you may have created on the 
LaserWriter. The printer carefully positions it on a camera 
copyboard and takes a picture of it on a special photoemulsive 
plate. This plate has a hardened image area that accepts ink and an 
undeveloped nonimage area that holds water. 

The plate is self-developing, like a Polaroid, and takes only a 
few seconds. Then it goes right to the rotary press. Thus, as the 
name suggests, quick printing can take place while you wait. More-
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over, since the technique eliminates the intermediary of film, it's 
inexpensive. 

onset 
We tend to think of photography as a way to take pictures. It is in 
fact a whole technology, and one of its greatest impacts has been in 
a field ordinarily hidden from the public eye: offset printing. 

Before photography, printers used straight rotary presses. 
These featured two large cylinders that turned in opposite direc­
tions and between which paper slid. The setup resembled two roll­
ing pins squeezing dough between them. The printer strapped cold 
relief type onto the cylinder, which inked and pressed against the 
paper to create the image. It was a bulky, complicated business. 

Photography allowed the fast creation of plates that could be 
wrapped around the cylinder to be used as print masters. They 
proved so effective that they soon came to dominate the offset rota­
ry process. 

Offset printing begins with a camera-ready item, a final im­
age-say, a p~ge from a laser printer. The printer places this page 
on the flat copyboard of a large and elaborate process camera, and 
takes a shot of it. But the plate is much larger than a single page. 
Each page of a book may have a separate piece of film, but the 
plate may hold an entire signature of 32 pages. Hence, the printer 
joins together all pieces of film that go on one plate, a delicate and 
sometimes painstaking operation called stripping. Once the printer 
makes the lithographic plate, he wraps it around the plate cylinder 
of the rotary press, and the press run can commence. 

If you want first-class work or if you have a longer job, offset 
printing is probably best for you. The printer takes your work; pho­
tographs it; strips it to make a plate of 4, 8, 16, 32, or 64 pages; 
and then runs it off. The printer can also insert halftones for you. 

Paper, plastic, and metal plates are all available for the final 
image, and the one you select should depend on the kind of run 
you want. Paper plates are inexpensive but wear out after a few 
hundred copies. Metal plates last much longer but cost more. 

Rotary presses have two kinds of paper feed, and you may 
have to decide between them as well. Sheet-fed presses take paper 
one sheet at a time. Most quick print shops do offset printing with 
sheet-fed presses, which can be relatively inexpensive. Sheet-fed 
presses are best suited for handouts, memos, and others items that 
lack halftones and require no more than several hundred to several 
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thousand copies. The higher-end sheet-fed presses are particularly 
effective for documents that require finer detail, higher quality, and 
better color, such as brochures and posters. Some sheet-fed presses 
print on only one side of the page at a time. Those that print on 
both are called perfecting presses. Perfecting presses are useful for 
printing over 2000 copies of books, reports, newsletters, and maga­
zines. A sheet~fed press may be essential if you're doing embossing. 

The other kind of press is the web-fed press, which prints on a 
long, continuous roll of paper. This device works much faster than 
the sheet-fed press and commonly prints on both sides of the page 
at once, a capacity called blanket-to-blanket. The web press may be 
a necessity if you're using lightweight paper, which tends to become 
ensnarled in the feed mechanism of sheet-fed presses. Web presses 
are also preferable for runs of over 5000 copies. If you've ever seen 
a newspaper printing press, it was almost certainly web-fed. 

Paper 
You may not have thought a lot about paper, but it's a realm all to 
itself. Paper comes in a remarkable variety of textures, grades, and 
weights, and some of the terms used to describe one type of paper 
may mean something else entirely when applied to another kind. 
Fortunately, you don't have to delve too deeply into this somewhat 
confusing field, but you should know a few things. 

First, there are three basic kinds of paper of interest to you: 
writing papers, book papers, and cover papers. Writing papers in­
clude those used for correspondence and for copier machines. Book 
papers are used for almost everything else you read. Cover papers 
are usually thicker and sturdier; they're used to enclose such docu­
ments as booklets and reports. 

Weight 
Weight is a key feature of paper. It's measured by the number of 
pounds a ream-500 sheets-of a standard sheet size weighs. It may 
sound like a simple a·nd useful measure, but in fact it's a maze. 
Different papers come in different standard sizes. For instance, 
writing papers are 17 X 22, book papers 25 X 38, and cover pa­
pers 20 X 26. Hence, 40-weight writing papers are thicker and 
heavier than 40-weight book papers, because the writing papers 
have less area to spread the weight around. 

That's not all. Sometimes the weight isn't measured by the 
ream but by the double-ream, or 1000 sheets. In that case, you 
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usually see the letter M after the figure. For instance, 100M indi­
cates that the paper is SO-weight by the single ream. 

Bulk 
Another vital trait is the thickness of each page, called the bulk. 
Bulk is measured in pages per inch (PPI), so that the higher this 
number, the lower the bulk. If you had paper that was 2 PPI, it 
would be plank-size-extremely bulky. If it were 800 PPI, it would 
have very little bulk. Bulk matters a great deal in book publishing. 
If you have a relatively brief item like The Metamorphosis but want 
to make it look novel-size and charge novel rates for it, you would 
want a bulky paper. Conversely, if you have a hefty book like Tom 
]ones and wish to make it less intimidating and easier to tote, you 
would use a low-bulk paper. 

Opacltr 
Opacity is critical, since it greatly affects quality. There are actually 
two ways to look at opacity. One is by the amount of light pene­
trating the page, which is called the visual opacity. Visual opacity is 
a measure of the likelihood that the next page in the book would 
show through. The other way of looking at opaciy is the depth to 
which the page absorbs ink, or the printing opacity. Printing opacity 
tells you how much of the print on the opposite side of the page 
would show through. You can gain this opacity even with very thin 
paper through special coating. 

In general, you want both kinds, particularly in a book or a 
document with many illustrations. However, opaque paper is more 
expensive than other kinds, and for fliers or other inexpensive pro­
ductions, particularly those with print on just one side, a low opaci­
ty saves you money. 

Finish 
Finish may be the single most important characteristic of all, since 
it controls what you can and can't print on a piece of paper. Over­
all, book papers are divided into two kinds of finish: uncoated and 
coated. The difference between them is that coated papers hav.e 
been processed to absorb very little ink. They're also generally 
somewhat more expensive. Both kinds can be waterproofed for use 
on offset presses, in which case they're called offset papers. 

Uncoated papers come in the following five varieties, in as­
cending order of quality: 
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Antique. Antique papers have the greatest bulk, the roughest sur­
face, and the lowest cost. They sabotage halftones,· since their 
unfinished surface absorbs ink unevenly and causes them to 
blur. In addition, they don't work well with modem fonts. How­
ever, because they resemble handmade papers, they can do quite 
well with oldstyle or transitional fonts. 

Eggshell. Eggshell papers resemble antiques but have a slightly 
smoother finish and lower bulk. 

Machine-Finish. Machine-finish papers are passed between pol­
ished steel rollers, a process called calendering (with two e's). 
Calendering gives the papers a smoother finish and lower bulk 
than eggshells, allowing them to accept medium-grade halftones. 
It also tends to leave one side of the page a bit smoother than 
the other. Machine-finish papers are commonly used in certain 
magazines and books. 

English Finish. English finish papers employ clay fillers, which 
were originally brought over from England. They have a smooth 
surface, don't absorb ink deeply, and are suitable for the finest 
halftones. However, they're often more expensive than the 
cheaper coated papers, and thus are falling from favor. 

Supercalendered. Supercalendered papers receive a second calen­
dering from the smoothest possible rollers and are the highest 
quality uncoated stock available. Like the English finish papers, 
however, their price is costing them popularity. 

Coated papers are generally superior to uncoated. All of them 
are covered with a layer of fine clay, which is supercalendered to 
the page. This clay stops ink from migrating into the paper fibers 
so that it remains on the outmost surface, creating a fine, dense im­
age. They generally come in four categories: 

Film-Coated. The least expensive type, film-coated papers have the 
clay applied at their origin, within the papermaking machine. 
This approach reduces the brilliance. of the coat, so you can easi­
ly mix halftones and text, the latter of which can be hard to read 
on brighter papers. 

Conversion-Coated. Conversion-coated papers receive one coat in 
the papermaking machine, like the film-coated papers, and a sec-
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ond one of higher quality later on. They can be treated to yield 
either a glossy or a matte (that is, lusterless) surface. Conversion­
coated papers are used for topnotch photography and fine art 
reproductions. 

Blade-Coated. Blade-coated papers are also coated twice but treat­
ed so as to leave a matte finish, which strains the eye less than a 
glossy finish. 

Cast-Coated. Cast-coated papers are extremely expensive, so much 
so that they're often produced by the single sheet, to order. They 
appear in such high-profile spots as covers for the slickest annual 
reports and presentation pieces. 

Color 
The final characteristic of paper is also important: color. By color, I 
don't mean red, green, or blue, but rather shades of white, most of 
which you can scarcely notice unless you set one kind of paper 
next to another. Nonetheless, the color of paper influences not only 
its proper use but also subtler matters, like the effect of particular 
fonts on the eye. 

Uncoated papers are always off-white and come in an array of 
tints, from warm cream to a chill, almost bluish hue. Generally, the 
temperature of the color interacts with that of the font, giving you 
great flexibility if you know in advance on what paper you'll be 
printing. For instance, Badoni, normally somewhat icy, becomes 
much more approachable on a cream-colored page. At the same 
time, Caslon on a cold bright page can develop an odd sparkle. 

The coated papers are pure white. Hence, they contrast more 
sharply with text and reduce the length of time one can read in 
comfort. 

Binding 
Once you've printed your material, you may not be done. If you're 
making a publication, you still have to bind the pages into a unit. 
Here again there are many options to choose from, and your choice 
depends upon the length of your document and the quality to 
which you aspire. 

One of the first steps you may take is to have the printed pa­
per scored. Scoring creates a slight ridge or indentation, so you can 
fold much more easily. 
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Saddle-Stitching 
Saddle-stitching is one of the simplest ways to bind pages, and it's 
useful for booklets and other small documents. You print front and 
back on 81/2 X 14 inch paper, fold it in half, and staple the pages 
together down the middle. Once saddle-stitched, a booklet opens 
almost completely flat. You can buy a saddle-stitch stapler for less 
than $50. 

For larger documents like books, you need other kinds of bind­
ing. Three types are common: spiral, perfect, and edition. 

Splral Binding 
Spiral binding links pages by spirals-helixes, really-of metal or 
plastic. This binding is not suitable for quality publications, as it 
suggests the grade school notebook, but it's highly desirable for 
manuals and other works that must stay open at certain pages for a 
while. For instance, spiral binding is a genuine asset for books with 
type-in computer programs. It's also inexpensive; it can run as little 
as 50 cents per book. 

Perfect Binding 
Perfect binding is the kind commonly used for paperback books. 
You fold pages into booklet-sized groups called signatures. Then 
you bring them together, shave the backs off, and apply a flexible 
glue to the spine. The cover goes on top of the glue. If you look 
closely at the spine of a trade paperback, you can see where the 
ends of the signatures have been lopped off. 

Edition Binding 
Edition binding is generally used for hardback books. It involves 
bringing the signatures together much as with perfect binding. 
However, instead of cutting off the ends, you sew them together. 
Then you apply glue to the spine, top it with a piece of gauze, and 
paste on the cover. If you look at the back of a hardbound book, 
you'll see the rounded ends of each signature, like a series of tiny 
scallops. 

Output marks the end-point in the graphics process, and it's 
fitting that the technology here is in flux. For despite its prowess, 
Macintosh graphics as a whole remain a prodigy, growing and im­
proving rapidly every year. Impressive as it is, this story isn't over. 
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Mastering Graphics on the Macintosh quides you 
through every aspect of Macintosh Graphics including 
desktop publishing and presentation graphics. Author 
Dan McNeill explains the tools av.ailable and how to use 
them ·to the limits of their power to create attractive. in­
teresting. and energetic Macintosh Graphics. 

Though this book focuses more on the elements of 
design than specific software. it is not without an in­
depth discussion of the uses of software packages like 
MacPaint, MacDraw, and HyperCard. Inside you'll find ... 

• Techniques to create scripts. charts. visuals, diagrams. 
and illustrations of any kind 

• A thorough discussion of desktop publishing, including 
explanations of the best use of typography and page 
design 

• Help in choosing the appropriate type and layout for 
your specific needs 

• Information on importing art into your Macintosh via 
manual copying. clip art, and digitizers 

With McNeill's help. you can literally capture reality 
through the use of perspective. shadow. texture. and col­
or. Macintosh allows you to modifiy input as much as you 
want before producing hardcopy. You are limited only 
by the bounds of your own creativity. 

In Mastering Graphics on the Macintosh. Dan 
McNeill has covered the skills needed to help you create 
memorable. effective graphics-whether you're a nov­
ice or seasoned Macintosh user. MacNeill is also the au­
thor of COMPUTE!'s Quick & Easy Guide to Desktop Pub­
lishing. 

COMPUTE! Books 
Radnor. Pennsylvania 


